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Welcome

John Dibbs 
From Spitfires to 

stealth jets, John’s 

aviation obsession 

has taken him 

(almost literally) to 

the stars and back. 

See his air-to-air 

images on p50

Jeremy Walker 
Joining us again to

celebrate the launch

of Camera School,

landscape legend

Jeremy shares his

advice for absolute

beginners. Read his

insight on p126

Nico Nordstrom
It’s not every day 

that someone tries

to recreate the 

opulent world of 

Marie Antoinette, 

but on a shoestring

budget. Find out 

how on p100

Learn from 
the best

Ben Hawkins, Group Editor

I
’M PACKING FOR A SHORT BREAK
to Havana as I write and seriously
can’t wait. I don’t escape the office
too often, so when I do I tend to get
very excited, kind of like an impatient
child the day before his birthday. Cuba
has long been on my bucket list and

no doubt you’ll be seeing some of my travel
photos in due course. Speaking of travel,
this month’s big feature couldn’t have been

better timed, what with Tim Berry compiling an in-depth guide
to the gear and shots you should be looking for when on your
summer hols. Starting on page 34, he also presents four exciting
projects to help focus your creativity, from colourful picture
grids to new ways to shoot familiar subjects. And don’t forget to
download your free copy of DxO’s amazing OpticsPro 9 editing
suite, worth a whopping £159. Turn to page 90 to get started.

58 Discover the thrill of street

photography with new projects

34 Take your travel photos to

the next level with our big guide

138 We review the ten best 

mirrorless lenses under £1500

Subscribe now 
and get a Lastolite
Collapsible Reflector
Choose from print, digital and combo deals

and get Practical Photography for less.

greatmagazines.co.uk/pp
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instagram.com/
practicalphotography

facebook.com/
PracticalPhotographyMagazine

twitter.com/practphoto

youtube.com/ppmagazine
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May
138 10 best mirrorless lenses

118 Shoot perfect landscapes

34 Get creative on your travels

58 Hit the streets for inspiration

108 Shoot fast-moving subjects

132 Fujifilm GFX 50S review

68 Process your RAWs like a pro

118 Sign up for Camera School

148 Brilliant £49 editing software

On the cover

Skills&ideas

Regulars
06

On the CD
Enjoy over 60 minutes of new 

videos and loads of extra freebies.

30
Ross Hoddinott
Ross looks at our irrational

fear of noise. ISO noise, that is.

32
Lisa-Marie McGinn
Lighting is the key to success 

and Lisa just loves to experiment.

129
Next month
It’s time to take a fresh look

at landscapes with our huge guide.

08
Beyond the lens
Five creative masterpieces from

the world’s most talented photographers.

20
10 clicks
A bagful of brilliant new projects,

from artistic portraits to clever still life.

34
Complete travel guide
Take a fresh look at this timeless

genre and pack the right gear and extras.

50
Air supremacy
John Dibbs talks about his

incredible flights of air-to-air fantasy.

58
Hit the streets
Turn bustling crowds and colourful

characters into gritty works of art.

100
Royal descent
Nico Nordstrom’s Marie Antoinette

project reimagines her world of opulence.

108
Know your stuff
Back button focusing, lens advice,

the golden ratio, and wireless triggers.

162
Student showcase
Soft tones and vintage vibes

typify Sue Williamson’s stylish portfolio.

118

100

50

148132



68
Polish your travel photos
Learn to process and clean up your

RAWs to a pro standard in Lightroom.

72
Make a mono masterpiece
Convert to black & white in Lightroom

and add detail, vignettes and film grain.

76
3 landscape treatments
Straighten your horizon, lighten the

foreground and apply a vintage sepia effect.

80
Enhance eyes and smiles
The second part of our new portrait

series looks at the art of facial reshaping.

86
Create fantasy images
Play with scale and bend reality

by making worlds within macro scenes.

92
NEW! Photo fixer
This month’s fixes include applying a

crop, adding a sky and changing colours.

96
Tidy messy images
Remove distractions and strengthen

compositions with the crop and clone tools.

98
NEW! Photoshop hacks
Use Smart Previews, extract stills

from videos, and set your white point quickly.

Photoshop 
Genius

GetIntoGear

Free DxO 
software!

Download
OpticsPro 9  

Elite now!   
See p90

18
The knowledge
30 years of Canon EOS, Calumet and

WEX unite, and Gitzo celebrates 100 years.

132
Fujifilm GFX 50S
Is the world’s first mirrorless medium-

format camera a total game-changer?

136
Canon 800D
Take a first look at Canon’s latest,

impressively specced entry-level DSLR.

138
CSC lenses under £1500
Discover the 10 best mirrorless

lenses under £1500 for travel photography.

146
Smartphone essentials
Lighting and protective cases to

steadicams, lenses and portable darkrooms.

148
Mini tests
Non-subscription editing software,

screen calibration and HD sunglasses!

90 Start using your free DxO software 

today for comprehensive image editing

58 Follow our three simple projects and fill  

your frame with the drama of the streets 

138

S C H O O L

NEW!
PHOTO SKILLS 

COURSE 
STARTS THIS  

ISSUE!

Module 1: Classic Landscapes  

Starts on page 118

136 Canon adds the 

800D to its popular 

EOS line-up

84 Use your free dispersion 

brushes to creative effect
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If the CD is damaged or contains the  

wrong content, please return the disc to:  

Practical Photography, Bauer Media, Media 

House, Lynch Wood, Peterborough, Cambs,  

PE2 6EA. Alternatively, you can email us at  

practical.photography@bauermedia.co.uk

Contact us if you have
issues with your disc

1 Smartphone challenge
The best camera is the one you have 

with you. And if this motto is good enough for 

Pulitzer Prize-winning photojournalist Barry 

Staver, it’s good enough for us. So we asked 

Tim, Dan and Kirk to give up their DSLRs for  

a day and instead use only their smartphones. 

The challenge? To shoot and process two 

very different, but equally amazing images, 

and put them to a public vote.

2 Beginner’s guide to boudoir
Boudoir photography has soared in 

popularity in recent years and it’s not hard  

to see why. Sensual, stylish and empowering,  

it’s also a surprisingly accessible subject that 

anyone can try. Kirk shows just how easy it is, 

using nothing but natural light, a reflector and 

a standard zoom. 

Over 60 minutes of hands-on camera and editing
lessons & tutorials to help you shoot better pictures

20 dispersion brushes 
Give your portraits the ‘wow’ factor with

our new collection of custom brushes for

Photoshop. Turn to page 82 to find out 

how to use and customise these effects. 

Photoshop video lessons
Process and clean up your travel shots 

in Lightroom, enhance eyes and smiles 

with our portrait retouching series, and 

get artistic with our dispersion brushes. 

Camera
Buying Guide
Unsure about which

camera is best for your

needs? Our ebook 

includes reviews, spec

and prices for every

camera available right

now. The latest 

additions include the 

Fujifilm GFX 50S and 

Sigma Quattro H. 

Creative projects

Pro hints & tips

Camera skills

Your Free CD

Plus More free gifts on your CD
THREE 
BONUS 
VIDEO 

GUIDES 

60 
MINUTES 

OF EXPERT 
ADVICE

Shooting advice



Buy a B1 or B2 Off-Camera Flash kit before April 30, 2017 and 

get any of the Air Remote TTL (for Canon, Nikon or Sony) or 

Air Remote for free.

Find dealer: profoto.com/offcameraflash/find-dealer

Now’s the time.
Buy the B1 or B2. 
Get an Air remote 
for free.
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The stories behind the world’s greatest shots
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Icelandic horses
by Klaus Fies
O During my last visit to Iceland I

was lucky enough to stay on a farm

with horses. One morning the light

was so favourable that I needed to

get out and start shooting. The black

stallion caught my attention with his

magnificent mane, so I spent a lot of time

observing his behaviour and waiting for

the perfect moment to get my shot.

Nikon D4S | 70mm | 1/640sec | f/3.5 | ISO 200 

Klaus Fies has been passionate

about photography for more

than 40 years. He enjoys

shooting landscapes, wildlife

and colourful architecture. 

pixeldreamer.de
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Bermuda triangle
by Pedro Fernandez
O This image is part of my project to shoot

some of the most unique contemporary

buildings in Spain. This is a very modern

neighbourhood in Madrid. There’s an

aerodrome close by, and it’s common to

see aircraft flying overhead. I wanted to

get a plane in-shot but it was too tricky to

capture, so I added one in Photoshop.

Canon 6D | 16mm | 1/100sec | f/6.3 | ISO 100 

Spanish photographer Pedro

Fernandez enjoys shooting

Madrid’s modern architecture

and nightscapes in the

surrounding countryside.

500px.com/fotoaguado

BeyondTheLens
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Face in the crowd
by Mustafa AbdulHadi
O I’m interested in street photography
because I love to explore and study
the different aspects of people’s lives,
customs and traditions. I was wandering
through the city when I saw this woman
carrying her son in among a gathering
of women. I loved the juxtaposition in
the scene and wanted to use the rule-
of-thirds and negative space to create
a powerful image. I was quite far away,
so zoomed in with my 70-200mm lens.
Canon 60D | 200mm | 1/200sec | f/5.6 | ISO 400 

Mustafa AbdulHadi is a
photographer from Bahrain
who enjoys taking landscapes, 
portraits and streets shots
around his local city. 
mustafaphoto.com
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BeyondTheLens



BeyondTheLens
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Spring in the air by Magda Wasiczek
O My way of looking at the world, and shooting it, stems from a fascination

with paintings. My pictures are more a record of impressions, colours and

flashing lights than a straight documentation, as I really want the audience

to see my vision of the world. I’d read about Photoshop’s Pixel Bender filter

and its oil painting effect, so used it on this shot of an orange tip butterfly.

I also added a texture bought from American portrait pro Jessica Drossin.

Nikon D700 | 150mm | 1/160sec | f/5.6 | ISO 250

Nature and floral 

photographer Magda 

Wasiczek is based in 

Poland, and has twice 

won International 

Garden Photographer 

of the Year. 500px.com/
magdawasiczek1/about
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Organic matter
by Ela Kurowska
O This image might look like a dramatic

cosmic event taking place, but in reality,

it depicts a small object of about one

inch long made out of a soft organic

gel that has the ability to glow under

specific conditions. As my subject

was so small I needed to use a macro

lens and focus stacking in order for

everything to be perfectly in focus.

Nikon D610 | 105mm | 0.5-1sec | f/8 | ISO 100 

Ela Kurowska is a photographer

and biochemist who is fascinated

with the origins of life, specifically

the potential of organic matter to

self-organise and become ‘alive’. 

lightforms.ca
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BeyondTheLens



Calumet buys Wex Photographic

From humble beginnings 30 years

ago, Canon’s EOS line-up is now

officially the world’s best-selling

camera range, with a 72% share of

the DSLR market recorded in

November 2016 and an eye-watering

growth of 31% year-on-year. And with

98 models to its name, of which 24 are

current, the EOS (Electro-Optical

System and/or Titan Goddess of the

Dawn) range shows no signs of

growing old gracefully...

Back in 1987 Canon introduced the

highly-specced 35mm EOS 650, as a

direct competitor against Nikon and

Minolta’s fast focusing AF models. The

camera featured the first EF mount

(replacing the manual focus-only FD

mount), which included an electronic

aperture and focusing motors. Two

years later Canon used this new AF

technology in the EOS-1,

the Japanese firm’s first

professional autofocus camera.

It then went on to release the first

entry-level digital SLR, the 300D, in

September 2003, which boasted a

6.3MP sensor and helped pave the

way for more accessible photography.

Recent additions to the EOS range

include ground-breaking DSLRs such

as the 5D MkII (which introduced Full

HD recording to DSLRs) and the

astounding 1D series, and it has

branched out to encompass CSC and

digital cinema cameras. The

supporting EF lens mount range

comprises 97 different models,

including the revered ‘L’ series,

and has itself exceeded an

astonishing 120 million units.

canon.co.uk

CA NON

R ETA IL

Calumet Photographic’s parent
company, Aurelius, has acquired Wex
Photographic, and plans to become a
‘leading multi-channel, pan-European
photographic retailer’. The sale of
Wex from Barclays was announced
in March and is expected to create
an annual revenue of €179 million.
The merger takes place two years 

after Wex, Practical Photography’s
current Retailer of the Year, acquired 
Fixation, the UK’s leading Canon and 
Nikon repair specialists. Whether
both brands will merge or maintain
their individual brands isn’t yet clear,
but hopefully both brands’ legendary 
customer service will continue to excel.
calphoto.co.uk

Celebrate 30 years
of Canon EOS

EOS CAMERAS IN NUMBERS...
72%
SHARE OF 
THE DSLR 
MARKET

80million
CAMERAS
SOLD FROM
1987-2017 

31%
GROWTH
IN SALES
YEAR-ON-YEAR

Kn wledge
The latest news from the world of photography

THE

Above The Canon EOS 650 
and the new EOS 77D span 

30 years of progression.
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Super speedy
Sony SF-G SD

MEMORY CA R D

Sony is known as an innovator in

many fields, and the SF-G – the

world’s fastest UHS-II SD card –

is no exception. Claiming a jaw-

dropping write speed of 299 MB/s

and possible read speed of

300MB/s, it’s now one step beyond

the Lexar Pro 2000x’s 260MB/s

maximum. It boasts an impressive

buffer clearing time of 8sec and the

ability to store up to 200 RAWs in

continuous shooting. The SF-G

outperforms its predecessor, the

SF-UZ, by at least 2x in Sony’s

benchmark tests.

sony.co.uk

Luxury Italian tripod manufacturer Gitzo joins photographic

giants Canon and Nikon in celebrating a landmark

anniversary this year. And to mark its centenary, Gitzo is

giving away a limited edition book by renowned landscape

photographer Colin Prior with every Systematic tripod

bought this year. Started by French innovator and

manufacturer Arséne Gitzhoven in 1917, the company first

produced cameras and accessories, and was named Gitzo after one of

its early shutters. In 1930 it ceased camera production and turned its

attention to tripods, patenting the first rapid column tripod in 1953, then

going on to create both the first carbon fibre tripod and magnesium

head in 1994 and 1996 respectively. Since 2001, Gitzo has been based

in Bessano del Grappe, Italy, where it is now known for producing

some of the finest tripods and accessories on the market. gitzo.co.uk

bwpawards.org

COMPETITION

Above To

celebrate 100

years, Gitzo is

giving away a

free Colin Prior

book with

every systemic

tripod

purchase.

Gitzo celebratesGitzo celebrates
100 years of success
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News

Sony CSC
medium-format
Hasselblad’s upcoming

X1D and Fuji’s GFX 50S

are both making waves, so

we’re waiting for mirrorless

pioneer Sony to announce

development of its own

medium-format camera. Having

developed sensors for other

companies, it makes sense that

Sony’s next step is a 50MP+

CSC using its 43.8mm sensor

and a new Expeed engine. With

so much experience in the field

already, the recent successes

must be tempting. sony.co.uk

Nikon 1 reboot
With the recent

CSC surge, coupled

with the DL range

cancellation, Nikon

must be tempted to

reboot its range. We’d

expect the new compact

interchangeable-lens camera

to feature a new in-house

24MP sensor, improved EVF

and touchscreen controls, as 

well as 4K video and enhanced 

dynamic range to bring it in 

line with the Canon M series. 

We’d also expect to see a new 

lens line-up announced, to help 

pave the way for a brand new 

Nikon 1 range nikon.co.uk

Canon 6D MkII
The full-frame’s new

version has been a

long wait, but word

is that we could be

looking at an early

summer announcement.

Expect to see a new 24MP

full-frame sensor, as well as

the same Bluetooth connectivity

as the recent 77D. We’re also

looking for an improved Dual

Pixel AF and Canon’s excellent 

touchscreen. While 4K video 

would be great, we don’t think 

it’s on the cards at the moment, 

with Canon concentrating on  

its EOS cinema range for 

dedicated videographers. 

canon.co.uk

RumourMill
Hotly-anticipated products 

we can expect in 2017...

TR IPODS
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O No matter where you roam,
amazing shots can always be
found. Go searching for the perfect
photo just like Riccardo Masut 
(500px.com/riccardomasut1). 

“The beautiful Lake Braies lies 
at the foot of the rock wall of the 
Croda del Becco, and is one of 
the deepest lakes in the Italian 
province of Bolzano, with a maximum 
depth of 36m. It’s a popular tourist 
destination because of both the 
intensely blue colour of its waters 
and the vibrant scenery all around it. 

“I was on holiday near the lake 
with my family and knew that I 
wanted to take a shot there. Most of 
the photos of this location are taken 

from the same spot, so I decided to 
walk around the lake in search of 
inspiration. There’s a small wooden 
house with a jetty that juts out, 
which looked like the perfect place. 

“Using a 14mm lens and my Nikon 
D750 I was able to capture the vast 
beauty of both the lake and the 
magnificent mountains. Including my 
legs gave me the opportunity to try 
and draw my viewers into the scene 
as much as possible. I think my main 
photographic goal at the moment is to 
be able to return to this magical lake 
as many times as I possibly can.” 
Q�You’ll find our complete creative 
guide to taking amazing travel 
pictures on page 34.

What to shoot with your camera right now

10Clicks
#1Travel far & wide

L A N D S C A P E
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TIP 
USE A 

WIDE-ANGLE LENS
Magnificent landscapes like 

this lake deserve to be shown
off in all their glory. Use a

wide-angle lens like a
14mm for incredible

results.
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O Landscape photography
is typically associated with
a wide-angle lens, but 
sometimes showing off as 
much of the landscape as 
possible isn’t what’s going to 
get you the best results. Why
not zoom in on the smaller
details like photographer Dino
Marsango (500px.com/dinom),
who used a 70-300mm lens to
capture a stunning landscape
from the other side of a valley.

“Photography is one of my
favourite hobbies, but I also
love combining it with another
passion of mine – hiking. When
I’m exploring the mountains
I always get caught up in the
amazing feeling of being on
top of the world. I quickly
realised that taking photos of
these places meant I could
capture this feeling and enjoy
it again at a later time.

“My favourite lens to shoot

landscapes with is usually
a wide-angle 16-34mm f/4.
However, this picture required
a 70-300mm lens, as the
house was on the other side
of the valley and too far away
to be shown in all of its glory
with a wide-angle. I also used
a sturdy tripod to ensure
that any chance of camera
shake was eliminated.

“I feel very lucky to live
so close to the photographic

wonders of the Dolomites in
Italy, and for me weekends are 
a chance to get away from it all 
and take some photographs.
I’ll also do some post-
processing in the evenings,
usually using Luminosity mask 
techniques in Photoshop.”

Follow Dino’s lead when
you’re in an epic location by
zooming in with a telephoto
lens to create amazing images 
based around small details.

#2 Zoom in with
a telephoto lens

L A N D S C A P E 

10Clicks
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Above Use a 
300mm
s to zoom in
 the most
namic part
he shot. 

O�Make the most of the brighter

weather and colourful flowers

that should be blooming by now,

by heading outside for a portrait

shoot with a difference. Alexandra

Bochkareva (500px.com/leks-a)

coupled these arresting sunflowers 

with her model for striking results.

“I shot this photograph last year

in my hometown of St. Petersburg,

Russia. I’d organised a portrait shoot,

and since it was a warm day, my

model, Polina, and I headed outside. 

We didn’t have to go far too before we

stumbled across a great location, as

we found these amazing sunflowers

just a few streets from my house.

“I immediately wanted to incorporate

them into the shoot, as they reminded

me of my childhood, when we had lots

of them in our garden. They also worked

really well with Polina’s dress, which

was covered in a bright sunflower print.

“When it came to post-processing,

I wanted to make the portrait not

only bright and contrasting, but

dramatic too. First I opened the

image in Adobe Camera Raw and

enhanced the exposure, blacks and 

whites. I then boosted the colours

and atmosphere. I used frequency

separation for retouching the curves, 

and applied colour grading. After

all the colour work, I added some

scratches and dust textures, and

made the portrait a little bit darker.”

#3 Employ nature’s hues
P O RT R A I T S

TIP 
BOOST 

IMAGE COLOUR
To produce saturated colours 

in a scene like this, use the
Vibrance Tool in Photoshop. 

This will help stop bright 
colours from over-

saturating. 
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O Time spent waiting – and

planning – for the opportune

moment is rarely time wasted.

Bill Sherman (500px.com/

billsherman) found the

opportunity for his perfect shot

after scouting out a location

multiple times beforehand.

“This image was taken at

the Apple Store in Manhattan,

New York City. I’d visited the

store several times without

my camera, so I already

knew that I wanted to take a

picture of the dynamic glass

staircase that runs through it.

“It’s always awkward

taking pictures in a shop,

as people tend to stare. It’s

more acceptable shooting

with a smartphone, so

my Nikon D600 drew

some curious looks.

“The staircase is in the

store’s front corner, which

has glass walls to the outside,

letting in streams of sunlight.

I was expecting the mixture

of natural and artificial light

to be a bit of a challenge,

but in this case it turned into

an advantage, and I really

enjoyed working with it.

“I wanted to capture an

image from below, so that I

could catch people climbing

the stairs. This gave a pleasant

blurring effect, as I focused on

the steps themselves rather

than the figures. The way the

light fell, with the top half being

artificially lit from inside and

the bottom half from outside,

provided the wonderful

colour gradation that makes

this shot so successful.”

When you can’t physically

move any closer, a zoom

lens can help perfect

your composition. Bill’s

24-120mm lens gave him

the added versatility he

needed and allowed him

to easily frame his shot.

#4Capture colourful candids4

C A N D I D

TIP
COMBINE

LIGHT SOURCES
Unusual colours can give
abstract shots like this an

extra edge. Search for
interesting contrasts to

create a visually
dynamic image.

Above Using a shutter speed of 
1/400sec will allow you to freeze 
your subjects completely. This 
is perfect for taking candids.

10Clicks
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O Using a wide aperture to produce

deliberate blur can create stunning

photographs that will wow your

viewers. However, apertures like 

f/2.8 can be tricky when you’re 

working with a specific focal plane 

that you need to keep tack sharp. 

Fortunately, with a little bit of 

practice and careful attention to 

detail they can create some amazing 

results. Use blur to your advantage, 

just like African photographer 

and Instagram influencer Nana 

Ampofo (instagram.com/picarus).

“This image forms a part of an 

ongoing project that experiments 

with transparency, perspective 

and depth-of-field by using various 

glass props. In the past, I’ve used 

different sized crystal balls and even 

an hourglass. I’ll often choose cliché 

locations for these images, in an 

attempt to bring a new perspective 

to old and familiar images. 

“Like crystal balls, magnifying 

glasses have been used to great 

effect by many photographers 

I’ve stumbled across and ended 

up following on Instagram. It was 

only a matter of time until I added

one of my own to my set of props.

On a recent trip to Sydney I came

across this particular magnifying

glass and it was love at first sight.

“The trickiest part of the 

image was getting a clear and 

in-focus centre to the shot. 

Magnifying glasses are really quite

capricious! It took me a couple 

of attempts before I was finally 

able to get the desired effect. 

“On this occasion the lighting

turned out to be perfect for 

what I had in mind. Choosing 

an overcast morning at around 

sunrise definitely helped to 

turn the odds in my favour.” 

Using a wide aperture like f/2.8

allowed Nana to achieve a shallow

depth-of-field that draws sharp 

attention to the crisp and clear 

centre of the image. This technique

works best when you have an easily

recognisable background. If your

viewers have to squint to figure out

exactly what it is that’s outside of the

tack-sharp magnifying glass, then

the effect simply won’t be as good.

#5 Find your focus
C I T Y S C A P E Left Switch your 

camera to Live View 
and zoom in.

Below Then adjust your 
focus by using the 
manual focus ring. 

Bottom Use a fast 
shutter speed like 
1/250sec. 
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10Clicks

O Impressive architecture

can provide amazing images,

like this shot by Tim Cornbill

(timcornbillphotography.com).

“Arriving in Berlin on a 

bright summer’s day, my 

wife and I decided to take a 

morning walk along the River 

Spree. We soon came across 

a large concrete building and 

I found myself instantly struck 

by its scale. I positioned 

myself across the river and 

laid in wait. A couple walked

into the viewfinder and I

simultaneously noticed the

cyclist out of the corner of my 

eye. I waited for her to ride 

into the frame before hitting 

the shutter. I tried to balance 

the composition while keeping 

in mind that this shot would 

work well in a square crop. 

“This image was really all 

about timing. Not only was 

I lucky with the path of my 

subjects, but the brilliant

weather and the time of

day also proved to be really

important as well. Concrete

is an organic material in a

lot of ways, as it reacts to

its conditions and takes 

on colours and shadows 

depending on the lighting and

climate. On a dry and bright

day, like the one in this image,

it’s light and almost reflective,

making it the ideal backdrop.”

Above Use a wide focal length 
like 20mm to capture large 
architectural structures. 

#6 Use eye-catching designs
U R B A N



PRACTICALPHOTOGRAPHY.COM 27

O New and old technologies merge in this fun

technique by Amelie Roy (amelieroy.com)

“The goal of this project was to symbolise

what photography is today – a perfect mix of

film and digital. This is why I chose to bring

together my favourite Polaroids and a screen.

“My second motivation was being able

to get the magnificent memories that I

captured with my Fujifilm Instax Wide film

out of their dusty box and give them a

second life. In my opinion, this is proof that

vintage and digital pictures are indivisible. 

“I used my Canon 5D MkIII and a 50mm

f/1.4 lens for this high-angle shot. The

most difficult part was perfectly aligning

the picture I took beforehand on my

iPhone with the Polaroid behind it.”

#7 Blend the 
past & future

S T I L L  L I F E

Above A 50mm lens has the least amount of 
distortion possible, making it perfect for still life. 

O Searching for your subject’s

identity is a common motif in

portrait photography, but for

Jessica Lia (500px.com/jessicalia) 

it’s the central theme of her work.

“In A Room of One’s Own 

Virginia Woolf wondered, ‘Anon, 

who wrote so many poems

without signing them, was often a

woman.’ This series of images is

somewhat inspired by this line. I

wanted to portray the anonymity

of women, how they’re always

behind a mask imposed by

society and history. I feel that the

idealised form of womankind can

represent everything holy and 

sinful, but nothing in-between. 

“This photograph is my way of

exploring these ideas through my

camera. The female figure in the

shot isn’t visible, but is wrapped

in myths and fantasy. However, the

motion of the fabric shows that the

woman is trying to break free, just

as women today are stepping away

from the pre-conceived notions of

how they should look and behave.”

#8 Mask your subject
P O RT R A I T
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OWhen you think of long

exposures, your mind

will instantly jump to

tripods. However, Alan 

Humphris (500px.com/

ahumphris) created this 

surreal image handheld. 

“About ten years ago I was 

feeling dissatisfied with my 

photography. I felt like there 

was something missing from

my images, so I decided

that some experimentation

was in order. I wanted to 

shoot photos that didn’t 

capture what the scene 

looked like, but what it felt 

like. I do this by shooting the 

constant motion of the street

and capturing the ghostly,

dream-like impressions 

that everyday life leaves for 

us when we’re not paying 

attention to what’s going on. 

“The shots are taken using 

long exposures of up to 

5 seconds. During the day I 

use ND filters and will keep my

camera moving, often following

one subject in particular.”

#9 Shoot a city on the move
A B S T R A C T

10Clicks

Above An ND filter will cut out

sunlight for long exposures.

O Shoots may not always go to plan, but a disappointing 

day can still provide wonderful opportunities. Lionel

Du Plessis (500px.com/lioneldp) discovered this when

shooting in South Africa. “I took this image in the car 

park of a hotel on the outskirts of Tzaneen. It wasn’t the 

shot I wanted, as I’d actually planned the trip around a 

completely different image entirely. I’d just unpacked the 

car when I passed this little palm grove. The striking gold 

of the dying palm leaf against the other leaves was too 

beautiful to ignore, so I had to immediately take a photo.” 

#10 Find contrast0
N AT U R E
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D
O YOU HAVE AN IRRATIONAL FEAR OF NOISE?
Obviously, I’m not referring to inconsiderate neighbours
or loud thrash metal, but digital noise obscuring 
precious detail in your shots. A lot of photographers do, 

particularly those – like me – who have been shooting digitally 
ever since the big migration from film around 10 years ago. 

Early digital SLRs weren’t renowned for their high ISO 
performance and photographers were strongly advised to keep 
ISO low. You might risk shooting at ISO 400, or even 800 if 
you were feeling adventurous, 
but you knew your images would
be visibly noisier. Fast-forward 
to 2017, and how things have 
changed. The likes of Sony, 
Nikon and Canon have really 
invested in this area of sensor 
technology, producing super-
sophisticated noise reduction 
algorithms in order to give us ‘ground-breaking’ high ISO
speeds and ‘lower than ever before’ levels of noise. While
top spec models like the Nikon D5 and Canon 1Dx MkII
might be the flag bearers for high ISO performance, the 
truth is nearly all modern cameras are pretty darn good.

We’re now being offered ISO speeds into the millions – 
crazily high sensitivities, which are providing photographers 
with new opportunities and encouraging them to push 
boundaries. However, despite the huge advances in sensor 
technology, how many of us still dare not tinker with our 
ISO button? I guess, over the past decade, we’ve been told 
so many times to avoid higher ISOs that it’s now engrained 
in us to avoid them at almost any cost. I think there’s a 
reluctance among old dogs to learn new tricks. And until not 
long ago, I would have included myself in that assessment. 

Don’t misunderstand me – I still fully advocate using the 
lowest practical ISO. However, the big brands haven’t invested 
crazy money into enhancing high ISO performance just for you 
and me to stubbornly keep our dials set at ISO 100. For example, 
when shooting close-ups of wildlife, I often shoot in low light and 
it’s rarely still. Trying to shoot windblown subjects in poor light, at 
high magnification, using a low ISO just doesn’t work, regardless
of whether you’re using a tripod or not. Trust me, I’ve tried. 

Equally, when shooting action, a rapid shutter will normally be
a priority. But if the light is poor, and 
your budget doesn’t stretch to a super 
fast f/2.8 telephoto, how do you intend 
to freeze subject motion? There’s no 
point capturing a noise-free image 
if the subject is blurred. It’s better 
to tolerate a small degree of noise 
and capture a bitingly sharp and 
useable result. Wouldn’t you agree?  

After years of being reluctant to increase ISO beyond 400, 
I’m finally enjoying the benefits of using cameras boasting high 
ISOs. I now regularly shoot up to ISO 3200 – or higher if the 
situation dictates. Dare I say it, but the usability of high ISOs also 
allows us to go tripod-less. I love my trusty legs, but there are 
occasions when the freedom, speed, fluidity and spontaneity of 
shooting handheld yields far more creative or unique results. I’ve 
reconditioned my way of thinking to embrace the opportunities 
that lie beyond ISO 100 – do you need to do the same thing?

Ross Hoddinott is an award-winning natural world 
photographer based in Cornwall. He’s written eight books  
on the subject and he won the inaugural British Wildlife 
Photography Awards. rosshoddinott.co.uk  

“ISO SPEEDS INTO THE 
MILLIONS ENCOURAGE 
US TO TRY NEW THINGS 
& PUSH BOUNDARIES”

ROSS HODDINOTT
ADVENTURES OF A NATURAL WORLD PHOTOGRAPHER ISO PERFORMANCE
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L
IGHTING IS A KEY ELEMENT IN LEARNING AND
understanding photography. As I’ve grown as a
photographer, my lighting techniques have changed.
During university, I was in love with high-key lighting

using one simple light, as the results were very crisp and 
clean. As I started really focusing on fashion and creative 
photography, natural light became my best friend and I would
shoot outside as much as I could. Even during Alberta’s long
winters, I wouldn’t shoot as much in the studio, as I felt more
confident using natural light.

Exposure is something I used 
to struggle with – I was never sure 
when I’d exposed an image correctly.
As a result, I often overexposed my
studio work because I didn’t trust 
my eye. At Lara Jade’s workshop in
2014, she told me that I had mastered
natural light and needed to continue
building up my studio portfolio. I’d had an Elinchrom starter
kit for about four years before I upgraded my gear in 2015. By
2016, I was shooting the majority of my work in the studio.

As I started focusing on beauty work and studio fashion, my
lighting skills got stronger and I started using a lightmeter to
help me with my camera settings. Now, I have an entire studio
filled with various modifiers and lighting equipment. My go-to
modifier has to be my Elinchrom octabox – I have two different
sizes, the 100cm and the 150cm. The 150cm is perfect for 
fashion photography, as it lights the subject from head to toe.
The 100cm is my favourite modifier for beauty photography.

I place a reflector underneath my subject with the modifier
placed directly behind me. It creates a beautiful, even light and if
you remove the reflector the shadows produced can add drama
to your image. Shadows created by the octabox are softer than 

if you were using a beauty dish. When I want to shoot a really 
dramatic editorial, I will use my beauty dish, and lately I’ve been 
adding my grid as well. The beauty dish is great for creating
contrast and adding texture for beauty work. Placing the grid 
on the beauty dish will focus the light in a spotlight kind of 
way, and the light will fall off to create interesting shadows. 

A recent lighting setup I tried (and loved) was from a beauty 
editorial. I placed my large octabox behind my model so it 
would touch her back to create a wraparound light. This created 

beautiful highlights around the model 
on her jawline, neck and shoulders. I’ve 
used this technique before and placed 
a reflector below the model. This time I 
added two strip lights directly in front 
of my camera in a triangular shape. For 
this setup, you really need something 
reflective on your subject’s face for 
the lights to catch the reflection.

Typically, I only like using one light unless I’m incorporating
gels into my shots. I wanted to step out of my comfort zone, so I used 
three lights in total. A quick tip – if you’re using an octabox placed 
behind the model make sure the actual light is hidden otherwise 
you have a risk of sun flare (which I love, but not everyone does). 
This lighting setup gave the model’s skin a beautiful, almost plastic 
look. Make sure your model is aware of where the lights are so 
you can see the reflections. As I build my beauty portfolio, I love 
trying different lighting techniques and the results they produce.

Lisa-Marie is a Scottish-born fashion and beauty 
photographer based in Alberta, Canada. Her work is  
regularly published in glossy magazines, and clients include 
Elinchrom, Canon and Vistek. lisamariemcginn.com  

“I’D STRUGGLE WITH 
EXPOSURES IN THE 
STUDIO AS I DIDN’T 
TRUST MY EYE”

LISA-MARIE MCGINN
ADVENTURES OF A FASHION PHOTOGRAPHER EXPERIMENTS IN LIGHT  
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I
F THERE’S A SURE-FIRE WAY TO
kick-start your creativity, sharpen
your shooting skills and open the door
to some seriously exciting 
photographic opportunities, it’s travel.

Visiting a new place allows you to see
everything through completely fresh
eyes. According to Bill Bryson: “The
greatest reward of travel is to experience
everyday things as if for the first time, to
be in a position in which almost nothing is
so familiar it is taken for granted.”

This is the time to break out of familiar
surroundings and get creative with your
camera, and we’re going to show you how
to get the best results from your location.

Travel light
But before you even think about jumping
on a plane, you’re going to have to decide
what gear to take and what to leave 
behind. Any form of travel means space is
at a premium, and if you’re flying, you’ll be
limited by weight too. 

Job one is to choose which camera to 
take. If you only have one, the burden of 
decision is off your shoulders. But if there
are several cameras in the family, you have
some thinking to do. As a general rule, the
smaller the camera the better, which 
makes mirrorless models or premium 
compacts slightly preferable to DSLRs. 
You could also consider an action cam, 
such as a GoPro, which are ideal for 
shooting in and out of the pool and on the
beach, but aren’t so good for creative
images. If you’re buying a new camera
before you go, consider one with weather
sealing, to protect it from splashes of
water, sand and dust. To the right, we
check out our three top enthusiast-level
cameras for travel photography.

36 PRACTICAL PHOTOGRAPHY

Three perfect
travel cameras...a

Get prepared for your trip
BEFOR E YOU GO

Expert advice Take out insurance before you go
We’d highly recommend 

you take out insurance for 

your camera kit when 

you’re travelling. Most 

tourist spots are notorious 

for pickpockets who will 

target your kit, and there’s 

a much higher chance of 

accidentally losing gear 

when you’re away. There 

are several specialist 

camera insurers out there 

(E&L, Photoguard, Trov), 

which offer both annual or 

short-term coverage for a 

relatively low fee, and the 

policy usually covers 

accidental damage.

Before you buy, check 

to see if your kit is covered 

on your home contents 

insurance, or if it can be. 

Most allow you to claim for 

high value items like 

cameras and lenses even if 

you’re abroad. Also 

double-check on the 

excess you’d have to pay 

should you need to make a 

claim. Even with proper 

insurance, it’s best to try to 

take less valuable kit with 

you, especially if you have 

two bodies. Getting your 

pride and joy stolen could 

completely ruin your trip!

 Nikon 1 AW1 kit  £629 

Although now an older model, Nikon’s 

14.2MP CSC is still the only waterproof 

interchangeable lens camera on the 

market. It can be fully submerged to 

15m, and is shockproof to 2m. There 

are several waterproof lenses available 

too, the 11-27.5mm kit lens included.

nikon.co.uk

Panasonic G80 kit £799 

The 16MP enthusiast-level G80 is 

fully dust- and weather-sealed, so 

can easily withstand a few

splashes of water. It’s very

compact, and has a tilting

screen for composing at

angles. The camera also

comes with 4K Photo,

meaning you can pluck 8MP

stills from 4K video.

panasonic.com/uk

 Canon 77D kit £919 

Canon’s brand new enthusiast 

offering boasts a redesigned 

24.2MP APS-C sensor, 5-axis 

image stabilisation, a 3in flip-out 

touchscreen and dual pixel AF for 

fast Live View focusing. There’s 

also Full HD video at 60fps for 

smooth slow-mo.

canon.co.uk

BEST 
FOR

USE IN
WATER

BEST 
FOR

BURST 
SPEED

BEST 
FOR

LENS 
OPTIONS
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Travel Projects

1
Wide-angle lens 

From £330 

If you’re planning to shoot

landscapes or cityscapes while

you’re away, you’ll need a lens

with a very wide angle-of-view.

Most kit lenses zoom out to the

equivalent focal length of

around 25-30mm, but ideally

you want 20mm or wider.

2
Portrait lens

From £105 

The most flattering focal length

for portraits is the equivalent of

85mm, which means a 50mm

lens on most DSLRs, the same

on Fuji CSCs, and 42mm on

Panasonic and Olympus. Buy an

inexpensive prime with a wide

aperture to blur backgrounds.

3
Batteries & charger

From £40

Make sure you pack your

charger, as well as a plug

adapter if you’re heading

abroad. It’s also worth

investing in a spare battery,

as when travelling you’re likely

to shoot a lot of photos

between charges.

4
Mini tripod

From £18  

For night shots and 

landscapes, you’ll need to keep

your camera perfectly still. You

may not be able to take a

full-sized tripod, but it’s worth

packing a mini version, which 

can weigh as little as 250g.

Manfrotto’s Pixi range is ideal.

7
Waterproof bag

From £30  

To protect your gear from dust,

water and sand, all of which

cause serious damage, take a

kit bag with a built-in raincover, 

and ideally weatherproof zips.

You may also consider a model

with anti-theft technology such 

as slash-proof straps.

8
Shutter release cable 

From £15  

If you’re shooting long 

exposures, a shutter release 

cable or wireless remote allows

you to fire your camera without 

causing shake. They’re cheap, 

light and compact, so easy to

pack. You can also use your 

phone if your camera has Wi-Fi. 

6
Lens cloth and fluid

From £10 

Your lens’ front element will get

pretty dirty when travelling, so

you should clean it as regularly 

as possible. This is especially

true if you’re on the coast, 

where sea spray can leave a

salty residue. Fluid, in addition 

to a cloth, is recommended.

5
Memory cards

From £10 

As a general rule, you’ll need 

around 32GB of memory for 

every week you’re away – that’s

1000-1500 RAW shots. But to

be safe you should take at least

double this. SD cards are

cheap, so there’s no excuse for 

running out of space!

1

2

3

3

4

5

6

7

8
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H
ERE IN THE UK
we’re relatively
reserved with our
use of colour in
public spaces, but

in some parts of the world –
particularly Africa, Asia, the
Caribbean and southern
Europe – vibrant colours are
an important part of the
cultural furniture. Fronts of
buildings are dressed in soft
pastels, brightly-coloured
boats bob in turquoise seas,

and markets are packed with
fruits and spices of every
imaginable hue.

In this first project you’re
going to be using the rich
colours you find at your
location to create striking
quadtychs, where four different
shots are presented together
for artistic effect. If you’re
travelling in the UK, you’ll have
a harder job, but to the creative
eye, it’s out there to be found.
We usually think of successfulW

travel images as needing a
definite focal point, such as a
person or landmark, as this
anchors the viewer’s eye and
gives the shot meaning. In this
case though, we’re going to
use colour itself, rather than
the subject, as the main point
of interest.

Break the mould
To make this work you’ll need
to create a very abstract and
minimal image that doesn’t do
anything to distract the viewer
away from the aesthetic value
of the colour. This might
mean focusing on a particular
section of an object, such as
an interesting door or some
fruit stacked in a box, and
working hard to eliminate any
unwanted clutter from the
frame. You should also ensure
there’s just one colour in each

shot, or else your quadtych
will have much less impact.

Master colour
When shooting your four
images, think carefully about
which colours are likely to
work well together, and which
might clash. This is largely a
matter of personal preference,
although much has been
written on colour theory,
which explains how and why
some colours complement each
other and some don’t. Before
you go, check out Adobe’s free
Color CC at color.adobe.com.
Select either Analogous or
Compound from the Color
Rule drop-down box and start
experimenting. Putting this
groundwork in before you
travel will undoubtedly help
you to get better results when
you’re there.

Create a colourful quadtych
PROJ ECT 1

“START USING COLOUR
ITSELF AS YOUR MAIN  
POINT OF INTEREST...”

  Expert advice Stitch your images together in Photoshop  

Above Adobe’s Color CC is a website that all photographers

should be familiar with, and it’s completely free to use.

1 Open your images
Open all four shots. Select the

image you want top left in your quadtych

and go to Image>Canvas Size. Click in

the top left anchor, then in New Size type

the exact Width and Height shown in

Current Size, plus add 1cm extra to both.

Check the Relative box and set Canvas

Extension Color to White. Click OK.

2 Build your quadtych
Bring up the image you want to place

top right, and press Ctrl+A, then Ctrl+C to

copy. Go back to your first image and press

Ctrl+V to paste. With the Move Tool selected,

click and drag to position your second

image in the top right corner. Repeat this

process for the other two shots, positioning

them bottom right and bottom left.

3 Boost your colours
With your images in place, open the 

Layers panel by going to Window>Layers. 

At the bottom of the panel, click the Create 

new fill or adjustment layer icon, and 

select Vibrance from the list. Nudge the 

Vibrance slider to the right until all of your 

colours are bright and vivid. Be careful not 

to go too far. To save go to File>Save.
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Travel Projects

TIP
CROP AWAY

DISTRACTIONS
If you don’t have the focal

length to fill the frame with

colour, you can always crop

in Photoshop, though don’t

discard more than half

the image area.

JO
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W
HEREVER
you travel
this summer,
getting an
amazing

landscape or cityscape of your
local area is an absolute must.
This often ends up becoming
the photo that reminds you
most of your trip, and if you’re
creating an album of your
travels, it’s important to have a
good location shot to put the
rest of your images in context.

One of the biggest
challenges you’ll face is that
popular tourist destinations
are almost always teeming
with people, which can make it
very hard to get a clean image.
To get around this problem,
work at sunrise when there’s
hardly anyone around, and
with luck you’ll get soft, dawn

light too. If you’re on holiday
with other people, this is also
the time when you’re least
likely to disrupt their plans,
giving you a little more time
to get out on your own.

Scout out your location for a
couple of days to find the best
shooting positions. Look at
postcard stands and do some
research on Google to figure
out the favourite spots used by
other photographers. You
won’t necessarily want to
replicate these, but they’ll give
you a good starting point.

Use an ND filter
In some locations, such as
central London,
there may not be
any time of
day or night
when there

are no people or cars at all in
the scene. In this case, try
using a 10-stop ND filter, also
known as an ND1000 or Big
Stopper. This will allow you to
shoot with very slow shutter
speeds – typically as slow as 15
seconds in bright midday sun
– completely blurring any
moving objects and rendering
them near-invisible. We
recommend SRB’s circular
10-stop filters, which range
from £25 to £40 and offer
excellent image quality. Check
your lens’ filter thread size
before you order.

Even if you don’t use a
filter, working around first

light will mean slow
shutter speeds, so

you’ll need to
keep your

camera

perfectly still. Of course, it’s
not always possible to take
your full-sized tripod on your
travels, so you might want to
pack a mini tripod, such as
Manfrotto’s Pixi Evo. This
model folds to 21cm so fits
comfortable into a kit bag,
weighs in at just 267g, and can
support 2.5kg. Alternatively,
try a beanbag like the Ballpod,
or a flexible tripod like the
Gorillapod. For long exposures,
it’s also worth throwing in
either a shutter release cable or
a wireless trigger so you cana
fire your camera without 
risking camera shake. These 
remote releases are incredibly 
small and light, so are very 
easy to pack, and start from 
around £15. To the right we 
show you how to set up your 
camera to get the best shot.

Shoot an unspoilt sunrise

PROJ ECT 2
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Expert advice Set up your 
camera for the best results

2 Choose a narrow aperture
When using a wide-angle lens, you’re more likely

to have both extreme foreground and background in

frame, which means you’ll need a very large depth-of-

field to ensure everything is sharp. With your camera

in aperture-priority mode, choose a setting of f/16.

Don’t go any narrower or image quality will begin to

falter. Set ISO to 100 for minimal digital noise.

1 Shoot wide-angle
For landscapes and cityscapes, it’s best to shoot 

with as wide a focal length as possible. On a DSLR kit lens, 

this is usually around 18mm, although on most cameras 

this is the equivalent of 27mm due to the APS-C sized 

sensor. As such, a lens like Sigma’s 10-20mm is perfect. 

Similar wide-angle lenses are available on mirrorless 

systems – see page 138 for our travel lens group test.  

3 Achieve pin-sharp focus
With your 

camera set up and 

ready to go, find an 

attractive composition 

(see Camera School on 

page 118 for more) and 

turn on single-point AF. 

Choose a point around

one third of the way up

the frame, and

half-press to focus.

Then switch your lens

to manual focus using

the AF/MF switch on

the lens, and you’re

ready to shoot.
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Above Charles Bridge is o

busiest landmarks, so it p

early. Once the sun is up, i

with tourists.

Right In low light condition

a tripod is essential.

Manfrotto’s small and light

Pixi is ideal for travel.

TIP 
FIND OUT 

SUNRISE TIMES
A photography app, such as

PhotoPills, will tell you the 

exact times for blue hour,

golden hour and sunrise 

for any given date and

location.
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TIP 
USE ORANGE

AND TEAL
These two colours go 

together extremely well. 
Combine the orange of 
your subject’s skin with 

a teal backdrop and/
or clothing.



Capture a cultural portrait
PROJ ECT 3

E
XPLORING A
new place always
turns up
interesting
characters, giving

you the potential to bag some
amazing portraits. This is
especially true if you’re
heading to countries such as
India or Morocco, where the
culture and way of life are very
different to the UK. Look for
faces with lots of personality
and people wearing bright,
traditional clothing. This will
give your images that National
Geographic feel, and a
distinctly different style to the
portraits you’ve shot before.

Shoot candids
One approach to travel
portraiture is to shoot candids,
so that the subject has no idea
they’re being photographed.
The most common method is
to hold your camera between
your hip and your chest so that
no one notices you taking
shots. This will allow you to
capture natural expressions
and document people as they
go about their daily life. This
approach can be tricky as
you’re more-or-less shooting
blind, though if you have a
camera with a flip-out screen,
angle this upwards to help you
with composition.

Focusing is tough too, so it’s

best to use auto-area AF, where
all points are active and the
camera focuses on the object
nearest the camera. Some
cameras also have face-detect
AF, which can help. Working in
aperture-priority mode, shoot
at f/8 so the depth-of-field isn’t
too shallow, and raise the ISO
for a shutter speed of at least
1/500sec. You won’t be able to
tweak settings as you shoot, so
these are a good start point.

While the ‘shoot-from-the-
hip’ method will enable you to
get up close and personal with
your subject, your hit-rate will

be quite low, and you won’t
always get the composition you
want. For this reason you
might prefer to use a longer
lens and shoot from a distance.
You’ll still be working under
the radar, but you’ll have more
opportunity to think your shot
through. Ideally, use a lens
with an equivalent focal length
of at least 150mm, and use your
widest aperture setting to blur
the background.

According to
photojournalist Robert Capa,
“If your pictures aren’t good
enough, you’re not close

enough”. With this in mind,
why not approach your subject
for a more intimate close up.
This can be daunting,
especially if you don’t speak the
language, but most people will
be very happy to pose for you.
Working in aperture-priority
mode, use a wide aperture to
blur the background, and select
single-point AF to focus on the
nearest eye.

Above Emotion helps produce

more eye-catching results

Left Get close up for a strong

connection with your subject
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Expert advice Use backlight for atmospheric results 
You won’t have much time 

to pose your subject, but 

a few small adjustments 

to their position can make 

a huge difference. 

The two most 

important things to think 

about are background 

and lighting. Look around 

you to see if you can see 

a clean, colourful 

backdrop, such as a 

colourful plastered wall, 

and change your angle so 

that it is located behind 

the subject. You can also 

ask them to move slightly 

if necessary. 

Next, ensure there’s no 

harsh sunlight on the 

subject’s face, as this 

almost always causes 

squinting, exposure 

issues, and hard shadows 

under the eyes and nose. 

If you’re in direct sun, 

move to an area of shade, 

such as under a tree, or if 

there isn’t one available, 

ensure the sun is striking 

the back of the subject. 

If you’re working at the 

start or end of the day, 

you can use a low sun to 

backlight your subject. 

This will ensure there are 

no extreme shadows or 

highlights at all on the 

face, and with any luck 

create a golden hairlight 

with a small amount of 

lens flare.
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T
OURIST HOTSPOTS, 
which often 
consist of a single 
landmark like the 
Eiffel Tower or Big 

Ben, are some of the most 
photographed locations on the 
planet. This makes it tricky to 
capture a unique and original 
image from an angle that no 
one has thought of before. But 
with a creative eye and some 
imagination it is possible to 
find a new perspective. 

When you arrive on 
location, don’t fall into the trap 
of immediately grabbing your 
camera and firing off hundreds 
of ill thought-out images. This 
is the classic tourist approach, 
and it’s likely to yield 
snapshots instead of creative 
or inventive images. Instead, 
leave your camera in your bag 
and take a few minutes to 
scout out the area, focusing on 
places where there aren’t 
many people. The temptation 

is to shoot from as close as you 
can get, but moving back 
100-200m can really pay off. 
You might even find a great 
angle by using a telephoto lens 
from a much greater distance. 
The Eiffel Tower photographs 
beautifully from Montparnasse 
Tower, which is 1.5 miles away, 
and from the Sacré Coeur, 
which is 3 miles away!

Look for natural frames to 
form a border around your 
landmark. These could be a 
bridge, a doorway, a tree 
branch, or even a gap between 
two buildings. If you’re
struggling, go into a nearby
café and frame your landmark
through the window. Natural
frames can play havoc with
your exposure, so it’s best to
switch to centre-weighted
metering. This will ensure the
camera exposes for whatever
is in the middle of the frame.

Look around you
At popular tourist landmarks,
everyone’s eyes are fixed on
the main attraction. But the
surrounding area can
sometimes offer real

photographic opportunity. 
Your job is to use your artistic 
eye to see the world in a new 
way, capturing images that 
others don’t notice. And even if 
you don’t get any award-
winners, at least they’ll be 
original, and that’s crucial to 
developing your own style. 

If you’re struggling to find 
a new take on your subject, 
try giving your images 
renewed interest by working 
at night or in misty conditions. 
Or shoot from an elevated 
position such as the top of 
another building, or from
ground-level for an unusual
angle, where a tilting screen
will help when composing.

Keep it clean
As a general rule, your shots
will be more effective if you
keep them as minimal as
possible. Avoid having both
cars and people in the frame,
and eliminate any unnecessary
elements by adjusting your
crop. In very busy locations,
crop anything at street-level
out of frame, and place your
landmark against the sky.

Take a fresh look at an old location
PROJ ECT 4

“LOOK OUT FOR FRAMES
TO CREATE A BORDER
AROUND YOUR SUBJECT...”

Expert advice Convert to black & white for extra impact
If your image doesn’t quite work in colour, why not
try converting it to mono instead. Architectural
photography is particularly well suited to black &
white, as when colour is stripped out, the viewer’s
attention is focused fully on the lines, shapes,
curves and patterns of the structure. This is
especially true on overcast days when there’s lots
of texture and character in the sky.

There are lots of ways to convert to mono in
Photoshop, so if you already have a preferred
method, stick with it. If not, open your image and go
to Image>Adjustments>Black & White. Then adjust
any of the six colour channels. If shooting on a blue
sky day, moving the Blue and Cyan channels to the
left to darken the sky can be very effective.

Above Natural frames, like this archway around Big Ben,
can help produce much more eye-catching results.

Above This image of Tower 
Bridge, shot on an overcast 
day, looks considerably 
punchier in black & white than 
it does in colour.
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With different creative approaches, a single landmark such as
the Eiffel Tower can be photographed very differently by
changing the angle, distance, foreground, framing and 
composition. Being inventive with how you shoot is more likely
to get you a unique and eye-catching shot.

Find a unique angle

TIP 
WORK IN

GOLDEN HOUR
Working at the start and end

of the day gives a soft,
golden light and lots of long 

shadows, which tends to
produce attractive

images.
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Feeling a little more
adventurous? Try these
five creative ideas to add
some extra spice to your 
travel portfolio...

1 Photograph a festival
The summer months are packed full of

festivals, carnivals and events that are perfect for

documentary photography. In Spain alone – the most

popular overseas destination for Brits – there’s the

wine battle in Haro in June, the Pamplona Bull Run in

July, and the Bunol tomato-throwing festival in

August, all of which are spectacles of colour, emotion

and movement. Working amid the hustle and bustle

of a busy event will push your shooting skills to the

limit. You’ll want to be in the thick of the action, and

this means having very little space or time to get your

camera settings right. For this reason, you’re best off

with a small and light mirrorless camera with a 

wide-angle lens. 

At some festivals, there’s a risk your gear may get

wet, dusty or even dropped, so think carefully before

taking an expensive camera or lens into the fray. 

Always wear a neck strap for extra peace of mind,

and consider investing in a weather-sealed model.

Tips for even 
better shots
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4 Keep looking up
If you’re heading off on a city break,

don’t forget to keep checking for great shots

directly above you. The converging lines of

tall buildings can look amazing in-camera,

and you’ll also be able to eliminate all the

hustle and bustle going on at ground-level.

You’ll get the best results on a sunny, blue sky

day, and by using an ultra wide-angle lens such as Sigma’s 

10-20mm (if using an APS-C DSLR).

5 Try forced perspective
This fun technique, which is

perfect for family holidays,

involves using perspective

distortion to make regular

objects look abnormally big or

small. If executed correctly,

the technique can be 

extremely impressive! The

key is in lining up your 

background object with your

foreground object as precisely

as possible. For best results,

choose an area with a clean

background, such as a beach.

2 Create a photo story
Why not document a complete record of your trip by

taking photos from the second you leave the house until the

second you get home. Sometimes the most memorable images 

come when you least expect them. You can then have your shots

printed in a photo album for a complete memory of your time 

away. Don’t forget, taking photos in less glamorous locations, 

such as a taxi or plane, doesn’t mean you can’t be creative.

3 Visit a market
If you want to inject some

colour and character into your 

portfolio, there’s no better place than a

busy marketplace, especially in North

Africa and India. Packed full of 

interesting faces and vibrant foods and

fabrics, these are ideal places for

amazing reportage photography. As markets are usually very

cluttered, stick to photographing details wherever possible. A

50mm prime is a great option, as it’s small and light and offers

a very wide aperture for blurry backgrounds. It’s also ideal for

candid portraits. You can buy a 50mm f/1.8 for around £100.

TIP 
CHOOSE A

SMALL APERTURE
You want both the extreme

foreground and background 

in shot, so use a very narrow

aperture of around

f/16 for a large

depth-of-field.
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Delivery to your door
print & digital combo
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Save up to 59%* when you subscribe to Practical Photography
and we’ll send you this Lastolite collapsible reflector!
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Easy online sign up
greatmagazines.co.uk/pp

About your gift
“Lastolite’s 50cm Collapsible Reflector 

is the perfect piece of kit for shooting 

portraits. Its double-sided reflective 

surfaces – one silver and one gold –

perfectly illuminate your subject by 

adding an extra burst of light into your 

images. It also collapses down to one 

third of its original size, and is supplied 

with a bag, making it easy to carry between locations. If 

you’re after a versatile 

companion for your 

portrait shoots, then 

look no further!”

Tim Berry,  

Deputy Editor

New Subscription Offer!

Double-coated reflective  

material prevents  

 cracking or splitting 

Silver and gold  

surfaces for creative 

 lighting effects 
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From Spitfires to stealth 
jets, John Dibbs has flown 
and photographed over
1200 sorties. And he still

can’t quite believe this is his job...

John Dibbs is a Seattle-based aviation
photographer and the brains behind
The Plane Picture Company.
He provides stunning air-to-air 
photography for the aerospace,
military and publishing sectors. 
facebook.com/theplanepicture
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W
INDBLAST, G-FORCE, 
cramped cockpits... it’s fair to 
say that John Dibbs’ working 
environment is a little more 
extreme than most. Even 
a dropped lens cap could 

result in serious injury. And if you think your 
AF system struggles at times, try pointing it at a 
camouflaged warplane through Perspex. Air-to-air 
is surely the ultimate photographic challenge...  

What is air-to-air photography? 
People often assume I take pictures of houses from 
an aircraft, but that’s aerial photography. Air-to-air 
is actually defined as taking photos of one or more 
aircraft from another aircraft while in flight. It’s 
very niche, primarily due to the cost of execution, 
the difficulty in gaining experience to be safe, and 
the incredible amount of effort it takes to get all the 
elements in the right place at the right time. Military 
clearances can take years to get. You could almost 
say waiting is my job and I get to fly on my days off! 

How did this become your specialist subject?
My fascination with flight started at the youngest 
age – as a baby I’d clap in my pram at the planes 
flying to and from Heathrow. However, it was my

father’s stories of Spitfires and Hurricanes that
he witnessed as a child at RAF Northolt during the
Battle of Britain that stirred my soul. Add to that
my creative nature and my course was set, even
though I didn’t know it at the time. I took a path
into photography via a studio in Covent Garden.
I’ve never had a photography lesson in my life, so
I started as a messenger boy, and spent every spare
minute in studios, labs and design departments.
It was a great place to learn how to shoot, what
clients wanted to pay for, and how the images
were used. I started to get mentored by the design
department and worked on British Airways design
jobs – I couldn’t ever find a photo in their aircraft
library that worked well in design, so that got me
thinking about aircraft imagery. I’m naturally
reserved, as I think most creatives are, but if
I believe in something then I put my energy to it.
I managed to convince BA’s marketing manager
that they needed new imagery and so went from
messenger and studio assistant to British Airways

“YOU COULD SAY WAITING FOR
MILITARY CLEARANCE IS MY JOB 
& I GET TO FLY ON MY DAYS OFF!”

Above Painted to 

represent famous 

pilot Douglas

Bader’s fighter

from the Battle

of Britain, this

Hurricane is seen 

flying above

Dover’s iconic

white cliffs.
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Above The Red 
Arrows as seen 
from within the 
formation. The 
jets are often 
only 18 inches 
apart and pull up 
to nine times the 
force of gravity 
during a display. 

Left Mustangs 
form a silent vigil 
to the fallen of 
World War II. 
Shot in Florida in 
1993, this is still 
one of John’s 
favourite images. 
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air-to-air freelance photographer. I’m now 25 years 
into my career and have flown over 1200 sorties. 
Funnily enough, during my lunch hour I’d nip
out to WHSmith and buy Practical Photography,
so this interview completes a circle for me!

Would you describe what you do 

as a job or an obsession? 

I don’t really see it as either, more my calling, 
though I don’t wish to sound pretentious. I just find 
I’m at one with being in the air to visually capture 
what’s happening up there, and love to bring that 
back to the ground for everyone else that loves 
aviation. I get excited at any really good aviation 
image, and by aircraft whether on one, in one, or 
looking up watching one. I’m just grateful to be 
part of it all and that I get to call it my living. 

What makes a great air-to-air image? 

I’ve been trying to answer that question for 25 
years! My hope is to convey the beauty of flight and 
the machines that achieve it, so the response of 
others is the best indicator of a good or great photo. 
I know what I like, however, and as a photographer 
you need a philosophy or approach that creates a 
style you get known for. Some flying machines are 
as beautiful and as enigmatic as any model or film 
star, and I want people to get that from my photos. 
I’ve become known for what the flying community 
calls ‘in yer face’ imagery, where you feel you can
reach out and touch the subject. Working with 
the right pilots, and with a team that trusts each 
other, it’s quite easy to get so close that you can 
only hear the roar of a Spitfire’s Merlin engine, for 
example, over the noise of the camera – 2000hp of 
unsilenced 1940s Rolls Royce engine can be felt in 
your chest when it’s flying a few feet off your wing. 

Tell us about your very first air-to-air shoot… 

My first photo sortie was with a De Havilland 
Chipmunk, a light post-war trainer, and I was in 
a Piper Cub. I had no idea that I was about to start
a career when I loaded that roll of Velvia into a 
borrowed Canon F-1. Looking back, it was as though
I had some insight into myself years later, instructing
the pilot to get closer, move farther away etc. 

Afterwards the pilot, an ex-army aviator, took me
to one side and said, ‘How do you think that went?’
I told him I wasn’t sure. He said to me, ‘Just one 
thing, you didn’t know anything about my piloting
background yet you wanted me to get close. That
can be very dangerous. Only do this with people that
you know can fly formation’. It was the best advice
I could have ever got, especially that early. A split-
second lack of concentration could end in ‘swapping
paint’, as pilots like to refer to a mid-air collision.

“SOME PLANES ARE  
AS BEAUTIFUL AS ANY
FILM STAR OR MODEL &
I WANT TO SHOW THAT”

Above

John was lucky enough to capture them on a transit flight down the south coast. 

Above A Supermarine Spitfire MkV that saw combat in World War II returns to 

familiar English shores, just as it would have in 1942. 



What have been your defining

air-to-air moments to date? 

There have been several highs over the years. 
I recall coming alongside a Concorde for the first 
time – that was phenomenal. Any Spitfire shoot 
is exceptional – you don’t just observe and shoot a 
Spitfire over England, you feel it. When you’re above 
the clouds with a Mk I, there’s nothing to say you 
are not in 1940. Geoffrey Wellum, the famous Battle 
of Britain pilot, said that when he sees Spitfires fly 
now, they’re like friendly ghosts, and that’s very 
true. There’s a connection to those arduous times 
and The Few. In fact, my biggest motivation is to 

create illustrations for articles and books that tell
the story of those that went before. We should never
forget their service. More recently, I’ve moved into 
TV and film projects, directing aerial sequences. 
Another high was flying with the Red Arrows for 
the first time. It all looks so elegant from the ground, 
but it’s a battle of G-force, disorientation and power 
that leaves you exhausted. Incredible pilots. 

Talk us through the practicalities 

of air-to-air photography…

The basics are very much rooted in military practices 
and the preparation is almost ritualistic. The camera 
gear is very much a secondary consideration after 
briefing and planning – plan for the worse and 
you avoid it. There are so many issues to combat in 
this game: extreme windblast, cold, heat, G-force, 
negative G, disorientation, lack of familiarity with 
your surroundings, cramped cockpits. There can 
be no loose equipment, as dropping a lens or lens 
cap can snare controls, or worse, for those on 
the ground, fall out of an aircraft. So I don’t let 
anything rush me. You become part of the aircrew, 
whether that’s in a WWII trainer like a T-6 or in 
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“THE BASICS ARE 
ROOTED IN MILITARY 
PRACTICES & THE PREP 
IS ALMOST RITUALISTIC” 

Above Captured 

against a late 

summer sunset, 

John had to be 

mindful of this 

Vulcan’s massive 

air frame.

Below A Hellcat 

flies alongside its 

rival in combat, a 

Zero, against an 

amazing sunset.
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a supersonic F-15, so that needs to be your mindset. 
I often spend as long in the briefing as we do in 
the air, as it’s a collaboration and anyone has 
veto. You have a huge responsibility not to mess
up. Only after all that preparation do you turn 
to your cameras. Generally, I can illustrate the 
shot through another image and that replaces all
the pilot’s hand waving. I don’t use a neck strap,
always a handgrip, as if you eject with a neck 
strap then you could do some serious damage. 

Talk us through your techniques…
Shooting a WWI aircraft or an F-22 is as different as
shooting still life is to a wedding. The only constant
is that it takes place in the sky. I shoot mainly for 
books and calendars, so I know what visual story
I need to tell to fill pages etc. That’s how I work out
my compositions. Then you have the limitations of the
platform you’re working from. You can only see what
you can see out the window or canopy. Exposure
I generally trust to Canon’s metering – every frame
has different light, as you travel so far in each 
moment. Focus is a challenge too, as camouflage on
warplanes can trick autofocus, and you’re shooting
through Perspex sometimes, so I would say focusing
is my most important role in operating the camera.
RAW can rescue exposure issues, and you can 
re-crop with such large sensors, but if it’s soft, 
it’s soft, so I pay a great deal of attention to focus.

Talk us through your mental and 
physical approach to shoots…
To fly in military fighters, you have to do quite 
a lot of training, mostly based on worst-case 
scenarios – ejection seat training, what to do if 
there’s a fire on take-off, and water and land survival
skills. Basically, you’re a fighter pilot for the entire
duration of the sortie, and as a civilian you have to
go through that process every time you fly. To fly
in civilian aircraft is easier, more like the safety
brief on an airliner. It’s ironic that I’m scared of
heights, and don’t like airliner flying. That aside,
you have to be fit and flexible – I watch my diet
and try to keep in shape. I also avoid inflammatory
foods, as twisting around while lashed to a seat
with a parachute cutting into your shoulders and
sitting on a hard dinghy pack strapped to your 
backside can leave you seized up the next day. 

What cameras and lenses do you use and why?
I use Canon equipment. The EOS system is 
superb for what I do, and I love its simplicity and
ergonomics. My kit generally gets harshly treated
from temperature, sharp metal in cockpits and 
exposure to G-force. I can honestly say that I’ve 
never had a camera failure in the 1200 sorties I’ve
flown and that includes external-mounted Canons
outside jet fighters. So, my EOS is like my best mate
in the air – reliable and trustworthy! When you 
look out on the wing and see a Concorde or maybe
nine Spitfires in formation, you want that camera
to work. L series lenses are fast and responsive, 
and I generally operate two bodies in the air. 
At the moment, I use the EOS 5DS R and have
a 28-70mm f/2.8L and 70-200mm f/2.8L Mk II. 

1
WORK IT OUT
Being prepared is the

best way to approach a

subject you have no control over,

so working out where to be in

regard to light and aircraft flight

line gives you the best chance of

getting a good shot. Too far away

and it’s underwhelming, too close

and it’s likely to result in poor

composition and lack of focus.

2
PICK ONE LENS
Having all sorts of lenses

and cameras around can

lead to fatigue and indecision, so

make a choice and stick with it.

I like to pick a focal length and

create images based on that

choice. So if you have the sort

of lens that allows you to reach

a Spitfire at the top of a loop,

concentrate on getting that sort

of image. Also, always track the

subject, even if against the light, 

as you never know when a magic 

sparkle of surface deflection might 

get you that standout image.

3
FOCUS ON INFINITY
For jets, both military and 

civil, a fast shutter speed 

is an option, and as you’re most 

likely shooting at infinity a wider 

aperture won’t be an issue. I like 

to keep a low ISO, so you can crop 

into the frame too if needs be, to 

create drama and not lose quality.

4
GO SLOW FOR PROPS
For props a slower shutter 

speed is essential, so you 

don’t create ‘camera induced 

engine failure’, as I like to call 

frozen props from fast shutter 

speeds. For air-to-ground images  

I tend to use a maximum of 

1/250sec-1/320sec on warbirds. 

 Pro advice 
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The incredible variety on offer with street photography is impossible
to deny – all it takes is five minutes wandering around a city and you’ll
be rewarded with ten wildly different images. Whether you’re shooting 
from the hip, zooming in on the action from across the road, or directly 
interacting with your subjects, capturing people as they go about their 

everyday life is a fantastic way to hone your photographic skills.  
So prepare yourself for an adventure, as we show you how to capture 

the humming hubbub of the street. 

COM PLETE GU IDE

D I S C O V E R  
T H E  T H R I L L  O F

STREET 
P H O T O G R A P H Y

PROJECT 1 
Frame your subject 

using unusual 
architecture

P60

PROJECT 2 
Shoot parties and 

protests to capture 
movement

P62

PROJECT 3 
Reveal more about 
your subjects with 
intimate portraits

P65

Three brilliant street projects to inspire you... 
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HOOTING ON THE
street can produce an
interesting combination
of both architectural
photography and candid
portraiture. However,

many photographers will often ignore
their surroundings and focus solely on
the action. This is understandable when
you’re shooting such a fast-paced subject

as street life. With the circumstances
changing so swiftly, you might feel like
you should always have your camera to
your eye and be taking shots non-stop.
However, this isn’t always the best
option for shooting amazing images.

The decisive moment
Rather than simply ‘spraying and
praying’, this genre gives you the

perfect chance to lie in wait for the
ideal photo and then pounce as soon
as the right opportunity comes along.
Henri Cartier-Bresson, the grandfather 
of street photography, pioneered the
concept of the ‘decisive moment’ –
the split-second when a composition
presents itself and you must intuitively
know when to press the shutter.

To put this concept into practice,
all you need to do is find yourself an
interesting environment and wait
for potential subjects to wander into
it. Look for dynamic shapes, such as
doorways, windows or gaps between
buildings, then compose your shot
and stand by ready to shoot once
someone walks into the image. The 
beauty of this technique is that you 
can use it again and again at the same 
location, with a completely different 
subject in the frame each time.  

Use auto ISO
The exciting, yet simultaneously nerve-
racking, nature of street photography 

PROJ ECT 1

Frame your s j t

n Photoshop, go to Image>Adjustments>Channel Mixer 
nd simply tick Monochrome. Alternatively, you might 

want to use Image>Adjustments>Black & White instead. 
fter you’ve converted your image to mono you’ll want 

o make the shot pop by increasing the contrast. There 
re a variety of tools that you can use, but the simplest 
to go to Image>Adjustments>Brightness/Contrast 

nd use the sliders until you get the desired result.

If you prefer Lightroom to Photoshop you can turn to 
age 72 to get editing expert Dan Mold’s tips on how to 
reate moody mono masterpieces from any photograph.

Convert to mono in post-production
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is that there are no second chances. 
After you’ve pressed the shutter, the 
moment will have disappeared forever 
and there’s no way to recreate it. This 
means that selecting the correct settings 
for the situation is absolutely paramount 
when preparing for your shot. 

Auto ISO is a very useful feature 
that can help save your images from 
being incorrectly exposed. This setting 
will automatically adjust your ISO 
with each individual shot. This means 
that if the light suddenly changes 
you won’t be caught unawares and 
left with a multitude of under- or 
overexposed shots that could have 
otherwise been real winners. 

The best part about this setting is 
that not only can you set your maximum 
ISO (which we would recommend to 
be ISO 3200), but you can also choose 
a minimum shutter speed. This means 
that you can set your camera to never 
go below 1/125sec, which will ensure 
that all of your shots will remain 
perfectly sharp and blur-free.

Gear What kit should 
you be using?
// An all-purpose 18-55mm zoom lens

There’s no need for massively expensive kit when 

shooting street photography. In fact, the smaller and 

lighter your equipment is, the better it’ll serve you. 

A standard kit lens with a focal range of 18-55mm 

will be perfect for giving you the flexibility to zoom in 

on the action or go for a wider view. An unfortunate 

downside to kit lenses is that they don’t tend to come 

with particularly wide apertures, especially when you’re 

using a narrower focal length. This means that you’ll need to 

push your ISO higher than you might like. However, Canon’s new 18-55mm, 

for instance, comes fully equipped with image stabilisation, which will 

help you use slower shutter speeds. Not only is this an inexpensive piece 

of kit, it’s also a great way to get to grips with street photography.

// A handy flip-out screen

If you’re new to shooting on the street then you may feel uncomfortable

and overly conspicuous when you hold your camera to your eye at first.

Alternatively, you may be an experienced street shooter but you don’t want

to draw any attention to yourself while you’re trying to take your photos.

The best way to shoot surreptitiously is to use a camera with a flip-out

screen. This helps you look like you’re simply looking through the images

you’ve already taken, diverting your subject’s attention away from your

camera. The Nikon D5600 uses a vari-angle touchscreen, which allows

you to take a photo without even pressing the shutter by simply touching

the screen. Another great thing about the flip-out screen, aside from

the fact that it helps you to maintain a certain amount of anonymity as a

photographer, is that it also allows you to shoot from unusual angles.

Above & left Make sure the

autofocus is turned on, and

don’t be afraid to zoom in on

interesting people or activities.

Below & left Use the

virtual horizon in

Live View to ensure

your shots are

perfectly level. 

TIP 
PRE-FOCUS 

YOUR SHOTS
To ensure your shot is as 

sharp as possible, or to get 

around being slowed down 

by AF, focus on a pre-

determined spot and 

flick to manual. 

SABRIN
A SCUCCHI



C
APTURING AN ICONIC
street photograph isn’t
so much a question
of skill, but rather of
being in the right place
at the right time. The

best way to increase your chances of
shooting an image that people will

remember for generations to come is
to purposefully find events, protests or
marches where dynamic and exciting
interactions between people occur.

Whether it’s a peaceful march, a
protest with steadily rising tensions or the
carefree fun of a street festival, there’s no
better way to capture the full range of

human nature than by documenting
organised street events. While it’s always
wise to be careful, especially if you’re
attending a protest on a contentious issue,
emotionally-charged situations like these
can produce fascinating results.

Search for adventure
If you’re new to shooting organised
events, it’s best to begin with street
festivals. These are a great place to
capture people, as they’ll be focused on
having fun and celebrating with each
other. The Notting Hill Carnival in
London is a fantastic event to start off
with if you’re looking to experiment. The
colourful costumes and lively atmosphere
will give you plenty of dynamic shots.

The most important part to remember 
is that it has to be safety first with this 
genre. If you’re at a protest and it looks 
like things are going to turn violent then 
it’s time to leave. No shot is worth risking 
your life or health for. If you’re at a street 

PRACTICAL PHOTOGRAPHY
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Above Capture the carefree fun of street parties by isolating a figure out from the

crowd as a focal point. This will create a pleasing composition for the viewer. 

“NO SHOT IS 
WORTH RISKING 
YOUR LIFE OR 
HEALTH FOR...”
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Gear What kit 
is best?

// An inexpensive point-
and-shoot camera
While image quality is obviously 

important, the better your camera 

is the higher the price-tag it 

tends to boast. You might have 

the perfect kit for working in low 

light conditions with fast-moving 

subjects, but that doesn’t 

necessarily mean you should 

bring it to a lively protest held at 

dusk. You should always judge 

each shooting situation before 

you set off, and work out whether 

it’s worth using your normal 

kit or whether you should take 

a less expensive camera with 

you. Using a point-and-shoot 

camera will make you a less 

desirable target for thieves.

// A sneakily incognito
camera bag
If you decide that the event you’re 

attending is going to be relatively 

sedate and that there’s not much

chance of anything going wrong, 

then the next step to protecting 

your valuable equipment is to 

disguise it. Normal kit bags are 

great for long hikes to remote 

locations, but they stick out like a 

sore thumb when walking through 

the city. The ideal situation is that

you’re able to put your camera away 

and instantly blend into the rest of 

the crowd. The best way to do this 

is to use a messenger bag. This 

has the benefit of 

helping you 

blend in, while

having the

same level

of padding

as a normal

kit bag.

Know your rights
as a photographer
Shooting situations

where there are

members of the public

means that, almost

inevitably, someone may

challenge you and say

that you’re not allowed to

photograph that person

or place. Ensure that

you’ve brushed up on

your legal know-how so

that you know exactly

what your rights are in

any given situation. It’s

worth noting that these

tips all relate to the UK,

so if you’re working

abroad then you’ll need

to research the law there.

Property
The general rule with

photographing property

is that if it’s a public

piece of land then you’re

free to shoot

there. However,

if it’s privately

owned then you’ll

need to seek permission.

This means that it’s

always worth checking

what the deal is with

your desired location

before you set off.

Police
There’s no law stopping

you from photographing

police. The Metropolitan

Police’s own guidelines

says that ‘police have no

power to stop [people]

filming or photographing

incidents or police

personnel’. The only

exception to this would

be if they believed the

images would be used

for an act of terrorism.

People
You may be surprised 

to learn that you can 

photograph people on 

public land without their

express permission 

and still sell the images. 

The only restriction on 

this is that they can’t

be used for commercial 

purposes, in an advert 

for example. However, 

if someone is on 

private property then

they have the right to 

privacy, so you can’t 

photograph them without

permission, even if you 

have the permission of 

the property’s owner. 

festival stay constantly vigilant to protect 
yourself against pickpockets. 

Set up your camera 
With swiftly changing situations like 
organised street events it’s difficult to 
recommend particular settings that will 
carry you through the whole day. As 
recommended in the last project, using 
auto ISO will help to make sure that all 
of your images are correctly exposed. 
You can also shoot in aperture-priority 
to ensure that you have to manually 

touch your settings as little as possible. 
When deciding on what aperture to use 
it’s definitely worth thinking practically. 
If you use a wide aperture, then you’ll
be able to isolate your chosen subject 
from the background, which will be less 
confusing for your viewer. However, if 
people are moving around quickly in 
your shot then you may struggle to get 
the key parts of your image crisp. Use a 
narrower aperture like f/11 to have a 
better chance of getting your shot in 
focus in busy situations. 

VIDEO
WATCH OUR

VIDEO ON YOUTUBE
Go to tinyurl.com/streetrights 

to access Tim Berry’s video 

on how you can practice 

your photography

within the law.





Get intimate with
your subjects

T
HE BEST THING
about street
photography is that
there are no hard
and fast rules that
you need to stick by.

Your shots could be fly-on-the-
wall depictions of everyday life,
or could say something a little
deeper about the people in the
frame. Interacting with subjects
to find out more about them can
create some really powerful
portraits, so don’t be afraid to put
down the camera and employ your
most useful weapons – a genuine
smile and a curious personality.

Find interesting subjects
You don’t have to stick to the streets
for these kinds of portraits. Instead
visit conventions, festivals or
specialist events where you think
there will be lots of unique
personalities. This is a great way to
quickly build up an eye-catching

body of work in a relatively short
period of time.

The best way to approach
would-be subjects is with a friendly
manner that makes them feel at
ease. Tell them that you think they
look great and that you’d love to
shoot a portrait of them. They may
feel wary at first, so employ some
gentle persuasion but don’t go
overboard. If they’re genuinely not
interested then just thank them for
their time and move on to finding
another person.

Once you’ve found a subject, it’s a
good idea to spend a little bit of time
chatting to them before bringing
your camera into the equation. If the
person feels tense this will translate
into the image. Ask them questions
about themselves to get them to open
up. Once they’re relaxed then they’ll
be much more open when facing the
camera. This will help you capture
portraits that reveal something
important about your subject.

The best way to separate a

serious portrait from a

quick snap is a neutral

expression rather

than a smile.

TIP 
GET A NATURAL 

EXPRESSION

PROJ ECT 3

Gear What kit
is best?
// A fully versatile
50mm lens
For portrait photography,

no piece of kit can beat

a simple 50mm f/1.8

prime lens. The crisp

sharpness and lack of

distortion means that

your subject’s face will be represented in

the most flattering way possible,

while the wide aperture means that you

can produce shots that isolate the faces

from the usually quite busy nature of

the background.

// A fast memory card
A memory card with a lightning-quick write

speed is absolutely essential for any kind

of street photography. The write speed

describes how fast images can be saved

onto a card. If you’re taking lots of shots in

a short period of time you don’t want to be

slowed down by your card buffering. You

can also increase your memory card’s write

speed by formatting it. Just make sure your

images are already saved!
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‘Prints were perfect from the first test’ –
f2 Cameracraft Test, Jan/Feb

‘Saves the hassle and wastage of cutting down larger sheets... 
well worth exploring’ –
Photography News Test, Jan
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60 MINUTES
OF VIDEOS ON
YOUR FREE CD

When you see this icon 

on the page you can 

find a full tutorial on

this issue’s video disc. 

Turn to page 6 to find even

more multimedia content. 

Learn exciting new editing techniques 
from the UK’s best digital experts...

68 Polish your travel shots
Use Lightroom to process and

clean up RAWs to a professional standard

72 Make a mono masterpiece
Convert images to black & white in

Lightroom and create images that stand out

80 Enhance eyes and smiles
Make subtle facial adjustments with

the Liquify tools and improve portraits

82 FREE! Use your brushes
Use this month’s custom brushes

to give your portraits the ‘wow’ factor

86 Create a fantasy world
Play with scale and reality to

breathe new life into your macro images

92 NEW! Photo Fixer
Stuck in an imaging rut? Send them

to us and we’ll retouch them for you!

96 Crop and clone 
Remove distractions and strengthen

compositions with the various clone tools

98 NEW! Photoshop hacks
Use Smart Previews, extract stills

from video, and set your white point quickly

76 THREE EASY WAYS TO 
IMPROVE LANDSCAPES 
Super-fast fixes for detail and drama

32 EXTRA PAGES  
OF THE BEST 

TUTORIALS FOR  
ALL LEVELS

New!

NOW INCORPORATING

EASY PHOTOSHOP ADVICE 
THAT REALLY WORKS
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Polish up your
travel photos in
Lightroom WHAT

YOU NEED
Q Photoshop Lightroom 

6 or CC

Q A RAW from your
travels in need of a 

clean up

AFTER

DA
N 

M
O

LD
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1
Apply basic adjustments and lens corrections
Open your shot into Lightroom by going to the Library module and clicking the

Import button. Under Source, navigate to the location of your RAW. Make sure the

image thumbnail has a tick next to it and hit Import to bring the image into Lightroom. Go to

the Develop module and click on the Basic panel. Now drag the Exposure slider until you’re

happy with the brightness of the whole pic. Increase Contrast to +10, Clarity to +15, Vibrance

to +50 and Saturation to +10 for more impact. Expand the dynamic range by pushing the

Shadows and Whites sliders to the right and pulling the Highlights and Blacks to the left.

Then, go to the Lens Corrections panel and under Profile, tick Enable Profile Corrections.

The Lightroom workflow 

operates in an entirely 

different way to Photoshop 

so can seem daunting to 

get to grips with. But you’ll 

soon familiarise yourself 

with the layout when 

you’ve made a couple 

of RAW conversions. 

Here’s what you need to 

know about the Develop 

tab, which is where you 

make your edits...

Lightroom 
interface 
explained

Modules

The most useful modules

are the Library, where

you can import your

pictures, and Develop,

which lets you process

your RAW files. The Print

module is also handy if

you want to print directly

from Lightroom.

Adjustments

The Adjustments are all

collapsible panels. Click on

them to expand and they

will reveal the sliders and

controls within. These

contain powerful editing

options, from Exposure to

Sharpening, and Noise

Reduction to Split Toning.

Toolbar

For more precise adjustments,

there’s a handful of tools found

under the histogram. Here you

can apply a crop, remove

spots, correct red eye, add

graduated and radial filters

and adjust specific areas of

your pictures using the

Adjustment Brush Tool.

 Filmstrip 

The Filmstrip sits at the bottom of the 

interface and lists the images from 

your latest import. This makes it easy 

to flick through the images in your 

current import. You can star rate your 

pics with number keys 0-5, and using 

the Filter you can reduce the images 

shown in the Filmstrip to just the 

ones you want to work on.

Above Lens defects such as 

distortion and vignetting can be 

ironed out in Lightroom’s Lens 

Distortion panel.
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2
Crop your shot and level-up
Click the Crop Tool from the Toolbar, and click

on the ruler icon to switch over to the Straighten

Tool. You can then level-up by dragging your cursor over the

horizon to make it perfectly horizontal. When done, you can

pull in the corners of the crop overlay to get your desired

crop – hold the Shift key down as you do this to maintain

the original aspect ratio. You’ll see a rule-of-thirds overlay

appear, which you can use to strengthen your composition

by lining up one or two of its lines with your focal point.

When it looks perfect, hit Done to apply the crop.

3
Make your shot razor sharp
Head down to the Detail panel and set the

Sharpening Amount to 50 to give the shot a good

kick of sharpness. Now, hold down the Alt key and drag the

Masking slider to the right, until only the parts you want to be

sharp appear in white (like in the shot above). Then set the 

Luminance slider to reduce the amount of Noise in your shot.

This was set to 15 for this image, taken at an ISO of 100, but

may need pushing further if you shot at a higher ISO value.

4
Remove distracting dust spots
Dust on your camera’s sensor can result in small dark

circles appearing in your pictures. But they are easy

to fix in Lightroom. Just grab the Spot Removal Tool and resize

the brush with the [ and ] keys until the cursor is slightly bigger

than the dust spot. Now paint over the spot to replace it with

nearby pixels. You’ll see the sourced area appear, which you can

drag to fine-tune where Lightroom replaces the pixels from.

5
Apply a Graduated Filter
Click on the Graduated Filter Tool from the Toolbox 

then drag your cursor from the top of your shot down 

to the horizon. Hold the Shift key down while you do this to 

ensure the filter is applied completely straight. Now you can set 

the adjustments of your Filter. For this shot, the Exposure was

set to -0.70 and the Temperature was increased to 5, to make

the sky a little darker and warmer. You can also erase parts of

the filter by clicking Erase and then brushing over any offending

areas, such as the temple towers in this picture. When you’re 

finished, go to File>Export to bring up the Export dialoguet
box. Choose the location you want to save your shot to and 

set the Quality to 100, then hit Export to save your shot.

GENIUS When you’ve applied your 
Graduated Filter you can erase any areas 

that you don’t want to be affected

//  // VIDEO ON THE DISC
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Convert to black & white for
images that really stand out from
the crowd. Dan Mold reveals how
to do it in Lightroom.

DA
N

M
O

LD

Make a mono 
masterpiece  
in Lightroom 
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T HERE’S AN OLD
saying that the
whisper is louder

than the shout, and nowhere
does this apply more in
photography than with black &
white. Saturated full-colour
images can make a scene look
too busy – it’s all too easy for the
eye to be pulled away from the
main focal point by bright,
distracting colours elsewhere in
the frame. Converting to mono
removes this problem, allowing 
the composition, shape, light
and tone to shine through 
instead. Black & white is also a 
great way of saving an under- 
or overexposed shot from the 
trash, as you can push mono 
files much harder for creative, 
often abstract results.

Use RAW power
The best black & white images 
come from full-colour digital 
RAW files. Editing these 
files with a program such as 
Lightroom allows you to adjust 
the brightness of the individual 
colours within your shot. And 
as you’re editing the RAW, you’ll 
never lose the original colour 
image – you can always go back 
and rework it at a later date.

All you need is a RAW file, 
Lightroom and 10 minutes 
to give your colour shot 
a classic mono finish.

// LIGHTROOM 

AFTER

BEFORE

Above There’s loads of colour 

detail in this picture, but it looks 

quite flat and lacks contrast. It’s 

also underexposed, so it’s hard to 

see what’s happening in the scene.

Left By applying a mono 

conversion in Lightroom we’ve 

been able to tweak the brightness 

of each colour channel to 

accurately adjust the contrast.

WHAT 
YOU NEED
Q�Photoshop

Lightroom 6 or CC

Q A photo in need of

a powerful mono 

conversion
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3
Convert the picture to black & white
Go to the HSL/Color/B&W panel and click on B&W to remove the colour. The

RAW file still holds the colour data, which you can take advantage of in Lightroom

to darken or lighten these areas. Pull the colour channel sliders to the left to darken or 

to the right to lighten your mono image. Pushing the Blue slider up will brighten the sky 

along with any other blue areas. There’s also a little icon you can click, which will allow 

you to adjust the black and white mix by dragging your cursor in the photo. Click the icon

to make it active, then click and drag up or down on the tone you want to tweak to change

its luminance. You can also hit Auto to reset the sliders back to the default values.

Above You can sample the colour 
you’d like to adjust by clicking on a  
small icon in the B&W panel.

1
Import and fine-tune the exposure
Open up Lightroom and click on the Library module.

Now click on the Import button and under Source

navigate your way to the location of your RAW image. Make

sure it has a tick next to it and click Import to load your image

into the Lightroom interface. Now go to the Develop tab and

click on the Basic panel, then adjust the Exposure slider until

you’re happy with the overall brightness. To increase the 

dynamic range, pull the Highlights slider to the left and push the

Shadows to the right, then set Whites to +40 and Blacks to -5.

Now set Contrast to +10 and Clarity to +20. The Vibrance and

Saturation sliders have no effect on the mono conversion, so

can be left at the default values.

2
Increase the detail
Staying in the Develop module, click on the Detail 

panel to expand it and reveal its sliders beneath. 

Now drag the Sharpening Amount slider to 50 to increase 

the sharpness of the shot. Then hold the Alt key down and 

drag the Masking slider until only the areas you want to 

sharpen are shown in white against black – any black areas 

won’t be sharpened, so noise won’t be exaggerated in any 

out-of-focus areas. You can also reduce noise caused from 

shooting at a high ISO value using the Detail tab. All you have 

to do is drag the Noise Reduction Luminance slider to the 

right. But this mono conversion would actually benefit from a 

little graininess, so it has been left at its default value of 0.
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4
Add a stylish vignette and film grain
With the contrast of the colours now set it’s time

to add a few little flourishes. A vignette is a great

way of directing the viewer’s eye towards the middle of 

the image. It’s really easy to apply a vignette too. All you 

need to do is go to the Effects panel, where you’ll find the

Post-Crop Vignetting options. Drag the Amount slider to 

the left to make the corners darker or to the right to make

them lighter. A dark vignette works well with this shot, so it

was set to -30. A gritty grain effect would also look great,

so the Grain Amount was set to 70 in the Effects panel too.

5
Enhance the exposure
Head back up to the Basic panel. Now you

can see the image in black & white it’s worth 

re-adjusting the sliders here to really finesse the contrast 

within your picture. You’ll see the Vibrance and Saturation 

sliders have been greyed out because they now have no 

bearing. But the Temperature and Tint sliders, used to 

refine the White Balance, can still be used and this can 

have a big effect, so they are worth experimenting with. 

6
Apply a Tone Curve to boost contrast
Contrast can be pushed much higher in mono images

than with colour. To give your shot a powerful punch,

go to the Tone Curve panel and give it a click to reveal the Tone

Curve options. For a small boost, set the Highlights to +15,

Lights to +10, Darks to +5 and Shadows to -20. You can also

change the Point Curve from Linear to Medium Contrast or

Strong Contrast to make the contrast stronger if preferred.

7
Export your image to save it
When you’ve finished making your adjustments you 

need to export the shot out of Lightroom to turn it 

into a JPEG that you can then upload to the web. To do this, go 

to File>Export, then under Export Location>Export To choose 

the folder where you want to save your picture. And under File 

Settings change the Image Format to JPEG and the Quality to 

100 for the best quality. You can revisit the RAW at any time to 

adjust the sliders, for example you could make a colour version. 

If you do this you don’t have to lose your mono settings. Just 

right-click on the image thumbnail in the filmstrip and click Create 

Virtual Copy. You’ll then have an identical picture that you can 

process without losing your black & white adjustments. 

GENIUS Tweak the individual colour 
channels of your mono shot for greater 

control over the tones in your scene

//  



B RITAIN’S COUNTRYSIDE
boasts some of themost
photogenic places on earth,

with a variety of fantastic landscapes just
waiting to be captured by photographers
like yourself. But translating incredible
scenes into great images isn’t always so
simple. That’s because the human eye can
see amuchmore extensive range of tones
and detail than your camera can. Sowe’ve
come upwith three quick fixes that will
help you polish up your pictures, from
balancing out the exposure to increase
the dynamic range, to creating a retro
sepia effect.

But first we’re
going to cover one
of the most basic
elements of landscape
composition, and that’s achieving a
perfectly level horizon. It’s the first
thing photographers notice and if it’s
not entirely straight it can have a hugely
detrimental effect, even on the most
impressive of vistas. Don’t worry if
you’ve already taken your landscape
shot though, as it’s easy to fix a wonky
horizon in just a few clicks. And
unlike cropping, our method doesn’t
reduce resolution, so let’s get to it...

Take your scenic images
to the top of their game with
these three super-fast fixes.
Dan Mold explains all.
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Easy landscape
treatments3

Left There’s a brilliant

landscape here, but

a few minor tweaks

would really take it to

the top of its game.

Right In less than a

minute the horizon

can be straightened

to strengthen the

composition. Our

method also keeps

the original resolution

of the picture, unlike

when you crop.

1
Activate your rulers
Open your landscape into Photoshop
and hit Ctrl+R to switch on your

Rulers if you can’t already see them, or
Ctrl+Shift+R in Elements. Click on the ruler at
the top of the screen and drag a guide down
to where you’d like the straight horizon to go.
To move the guide after you’ve placed it, just
hold the Ctrl key down to move it around. If at
any point you want to remove the guides hit
Ctrl+; to momentarily hide them from view.

BEFORE

ED
RH

O
DE

S

WHAT
YOU NEED
Q Photoshop or

Elements

QA landscape image

that you’d like to

improve

1Level up like
a professional

AFTER
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2
Straighten up 
the horizon
Hit Ctrl+J to

duplicate your Layer, followed
by Ctrl+T to put it into Free
Transform mode. Now hold
the Ctrl key down and pull the
top corner handles up until the
horizon is perfectly straight.
Alternatively, you could use
the Crop Tool to level up, but
cropping means you lose
resolution. Using this method
you’ll be able to straighten up
without reducing your pixel
count. When you’re done, go
to Layer>Flatten Image.

// PHOTOSHOP & ELEMENTS 
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1
Select the
foreground
Go to your 

Toolbox and grab the

Lasso Tool. Make sure

Feather is set to 0px. Draw

around the foreground of

the landscape (or another

area in the image that

you want to brighten),

and you’ll see marching

ants appear around it.

Now click Refine Edge

and set Feather to 50px

to soften the edge of 

the selection. Click OK

to apply the effect.

2 Lighten the 
foreground in
two steps
ONE OF THE HARDEST PARTS OF 
shooting a landscape is dealing with the 
different brightness and contrast between 
the dark foreground and bright sky. Many 
professionals use a graduated ND filter 
to reduce the light in the sky to create 
a balanced exposure across the frame. 
But this is often a bit of a faff, and you 
may already have some great landscapes 
in the bag. Your best bet is to expose for 
the sky, as burnt out highlights are much 
trickier to rescue, but a slightly dark 
foreground – like the one in this picture 
– can be lifted in just a few minutes.

AFTER

2
Lighten 
with Levels
With the selection

still active, go to your Layers

panel (Window>Layers) and

click on the Create new fill or

adjustment layer icon and

choose Levels from the list

that appears. The marching

ants will disappear and the

selection will become a Layer

Mask. In the Levels panel,

drag the middle Midtones 

slider to the left or right to

brighten or darken the 

foreground respectively. When you’re done, close the Levels 

panel and save your image under a new file name.
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2
Apply a retro sepia tone
Go to your Layers panel (Window>Layers) and click

on the Create new fill or adjustment layer icon, then

choose Photo Filter from the list that appears. Click on the

Filter drop-down box and set it to Sepia (or experiment with

others) and set the Density to 100% to strengthen the filter.

You can skip Step 1 if you would prefer a sepia style without

the film grain. When you’re done, go to Layer>Flatten Image
to merge your Layers down.

GENIUS Change the
effect of Photoshop’s 

photo filters by adjusting 
the Layer Opacity or by 

stacking up multiple filters 
on top of each other

3 Apply a vintage sepia effect
CREATE A CLASSIC SEPIA TONE 
in just ten clicks using Photoshop or 
Elements. All you need to do is apply a little 
digital noise to replicate the effect of 
analogue film grain. To add the warm sepia 
tint, you simply insert a Photo Filter 
adjustment Layer. If you like just the 
warming effect, you can always skip Step 1.

AFTER

1
Add noise
Open your

landscape shot into

Photoshop or Elements and

go to Filter>Noise>Add Noise.

Now drag the Amount slider

to the right until your picture

has a gritty film grain effect,

we used a value of 25% in

our photograph. Then set the

Distribution to Uniform, and

make sure Monochromatic 

is ticked. Finally, hit OK to

apply the Noise filter.
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1
The Forward Warp Tool
In Photoshop, open your image and

go to Filter>Liquify In Elements, go toy
Filter>Distort>Liquify. Grab the Forward Warp Tooly
(W) from the Toolbox. Use the Brush Size slider to

make your brush a similar size to the one in the shot

above. Now push the hairline up to create volume.

Next enhance the smile by 

brushing up at the corners 

of the mouth, with the edge 

of your brush just touching

the corner of the lips. Lastly,

use a smaller brush to push

the lips down in the centre of

the smile. If the effect looks

unnatural, just hit Ctrl+Z to

undo and have another go.

2
The Bloat Tool
Once you’re happy with the shape of your

smile, it’s time to make the eyes a tiny bit

larger to ensure they really stand out. This is really

simple to do in both Photoshop and Elements, using

the Bloat Tool (B). This applies a kind of ‘inflating’

effect, expanding the area from the centre outwards,

making specific areas appear to balloon. Make sure

the brush is roughly 1.5x bigger than the entire eye

and line up the centre cross-hairs with the middle of

the iris. Less is more here, so use single, short clicks

to gradually inflate the eyes. Do this evenly over both eyes so 

that one doesn’t look larger than the other. This can be used to 

subtly give the eyes more prominence, though pushing it further 

will result in a cartoony, caricature effect, which can be fun.

Forward Warp Great for reshaping 

features such as eyes or lips.

Turbulance Great for creating 

surreal, ripple-like patterns.

Twirl left & right Great for making 

fine adjustments to areas that 

need slight rotation.

Pucker & Bloat Great for 

making facial features, such 

as eyes or noses, slightly 

larger or smaller.

Shift Pixels Great for making 

adjustments along an edge.

Reflection Great for mirroring a 

scene or area for a surreal image.

Reconstruct Great for selective 

undo, leaving other areas intact.

Zoom Great for getting close in to 

work on smaller details.

Hand Great for scrolling along the 

image while zoomed in.

I T MAY HAVE RECEIVED 
some criticism in recent
years, thanks to over-use

on models’ bodies in the media, but
when applied with care, Liquify is still
one of the best set of tools for portraits.
With a broad range of applications and
capabilities, Liquify will enable you to
do anything from high-end body or
garment reshaping for fashion photography,
all the way to making your friends look like
bug-eyed aliens. The only limit to what you can
achieve is your own creativity. 

Liquify works exceptionally well on many aspects of an image, but 
here we’re specifically looking at faces as part of our portrait series, 
concentrating on a few key techniques to bring your images to life the way 
you intended. Read the step-by-step, follow the tutorial on this month’s 
free cover disc, and then find a portrait shot and try it for yourself...

Enhance eyes and smiles
Liquify is one of the simplest  
yet most powerful weapons in  
a portrait professional’s toolkit. 
Here Kirk Schwarz shares his 

expert tips for subtle facial reshaping.

WHAT  
YOU NEED
Q

Elements

Q A portrait needing a

boost to the smile 

and eyes
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What makes a good portrait  

a stunning portrait? Attention 

to detail. Next month we are 

going to show you some 

extremely simple, but 

effective, techniques to make 

your subject’s teeth appear 

pearly white and flawless, 

giving them that elusive 

Hollywood smile.  

NEXT MONTH
TEETH 
WHITENING

NEW
SERIES!

PORTRAIT
SKILLS
PART 2/6

Above The angle of the camera makes the eyes and nose look 

a little unflattering and the smile looks forced.

Above We’ve increased the size of the eyes and made the smile 

bigger to give a more striking look to our portrait.

BEFORE AFTER

3
The Pucker Tool
The Pucker Tool is, to put it simply, the exact opposite of the

Bloat Tool. Instead of inflating, it pinches your image, pulling

pixels towards the centre of the brush. The Pucker Tool looks like a butterfly

with four arrows pointing inwards. We’re going to follow the same steps

as we did with the Bloat Tool, but this time we’re going to apply the effect

to the nose. Again, less is more so it only requires a couple of clicks to

get the effect needed. You can also refine the Liquify effect at any time

by using the Reconstruct Brush Tool (E). The Reconstruct Brush allows

you to paint any part of the image back to how it was before it was edited,

which means you don’t have to undo multiple steps to correct minor

errors. When you’re done, hit OK to apply the Liquify Filter and then go

to File>Save As to save your edited picture under a new file name.

AL
IS

TA
IR

 H
EA

P
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WHAT 
YOU NEED
Q

Elements

Q A model, a dramatic
scene and our free 

custom brushes
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ALIJA

I F YOU ENJOY GIVING YOUR
portraits the ‘wow’ factor, then you’ll
love this technique, as it’s sure to turn 

heads and leave everyone wondering how you 
created such a striking result. It looks complicated, 
but we’ve simplified the process so you can easily 
make your portraits look like they’re falling apart. 

Before we were able to start putting the image 
together we needed to make some dispersion 
brushes. We snapped charcoal sticks onto white 
paper then shot the results, which looked like black
& white explosions. We then turned these images 
into brushes in Photoshop. We ended up with 20 
custom brushes and they’re all available for you 
to use right now in the Free Gifts folder on your 
CD. You’ll also need a sharp portrait with enough 
space around it for the dispersion to flow into. 

Go graphic 
with artistic 
dispersion 

Above This portrait is ideal, 
as it has enough empty 
space around the model for 
the dispersion effect.

Left Use the free dispersion 
brushes on your disc to 
create images just like ours.

AFTER

Break up the form of
your subject to create  
a striking dispersion
effect. Dan Mold

explains how you can do it.

20
EXCLUSIVE 
BRUSHES 

ON THE  
DISC 

BEFORE
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3
Load the brushes
Go to the Toolbox and

click on the Brush Tool to

make it active. Now in Tool Options

click on the Brush Preset Picker

and click on the cog icon 

(Photoshop) or menu icon 

(Elements) to bring up the fly-out menu, then choose Load

Brushes from the list that appears. Navigate your way to the

Free Gifts folder on the disc and double-click on the PP

dispersion brushes.abr file. This will then load your 20 free

dispersion brushes and they will appear alongside your other

brushes at the bottom of the Brush Preset Picker.

4
Mask off parts of your portrait
Click on a dispersion brush that you like and go to the 

Layers panel (Window>Layers). Click on the Add 

Layer Mask icon. You’ll now see a white rectangle appear next 

to your Layer thumbnail – this is your Layer Mask and any black 

areas on it will hide the Layer from view. In this step you want to 

hide a few areas of the model and reveal the background 

behind. Hit D followed by X for a black foreground colour, set 

Brush Opacity and Flow to 100% and then click over your 

model a few times to give them a broken-up look. You can 

quickly resize your brush with the [ and ] keys. If you make a 

mistake, hit X on the keyboard for a white foreground colour 

and paint over any offending areas to remedy them.

1
Clone out your portrait
In Photoshop or Elements, go to File>Open and

navigate your way to the portrait you’d like to use.

The portrait should be sharp and have enough room to allow

you to add the dispersion effect. Double-click your picture

to open it up and hit Ctrl+J to duplicate your Layer. Now go

to your Layers panel (Window>Layers) and click the eye icon

next to your top Layer, Layer 1, to hide it from view. Click on

the Background Layer to make it active. You now need to 

remove the person from shot, so grab the Clone Stamp Tool

from the Toolbox. Then hold the Alt key and set the source 

point. Now brush over your portrait to roughly remove them 

from the shot. This doesn’t need to look completely flawless.

2
Duplicate your portrait Layer
In your Layers panel, click on the Layer at the top of 

the Layers stack (Layer 1). Now hit Ctrl+J to duplicate 

the original image once again, and then click the eye icon next 

to the Layer’s thumbnail to hide it from view. Click back on 

Layer 1 to make this the active Layer again.

GENIUS Hold down the Alt key when 
you’re using the Clone Stamp Tool to set 
the source point to copy the pixels from 
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7
Mask off and reveal
In the Layers panel, click on the Add Layer Mask icon

and hit Ctrl+I to invert the Layer Mask so that it’s

completely black – this will completely hide your Liquified Layer

from view. Choose another dispersion brush that you’d like to

use, set the angle with the Brush Settings and hit D for a white

foreground colour. Now resize your Brush Tool with the [ and ]

keys and, when you’ve got the brush to a size you like, you can

paint over the areas where you’d like to add the dispersion.

Remember to change the brush and the angle of the brush

regularly to break up the pattern and make the shot look more

dynamic. You can also hit X for a black foreground colour and

then paint over any areas to remove them.

8
Build up the effect and save
Now is the time to go back over to your Layers panel

and tidy up any areas that you’d like to go back to

and finesse. You can go back to any of your Layers and click on

the Layer Mask (next to the Layer thumbnail) and use a Brush

Tool with a black or white foreground colour to add or take

away the dispersion effect to get it looking exactly how you

want it to. It’s then time to save your shot, so go to File>Save As
and set the Format to Photoshop to save as a PSD file, which

will retain your Layers. This makes it possible to go back and

edit your Layers at any point. Or, if you’re completely happy

with the effect and would prefer to cut down on disc space, you

can set the Format to JPEG.

5
Adjust brush size and direction
There are 20 dispersion brushes for you to play

with and each can be tweaked to fine-tune the 

effect. Click on the Toggle Brush Panel icon in Photoshop or

click on the Brush Settings button from the Tool Options if

you’re using Elements. In either case, you’ll see a circle with

a cross in the middle of it and an arrow showing the current

angle of the brush. This allows you to change the brush angle

and the overall roundness of the brush too. This is really 

handy, as it allows you to change the angle of the Brush Tool

to make it look like the portrait is disintegrating at a specific

angle. Just drag the circular icon into the desired shape and

angle and start painting.

6
Stretch the clothing out
With parts of the model now disintegrating, go

to your Layers panel, click on the top Layer to

make it active and make the Layer visible again by clicking

on the eye icon. Now go to Filter>Liquify in Photoshop or

Filter>Distort>Liquify in Elements to bring up the Liquifyy
interface. Set the Brush Size to 200 and the Brush Pressure to

100, then pull the edges of the model’s clothing out towards

the edges of the picture. The idea is to cover the whole frame

with the colour data of your model and their clothing, so the

red dress in this shot has been stretched across the entire 

image. This gives you the colour data you’ll need later to

create the dispersion effect. When you’re done, hit OK.

//  PHOTOSHOP & ELEMENTS //  VIDEO & FREE BRUSHES ON DISC
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C REATING BRILLIANT
abstracts often just takes a little
imagination. In this tutorial,

we’ll show you how to use ordinary subjects
to make something extraordinary, like this
boat sailing through the blue iris of a human
eye. You’ll learn how to compile multiple
pictures in Photoshop or Elements to make
striking composites, and how to seamlessly
merge images for realistic, yet otherworldly,
results. Macro shots are perfect for this

technique, so if you’ve got a macro lens, then 
now’s the time to put it to good use. If you 
don’t have close-ups to hand then there are 
loads of royalty-free stock image websites 
that offer free images. Download some of 
these and use them to experiment while 
you’re still getting to grips with the effect. 
It takes between 5-10mins to achieve and 
you’ll learn some key Photoshop skills along 
the way, such as using Layer Masks and 
changing perspectives.

Create your own fantasy
worlds in macro images

Play with 
scale to 
create a
whole new 

world inside a macro
scene. Dan Mold 
shows you how you 
can do it...



WHAT
YOU NEED
Q Photoshop
or Elements

Q A macro eye picture
and some boats you

can add in
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Above The boat, eye and
wake have been merged
together to create a
surreal fantasy world.

Left The eye image was
taken with a macro lens
and lit from behind to
match the backlighting
of the boat. We also used
the trailing wake of a
jet ski, which was shot
from a high angle.

BEFORE 1 BEFORE 2 BEFORE 3
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3
Add a sense of realism
The wake of a boat is a great way of making

this composite look realistic. This picture of a 

jet ski will work brilliantly because it has a clean white 

wake behind it. To make it part of the image, open it up, hit

Ctrl+A to select it, Ctrl+C to copy it and Ctrl+W to close 

it down. Then back in the eye image, hit Ctrl+V to paste it 

in. In your Layers panel (Window>Layers), drag the wake 

Layer beneath the boat Layer. Now hit Ctrl+T to put the 

wake Layer into Free Transform Mode. Resize and position

it just like in the previous step, but to get the perspective 

of the waves looking right, hold the Ctrl key down and 

pull the corner handles. Then hit Return to set it down.

4
Blend your Layers to finish off
To blend the wake in, change the blending mode 

of this Layer from Normal to Screen. Now click on 

the Create new adjustment layer icon and choose Levels. 

Right-click on the Levels Layer and choose Create Clipping 

Mask – this ensures the Levels adjustments will only be applied 

to the wake Layer. In your Levels panel you’ll see the Blacks, 

Midtones and Whites sliders underneath the histogram. All 

you have to do is pull the Blacks and Whites to the right until 

you can only see the white wake. When done, click the Add 

Layer Mask icon and use a soft black Brush Tool to paint over 

any offending areas that look unnatural. To finish off, go to 

File>Save As and save your shot under a new file name. 

1
Open up your images in Photoshop
Open your macro shot into Photoshop or Elements

with File>Open, and then open up a picture of a boat.

Hit Ctrl+A to select it, Ctrl+C to copy it and Ctrl+W to close

it down. Now hit Ctrl+V to paste the boat onto the eye. Go to

the Toolbox and click on the Polygonal Lasso Tool to make it

active. Hit Ctrl+Plus to zoom in tightly on your shot, hold the

Spacebar down to bring up the Hand Tool and use it to move

the boat into view. Now, using the Polygonal Lasoo Tool, you

can click all the way around the boat. When you’ve completed

the selection you’ll see the marching ants. Click Refine Edge, 

set the Feather to 1px and hit OK. Go to your Layers panel and

click on the Add Layer Mask icon to mask off the rest of the pic.

2
Add a Layer Mask and resize the boat
Hit Ctrl+T to put the boat into Free Transform Mode. 

Tick Constrain Proportions in Elements, or hold the 

Shift key down in Photoshop, so that you can pull the corner 

handles of the bounding box to resize without distorting the 

picture. Then drag it into place and hit Return to set it down.

GENIUS Layer Masks can be used to 
hide parts of your Layer, but these pixels 

can be recovered at a later date



Some memories deserve more.

The DxO ONE is an ultra compact, revolutionary camera that connects directly

to your iPhone® or iPad®. Simply plug the camera into your Apple device, capture

your most precious memories, and instantly share them with your friends and family.

With a 20.2MP 1 inch sensor and an aperture of f/1.8, the DxO ONE takes unforgettable

photos, anywhere you go. Learn more at dxo.com
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1
Make basic adjustments
When you’ve installed the free DxO OpticsPro 9 Elite

edition, open it up and click the Organize button in the top

left corner. This will bring up a list of folders on your computer and all

you have to do is navigate through your hard drive to find the folder

with your image in it and give it a click. This will bring up your image

or images. You can give images a star rating in the filmstrip, or delete

pictures by clicking the Trash icon. Now head up to the Customize 

button and give it a click to bring up the editing options. Go to 

View>Palettes>Essential Tools, to bring up the Essential Tools palette

on the right of the interface. Here you can make powerful adjustments

to your JPEG or RAW files using controls including White Balance, 

Exposure Compensation and Contrast. In this image we increased the

Exposure Compensation to 1.18 to make it nice and bright, boosted

the DxO Smart Lighting Intensity to 150 to fill in some of the shadows

and increased the Vibrancy to 50 to really make the colours pop.

2
Correct lens distortions
It’s so simple to correct optical flaws in

OpticsPro 9, as it applies its tailor-made 

corrections automatically when you open your image. 

You can also fine-tune the results by heading over to 

the Optical Corrections tab (View>Palettes>Optical
Corrections). Under Distortion set the type to Barrel  

(or Fisheye) to fix straight lines that bow outwards, or 

to Pincushion to fix straight lines that gravitate inwards. 

Then tweak the Intensity slider until the lines are straight. 

Vignetting, or dark corners, can be reduced under 

the Vignetting heading. Just drag its Intensity slider 

until the corners are the correct brightness. Lastly, if 

you can see colourful purple or green fringing around 

high contrast edges, increase the Intensity and Size 

sliders under Chromatic aberration until it’s gone.

W E’VE GOT A FANTASTIC
offer for you this month,
as we’ve teamed up with

DxO to secure a free copy of DxO
OpticsPro 9 Elite (worth £159) for
every Practical Photography reader!y

This comprehensive imaging 
software makes it super easy to 
adjust key parameters like exposure,
colour and contrast on both JPEG
and RAW files. Here we show you how
to use some of its key features such as Smart
Lighting, which optimises contrast and can recover lost highlight
and shadow detail in RAWs. Optical Corrections makes it a breeze 
to reduce unsightly lens defects such as chromatic aberration and 
vignetting. And OpticsPro 9’s powerful PRIME (Probablistic Raw
IMage Enhancement) denoising technology differentiates between 
noise and fine details for extremely powerful noise reduction. 

Download your free copy (see panel below right), follow 
the step-by-step and start using your free software today.

Use your free DxO softwaree
Every reader can claim a free
copy of DxO OpticsPro 9 Elite
with this issue. Dan Mold runs
through its key features.

WHAT  
YOU NEED

Q A computer with the 
minimum required spec

Q Internet access

Q A RAW or JPEG 
photograph

DxO OpticsPro 9 is
compatible with the
following OS:
QMicrosoft Windows
Vista, Windows 7,
Windows 8, Windows 8.1
QMac OS X 10.6 (Snow
Leopard), 10.7 (Lion),

10.8 (Mountain Lion),
10.9 (Mavericks),
10.10 (Yosemite)
Minimum system
requirements
Q 400MB available 
disk space 
Q 2GB RAM

SYSTEM REQUIREMENTS
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FREE SOFTWARE // DxO OPTICSPRO 9

Fill out the form at:

www.dxo.com/
practicalphotography

before 30 June 2017 to receive 

your free download link and

activation code for DxO

OpticsPro 9. You’ll also get

£40 off DxO’s OpticsPro

11 Elite when you buy it in

the DxO e-store between

13 April and 30 June 2017.

HOW TO CLAIM
YOUR FREE DXO
SOFTWARE

Above The original RAW file fails to leap off the page as it’s 

underexposed, lacks contrast and the colours are muted.

Above In a matter of clicks, the exposure has been brightened, lens 

distortions fixed and details enhanced in DxO’s OpticsPro 9.

BEFORE AFTER

3
Bring out the finer details
Go back to the Essential Tools panel and click

on Noise Reduction to expand the options and

set the Quality to High. The PRIME setting is great for RAW

files with an ISO of 3200 or higher. Now click on the Magnify

center button (looks like a crosshair) and click on an area

of fine detail with noise in it. Drag the Luminance slider 

until the noise is suitably suppressed. To increase details,

go to View>Palettes>Detail and Geometry - Advanced to

bring up the panel with Unsharp Mask. For most shots, an

Intensity of 100 and a Radius between 1.00 to 2.00 works

well to increase the details. When you’re finished, click on

the Export to disk button to save your enhanced photo.

GET
YOUR 

FREE DXO 
SOFTWARE

WORTH 
£159!

BEFORE

WITH PRIME
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Dan says:
Ali’s bagged a
special moment
between these
two wire-tailed
swallows. The
juvenile’s beak is

open, mid-squark, and there’s some
great eye contact with the adult bird
too. An aperture of f/6.3 has made the
focal point nice and sharp, yet wide
enough to blur the background into a
brilliant wash of colour. This means the
viewer’s eye isn’t distracted by messy
twigs or tree branches behind, and the
attention is solely on the swallows.

Although the blurry background is
doing a great job of focusing the viewer’s
eye on the focal point, the whole image
is a little dark and the greens look a
little dull too. Ali sent over his RAW
file and we boosted the Exposure slider
in Adobe Camera Raw to lighten the

whole image. We also went into the HSL 
(Hue/Saturation/Luminance) panel to
boost the Saturation and Luminance
of the Yellow and Green channels
(Photo Fix 1) and this really makes
the colours look much more vibrant.

The lens and camera body
combination provided Ali with a huge
focal length, equivalent to 640mm.
Camera shake is prone to creep in
when using telephoto lenses, so Ali
should be commended for capturing
this pin-sharp shot. That said, the
pair are fairly small in the frame. This
could be fixed in-camera by moving
closer to them or by using a larger focal 
length. But it’s easy to add prominence 
with a crop (Photo Fix 2). Our crop
maintained a resolution of 6MP,
which is large enough to print at A4.

Overall, Ali’s done a great job of
photographing a magical moment
between these two majestic birds.

Wire-tailed swallow By Ali Javed

Stuck in an editing rut with your shots? Send them over
to ppsubmissions@bauermedia.co.uk and our Photoshop
experts will show you how to professionally retouch them.

Ali says: I had
the perfect
opportunity to
capture these
two wire-tailed
swallows while

they were perched on a branch.
I used my long Canon 400mm
f/5.6L USM lens to zoom in and
the cropped APS-C sensor of my
7D body gave me an equivalent
focal length of 640mm. I used
single-point autofocus to focus 
on the adult and made sure
both birds were in the middle
of the frame to use the best
part of the lens for optimum
clarity. The moment has usually
passed by the time I press the
shutter, so I’m pleased that I 
managed to capture it here.

BEFORE

AFTER

PhotoFixer

Branch awkwardly 
leads the eye in

Birds are very 
small in the 

frame

Colours 
look a little 

muted



PRACTICALPHOTOGRAPHY.COM  93

Photo Fi Boost vibrancy and apply a cropx

1
Increase the power of individual colours
Open your RAW file into Photoshop CC 

and you’ll be able to click on the HSL 

tab (or HSL panel in Lightroom’s Develop 

module). You can then crank up the Saturation of 

individual colour channels, such as the Yellows 

and Greens in this shot, to make the background 

more colourful. You can even change the 

Luminance (how bright or dark the colours are), 

and the Hue of each colour channel.

2
Apply a tighter crop
Staying in Adobe Camera Raw or

Lightroom, click on the Crop Tool

and pull in the corner handles of the

bounding box for a tighter crop to make 

your subject more prominent in the frame.

Make sure Show Overlay is activated to

bring up the rule-of-thirds grid. Then line up 

your subject with the lines. 

Canon 7D | 400mm | 1/640sec | f/6.3 | ISO 200

TIP 
CROP FOR 

EXTRA IMPACT
Digital cameras have whopping

resolutions, so don’t be afraid

to crop your pictures to make

your subject larger in the

frame. It’s simple to do

and the benefits are  

huge.
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Seljalandsfoss By James Longworth

James says:

I’m an amateur

photographer

from Cheshire,

and I love to shoot 

landscapes. A

recent trip to Iceland provided

me with fantastic photographic

opportunities and I set about 

shooting Seljalandsfoss

waterfall. To fit the wide vista

into the frame I photographed

a 14-image panorama and then 

stitched the images together.

Dan says: James has captured an 
awe-inspiring vista of the Seljalandsfoss 
waterfall powering down the cliff-side.
He knew the 17mm end of his lens 
wasn’t wide enough to get the expansive
angle-of-view he envisioned and 
cleverly shot a 14-image panoramic. 
In Photoshop he then stitched the 
various images together seamlessly, 
for which I give him top marks. James 
also kept the original aspect ratio, so 
you’d never guess that it’s a panorama. 

One issue I do have is the heavy 
vignette around the edges of the frame. 
It’s too strong and makes the scene look 
very gloomy. It also directs the eye to the 
middle of the frame where the sky has 
burnt out to pure white. It’s tricky to nail 
the exposure when shooting a panoramic, 
so I’d always suggest shooting in RAW so 
you can pull the detail back. Omitting the 
vignette and adding a new sky will give 
this scene the ‘wow’ factor it deserves.

Photo Fix Add a new skyx

1
Select your current sky
Open your landscape into Photoshop and grab the Polygonal

Lasso Tool from the Toolbox. Use the tool to click all the

way around the sky you’d like to replace. When you’re done you’ll

see marching ants appear all the way around the sky. Then go to

Refine Edge, set Feather to 3px to soften it slightly and hit OK.

2
Add your new sky into the selection
Open up your new sky, hit Ctrl+A to select it, Ctrl+C to copy it

and Ctrl+W to close the shot down. Back in your landscape, go

to Edit>Paste Special>Paste Into and you’ll see the sky appear in your

selection. The rest of the sky will be masked off using a Layer Mask. You

can further refine the mask with a black or white Brush Tool to reveal or

hide parts of the sky. You can also change the blending mode and Layer

Opacity to make the sky appear more natural. 

Canon 550D | 17mm | 1/160sec | f/6.3 | ISO 200

BEFORE

AFTER
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Cinderella
By Basia Pawlik

Basia says: I wanted to create a
feminine, romantic mood, so used simple
pastel colours in the background and
also in my model, Joanna’s, props and
clothing. I made minimal tweaks in
Photoshop, cooling down some of the

tones, correcting some of the skin blemishes and applying
a little dodging and burning to adjust the contrast.

Dan says: The light in Basia’s 
portrait is beautifully soft and 
flattering, so she’s done well 
to avoid the harsh directional 
sunlight. She’s also taken a lot 
of time to inject subtle hints 
of lilac via the dress, eye-liner 
and head dress, though these 
clash with the purple tree 
behind. This could be fixed 
in-camera by finding a totally 
green background, though 
the tree can be remedied in 
Photoshop too (Photo Fix 1). 

The model’s head is quite
small in the frame, so a 
tighter crop would cement
her as the focal point. A crop
also provides the possibility
to change the central 
composition, placing the 
model’s head a third in from
the right edge and removing
the messy patio flooring in
the bottom half. I’d also apply
a little sharpening to the 
model’s face (Photo Fix 2)
and turn up the saturation.

Canon 6D | 35mm | 1/800sec | f/1.4 | ISO 100

BEFORE

Framing 
is quite 
loosePurple 

colour is 
distracting

Details are 
slightly soft

Photo Fix Change
colours & sharpen up

1
Change your colours
In Photoshop, go to Layer>New Layer. Grab the 
Brush Tool, making sure it’s a soft Brush, hold 

down Alt and click to sample the colour you want. Paint 
over the colour you’re changing. Go to your Layers panel 
(Window> Layers) and change the blending mode from 
Normal to Color. 

2
Sharpen up
Hit Ctrl+J to duplicate your Background Layer. 
Go to Filter>Other>High Pass, set a Radius of 

1-5px and hit OK. In the Layers panel (Window>Layers) 
change the blending mode of your new Layer from Normal 
to Overlay to blend it in and sharpen the image. 

AFTER
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Dan Mold reveals how to remove distractions
and strengthen compositions for cleaner results.

Crop and clone to
tidy messy images

T HE EASIEST WAY TO
improve the composition
of your pictures is to 

remove unwanted distractions, as any
blemishes in a photograph, from dust
spots to litter, have the potential to
draw the eye away from your main
focal point.

These problem areas are fast to
fix in Photoshop or Elements. Our
example image is a fantastic, vibrant
street scene, but the eye is stolen
away from the rushing traffic by the
messy frame edge on the left, traffic
lights jutting in from the top and some
litter on the road. Follow the step-
by-step below and tidy up problem
areas like these quickly, using three
really simple editing techniques.

WHAT 
YOU NEED
Q Photoshop or 

Elements

Q An image with

distractions that pull 

the eye away

1
Crop to remove
distracting edges
If distractions are creeping

into the edges of your frame, apply a
slight crop to remove them. Click on the
Crop Tool to make it active. You’ll now
see a bounding box around your image. Pull
the corner handles in to change the crop. This can be handy if
you have tricky distractions around the edge of the image that
are hard to remove with Steps 2 and 3 in this tutorial. You can
hold the Shift key down as you pull in the corner handles to
make sure the crop is applied at the same aspect ratio. Another
tip is to activate the rule-of-thirds Grid Overlay to help you
compose the focal point within your image. When you’re happy
with the crop, hit the Return key or click the tick to apply it.

2
Make debris disappear in a click
Small bits of dirt, dust or debris can pull the eye
away from your main focal point, but these are 

easy to remove in Photoshop or Elements. Just grab the
Spot Healing Brush Tool from the Toolbox and make sure the 
Type is set to Content Aware and that Sample All Layers is
unticked. Then zoom in closely on the area you want to clean
up by hitting Ctrl+Plus a few times. Hold the Spacebar down
to bring up the Hand Tool and drag the offending area into
view. Now hover your cursor over the spot and resize your
brush with the [ and ] keys until the cursor is slightly larger
than it and then paint over the area. Photoshop will replace
it with similar textures and tones. Go around the whole shot
with the Hand Tool and remove all of the smaller distractions.

BEFORE

Left There’s a 

fantastic 

amount of 

drama in this 

scene, though 

the viewer’s 

eye is drawn 

away from the 

middle of the 

image by 

distractions 

dotted around 

the frame such 

as the traffic 

lights and litter 

in the road.
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3
Clone areas for more control
The Clone Stamp Tool lets you sample an area of 

your shot with ‘good pixels’, which you can then 

use to paint over a distraction. This is handy for removing the

traffic lights at the top of this image, where the Spot Healing 

Brush struggled to produce a realistic result. To start, click 

on the Clone Stamp Tool from the Toolbox to make it the 

active tool and then hover your cursor over the offending 

area. Now use the [ and ] keys until the brush is slightly bigger

than the distraction. Hold the Alt key down to change the 

cursor to a target and click on the ‘good’ area you want to 

sample. You can then proceed to paint over the distraction 

to remove it from the frame. Choosing a softer brush and 

lower brush Opacity will make it look more natural. 

AFTER

Use a cloning 
target point to 
source the 
pixels you will 
use to replace 
the distraction.

DA
N 

M
O

LD
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Lightroom imports your images and requires a link to

them in order for you to edit them. This means if you

import from an external hard drive you need to have the

drive plugged in at all times to be able to access the pics

and make adjustments. But if you don’t have the drive to

hand, you won’t be able to edit. You need to create a

Smart Preview – a lower resolution file that allows you to

keep working. To do this, go to the Library tab and

highlight all of the pictures you want to work on (or hit

Ctrl+A to select all), then go to Library>Previews>Build
Smart Previews. You’ll now be able to continue editing

with the drive removed and your settings will be applied

to the original RAWs when your drive is reconnected.

Many cameras now

have the ability to

record 4K movies and

this means still images

can be pulled from the

film with a respectable

8MP resolution. To do

this, just open up your

video footage into

Photoshop and you’ll

see it load into the

Timeline at the bottom

of the screen. Zoom in

so you can see more

frames using the Control Timeline Magnification slider at the 

bottom of the Timeline panel, then drag the Timeline Cursor to the 

precise frame you want to turn into a still image. Now go to 

File>Save As, find a location on your hard drive that you want to

save the shot to and set the Format to JPEG, then hit Save!

There’s a really

quick way to

manually set the

White Point in

Photoshop and

Elements, which

tells the programs

which part of the

shot should be

completely white.

To do this, go to

the Levels panel

via Ctrl+L (or on

a Levels 

Adjustment Layer)

then in the Levels

panel click on the White Point eyedropper. Now you can click on 

the part of your picture that should be completely white, which is 

the bright sun in this wildlife photo. This will also give you more 

accurate colours. You can also set the midtones and shadows 

here using the Gray Point and Black Point eyedroppers

We hope you’ve enjoyed our 
new-look Photoshop Genius 
section and would love to see 
how you’re getting on with our 
brand-new techniques. So 
why not share your shots with 
us? All you have to do is post 

your shots on your Facebook 
wall with the hashtag 
#myphotoshopgenius so we 
can see it. Each month we’ll 

showcase our favourites
the Practical Photograph
Facebook page. We look
forward to seeing them!

Share your shots with us online

#myphotoshopgenius

Use Smart Previews to
continue editing on the move

Extract a still image from  
a video clip in Photoshop

Set your white point quickly

L I G H T R O O M

Quick tips & keyboard shortcuts that’ll
help you process your images faster!

shop

P H O T O S H O P P H O T O S H O P  &  E L E M E N T S

MORE  
EDITING 

VIDEOS ON 
YOUR FREE 

DISC!
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visit wex.co.uk
01603 208763 
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24.2 mp

6.0 fps

1080p

24.3 mp

6.0 fps

1080p

D750 Body £1639
D750 + 24-85mm VR £2099
D750 + 24-120mm VR £2279

D5 Body £5299 D500 Body £1759D810A Body £2899

D610 Body £1299
D610 + 24-85mm VR £1699

D7200 Body £859
D7200 + 18-105mm VR £1099

D750

D5 D500D810

D610D7200

D750 From £1639

D5 Body £5299 D500 Body £1759D810 Body £2499

D610 From £1299D7200 From £859

Pro Runner:
BP 350 AW II ..........................£159
BP 450 AW II ..........................£179

Photo Sport BP:
450 AW...............................£199

Mountaineer Carbon eXact Tripod:
GT5542LS..................................£719
GT3542-S3.................................£649
GT3542LS-S3 ............................£639

Gorillapod:
Compact..................................£17
Hybrid (Integral Head).............£29
SLR Zoom...............................£44.99
Focus GP-8.............................£89

Ball Heads:
494RC2............................ £48.95
496RC2............................ £65
XPRO Ball Head 200PL... £114
327RC2............................ £139

Anvil:
Anvil Slim................................. £139
Anvil Super.............................. £139
Anvil Pro.................................. £149

Hadley: Canvas/Leather: Khaki/Tan,
Black/Tan, Black/Black.
FibreNyte/Leather: Khaki/Tan, Sage/
Tan, Black/Black.
Digital .................................. £109
Small ................................... £129
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Pro Original ......................... £169
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RuggedWear:
F-5XB ......................................£69
F-6 ...........................................£89
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F-2 ...........................................£119

5DS R Body £2899
£2649 Inc. £250 Cashback*

EOS 5DS

5DS From £2799

5D Mark IV Body £3499

5D Mark IV

5D Mark IV £3499

ProTactic 450 AW
Backpack

'HVLJQHG WR ÀW
1-2 Pro DSLRs
(one with up to
70-200mm lens
attached), up to 8
lenses/speedlights,
a 15” laptop, tripod
and accessories.

GT3542LS-S3
• 146.5cm Max Height
• 9.4cm Min Height

SLR Zoom
• Flexi Tripod legs
• 25cm Closed Length
• 3Kg Max Load

327RC2
Joystick
Head

Hadley Pro
Original
Canvas Khaki/Tan

F-803
RuggedWear

Purpose-built
to organise and
protect more
gear, and provide
more options for
manoeuvring in
busy airports and
crowded streets.

Advanced Travel ..................£79.99

Manfrotto
Advanced Travel
Backpack - Black
is made up of two
compartments;
the bottom takes
photographic
equipment and the
top section holds
all of your personal
belongings.

G7 X Mark II

G7 X Mark II £549

D3400 + 18-55mm VR £439

D3400

D3400            From £439

 430EX III
£229

SB5000
£499

3m Heavy Duty
Background

Stand
£99

Lumimuse LED
Lights

From £44.95
Ezybox Speed-Lite 2

£49.95
L308s
£179

Plus III Set
£229

Gemini Pulsar
Tx 500R Kit £949

Tx 500 Pro Kit £1199
D-Lite RX 4/4

Softbox Set £725
Urban Collapsible 
Background £165

800D Body £779
800D + 18-55mm IS STM £869

EOS 800D

800D            From £779

77D Body £829
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EOS 77D

77D           From £829

D7100 Body  £699
D7100 +18-105mm VR £879
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D7100       From £699
7D Mark II Body  £1249
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EOS 7D Mark II

7D Mark II        £1249

6D Body £1399
£1274 Inc. £125 Cashback*
6D + 24-105mm IS STM £1699
£1574 Inc. £125 Cashback*

EOS 6D

6D From £1399

D5600 + 18-55mm VR £729
D5600 + 18-140mm VR £949

D5600

D5600           From £729

MT190XPRO3
• 160cm
Max Height
• 9cm
Min Height

1D X Mark II Body £4799

EOS 1D X Mark II

1D X Mark II £4799

MT055XPRO3 ...................£159
MT055CXPRO3
Carbon Fibre......................£269
MT055CXPRO4
Carbon Fibre......................£279
MT190 Series:
MT190XPRO3 ...................£139
MT190XPRO4 ...................£159
MT190CXPRO3
Carbon Fibre......................£229
MT190CXPRO4
Carbon Fibre......................£249
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80D Body £999
£919 Inc. £80 Cashback*
80D + 18-55mm IS STM £1029
£949 Inc. £80 Cashback*
80D + 18-135mm IS USM £1219
£1139 Inc. £80 Cashback*

 EOS 80D

80D           From £999

G7 X Mark II £549
G5 X £613

20mm f1.8G AF-S ED .................................£659
24mm f1.8 G ED AF-S ................................£629
35mm f1.8 G AF-S DX ................................£179
50mm f1.8 G AF-S ......................................£189
50mm f1.4 AF-S ..........................................£385
58mm f1.4 G AF-S ......................................£1419
60mm f2.8 G AF-S ED Micro ......................£529
85mm f1.8 G AF-S ......................................£449
105mm f2.8 G AF-S VR IF ED Micro ..........£749
300mm f4 E PF ED VR AF-S ......................£1489
10-24mm f3.5-4.5 G AF-S DX.....................£745
14-24mm f2.8 G AF-S ED ...........................£1619
16-35mm f4 G AF-S ED VR ........................£1029

16-80mm f2.8-4 G AF-S VR ED DX ...........£860
16-105mm f3.5-5.6 G ED VR AF-S DX ......£219
18-200mm f3.5-5.6 G ED AF-S DX VR II ...£625
18-300mm f3.5-6.3 G ED VR AF-S DX ......£629
24-70mm f2.8 G AF-S ED ...........................£1599 
24-120mm f4 G AF-S ED VR ......................£939
28-300mm f3.5-5.6 G AF-S ED VR ............£829
70-200mm f2.8 G AF-S ED VR II ................£1998
80-400mm AF-S Nikkor f4.5-5.6 G ED VR .£2199
200-500mm f5.6E ED VR AF-S ..................£1179

EF 24mm f1.4 L II USM ...................£1499
EP 35mm f1.4 L II USM  ................£1899
£1734 Inc. £165 Cashback*
EF 50mm f1.2 L USM ......................£1369
£1244 Inc. £125 Cashback*
EF 50mm f1.4 USM .........................£349
£299 Inc. £50 Cashback*
EF-S 60mm f2.8 USM Macro ..........£419
EF 85mm f1.2 L II USM ...................£1799
£1634 Inc. £165 Cashback*
EF 85mm f1.8 USM .........................£339
£289 Inc. £50 Cashback*
EF 100mm f2.8 L IS USM Macro ....£869
£789 Inc. £80 Cashback*

EF 135mm f2 L USM .......................£949
EF 180mm f3.5 L USM Macro ........£1329
EF-S 10-18mm f4.5-5.6 IS STM .....£213
EF-S 10-22mm  f3.5-4.5 USM .........£499
EF 11-24mm  f4 L USM ...................£2699
EF-S 15-85mm f3.5-5.6 IS USM .....£649
EF 16-35mm f2.8 L III USM ............£2099
£1934 Inc. £165 Cashback*
EF 16-35mm f2.8 L Mk II USM .......£1429
EF 16-35mm f4 L IS USM ...............£939
EF-S 17-55mm f2.8 IS USM ...........£749
EF 17-40mm f4 L USM....................£719 
EF-S 18-55mm f4-5.6 IS STM ........£219
EF 18-135mm f3.5-5.6 IS STM .......£379

EF-S 18-200mm f3.5-5.6 IS ............£469
EF 24-70mm f2.8 L II USM .............£1899
£1734 Inc. £165 Cashback*
EF 24-70mm  f4 L IS USM   .............£799
EF 24-105mm f4 L IS USM .............£799
EF 24-105mm f4 L IS II USM ..........£1065
EF-S 55-250mm f4-5.6 IS STM ......£269
EF 70-200mm f2.8 L IS II USM .......£1999
£1799 Inc. £200 Cashback*
EF 70-200mm  f4 L IS USM  ............£1049
EF 70-300mm f4-5.6 IS II USM .....£499
EF 70-300mm f4-5.6 L IS USM.......£1289
EF 100-400mm f4.5-5.6 L IS II USM  . £1875
£1675 Inc. £200 Cashback*

MT190XPRO3 
+ 496RC2 Ball Head ..........£139
MT190XPRO4 
+ 496RC2 Ball Head ..........£189

Anvil Slim 
Professional 
Backpack

Canon Lenses Nikon Lenses

Photo Bags & Rucksacks

Tripods & Tripod Heads We sell tripod accessories including plates and spiked feet on our website!

Lighting & Accessories

20.2 mp

10.0 fps

1080p 

24.2 mp

6.0   fps

24.2 mp

6.0   fps
24 mp

5.0   fps

24.2 mp

5.0   fps

24.1 mp

6.0   fps

24.2 mp

7.0   fps

30.4 mp

7.0 fps

Full Frame

20.2 mp

4.5 fps

Full Frame
24.3 mp

6.5 fps

Full Frame

20.9 mp

10.0   fps

20.8 mp

12.0 fps

Full Frame

36.3 mp

7.0 fps

Full Frame
20.1 mp

4.2x zoom

20.2 mp

16.0 fps

Full Frame

50.6 mp

5.0 fps

Full Frame

£125
Cashback*

£125
Cashback*

£80
Cashback*



100  PRACTICAL PHOTOGRAPHY



R O Y A L

DESCEN T

PRACTICALPHOTOGRAPHY.COM  101

Factfile
Photographer: 
Nico Nordstrom
Full-time occupation: 
Fashion photographer
Aim of project: To create 
something fabulous and 
to see how far we could 
push ourselves creatively

Location: Austin and
Houston, Texas

Duration: From August 2014  
to November 2016

Time spent: Each shoot lasted 
anywhere from 4 to 16 hours, and  

we always needed at least a full day both 
before and after the shoot to set  
everything up and then tear it down

Images taken: We ended up  
with 30 edited images

Website: theroyaldescent.com 

With images draped in unapologetic 
opulence, Nico Nordstrom and her
partners have created the world of

a modern day Marie Antoinette.

MY PHOTO
P R O J E C T

PERSONAL WORK FROM
UPCOMING TALENT
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HETHUDDINGCREATIVE
heartbeat at the centre of
Nico Nordstrom’s lavishly
extravagant project is the
strong bond of collaboration
she has with her two partners,
Michi and Danni. Together

they’ve weaved an intricate world of majesty
that instantly captures their viewers’ rapt
attention. Armedwith their imagination and
ingenuity, they overcome the obstacles of low
budgets, full-time jobs and busy personal lives
to create amazing images of stunning beauty.

What first inspired this project and how long

have you been interested in it?

My partners, Michi and Danni, originally started
thinking about the project in June 2014 and
approachedmewith the idea. I’ve always been
completely fascinated with the life and legacy of

Marie Antoinette, so I jumped at the opportunity
to collaborate with such a talented team on a
project that I found so personally interesting.

How did this project evolve?

Whenwe first began we knew it was going to be
a large investment of time, money and energy,
but we had no idea what wewere actually getting
ourselves into. It started significantly smaller, but
we soon discovered that all three of us together
was like mixing fire and gasoline – in the best
possible way It went from being a large shoot to
becoming an absolutely massive project, because
wewould just build on each other’s ideas.

Above Finding a

creative use for

cardboard saved 

Nico and her 

partners from 

spending

hundreds of 

dollars on cake. 

Previous page  

Magnificent wigs 

and costumes 

create the richly 

detailed world of 

Nico’s shoots. 

“WE SOON DISCOVERED THAT ALL 
THREE OF US TOGETHER WAS
LIKE MIXING FIRE AND GASOLINE...”
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These images have lots of ornate detail – how 
did you fund and source all of your props?
It was a mixture of blind luck and sheer 
determination. We already had some of the props, 
such as the curtain rods for sceptres. However, 
we had to research some of them and find people 
that we could trade with. On other instances, such 
as with the cake scene, we were resourceful and 
saved money, found cheap alternatives and took 
shortcuts. The actual cakes themselves are all 
made out of cardboard and we used anything we 
could scavenge for the decor, such as old Mardi 
Gras beads, flowers from a team member’s wedding 
and tons of spray paint. And anything that wasn’t 
facing towards the camera was left unfinished. 

How long does it take to prepare for each 
individual shoot?
The preparation time depended on how intense the 
shoot was, but for the most part usually each shoot 

“One of the other projects that 
I’ve worked on is a massive 
2000-mile road trip from Austin, 
Texas to Portland, Oregon. 
Danni, Michi, two models and I 
lived out of a van for two weeks 
as we travelled the country. 

“We brought along designer 
dresses and averaged about 
two+ photo shoots per day. We 
ran barefoot through the 
Redwood Forest shooting a 
storybook-esque editorial in the 

fog, shot a dramatic red dress 
against the white sand dunes of 
New Mexico and photographed 
a sea queen on a black sand 
beach in Oregon. 

“It was an absolute whirlwind 
of an adventure. We had to get 
the models ready for the shoots 
in truck stop bathrooms and car 
parks, got kicked out of the 
University of California for 
trespassing and sometimes 
drove for 24 hours straight.” 

American road trip 

Personal Project Nico Nordstrom
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Personal Project Nico Nordstrom

Above Dying a 
horse pink (using 
ethical means) 
added an extra 
dimension to this 
image. 

Left Barbecue 
skewers morph 
into a stunning 
halo at the hands 
of Nico and her 
partners.  

took more than two months to prepare for. This 
included storyboarding, collecting inspirational 
images, making the props/wardrobe/wigs/
sets and then the actual setup for the shoot.  

Which one is your favourite image?
My favourite would have to be the full-length 
image of Marie on the red throne (page 106). 
During research, we happened to come across 
someone who had a throne, so we drove three 
hours so we could use it. I had the flu and was 
actually sick the entire time, so unfortunately 
the shoot itself was kind of miserable. However, 
when we saw the model in her outfit with the 
huge wig and final set, it was all totally worth it.

Do the individual images have different stories 
behind them?
Yes! We wanted to have depth to each scene, so we 
created complex back stories to go with each set. 
This helped us to figure out which elements we 
wanted to add when deciding on our styling, props 
and set design. Since the project was a modern take 
on the legacy of Marie Antoinette, we decided to 
include lots of tiny references to her life. We had a 
dog in one image because Marie had to give up her 
own dog when she entered France. We also put 
framed images of King Louis XVI in the bedroom
scene and used flowers to symbolise life and death.

This project was a creative collaboration 
with many different people – what was this 
process like?
Having such a large team was wonderful. It 
increased our resources and creativity exponentially. 
Having so many people to bounce ideas off really 
saved us from making a lot of mistakes. We all 
thought that it might be a little tricky with so many 
of us, but it was more like having a large creative 
family. There was always someone to help iron out 
the ideas and pick up the slack if another person 
became overwhelmed. Besides myself, Danni and 
Michi, our main team members were our model, 
Samantha Gloor, our make-up and hair artist, Sarah 
Contey, our seamstress and wardrobe assistant, 
Sabrina Loyless, and our set designer, Ryan Blair. 

What have your journeys as artists been like 
so far?
I’ve been a photographer for most of my life, 
but I really only fell in love with fine art fashion 
photography around seven years ago. I started 
out on my own, so I taught myself how to do set, 

“WE WOULDN’T LET ANYTHING 
STOP US FROM CREATING 
SOMETHING FABULOUS...”
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Personal Project Nico Nordstrom

fashion and prop design. Danni has been working
extensively for almost 20 years and originally 
started with styling, which has segued into a 
passion for numerous other fields in the arts. My
other partner, Michi, is a renowned hairstylist,
wig-maker and editorial stylist. She also began her 
artistic journey around 20 years ago, and has since 
expanded her creative field to all areas of styling.

What has been the most difficult part of

the project?

The most difficult part was taking on such a large
production while still having to balance our personal 
lives, school and work. We are all freelance creatives 
and none of us had any spare time or money to freely 
fritter away. When we started I was a poor college
student, and attended school while also running
my photography business. Danni and Michi are
employed full-time and are also single mums of
special needs children, so keeping everything
balanced wasn’t easy. There were a lot of sacrifices 
that we all had to make, but we all had faith that it
would be completely worth it in the end. Despite
everything that was pushing us not to work on
the project, we knew that it was something we

were passionate about. We wouldn’t let anything
stop us from creating something fabulous.

How much post-processing do you do?

Because of our small budget and limited free 
time there was a lot of post-processing involved. 
We actually photographed the majority of our 
daytime shoots late at night. We also duplicated 
the flowers so that they appeared more lush, 
and we would swap in models from different 
images. However, the horse was actually pink 
and the wigs really were that massive!

Why should PP readers start a personal project? 

Personal projects are so vitally important for 
developing your creative eye and learning about 
yourself both personally and professionally. 
There’s no easier way to kill your passion 
than by only doing it for other people. 

What’s next for you and this project? 

We’re so happy that this project has finally 
been released. I think that the next part 
is just simply getting it out there and 
sharing our work with everyone. 

Above
Contrasting
different textures
creates dynamic
images.

Top right The
detail-orientated
nature of Nico’s
shoots mean that
extravagant
props like fans
and sceptres are
given their
moment to shine.
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1
Set realistic but challenging

targets for yourself at every

single step of your shoot,

including the planning, lighting, 

shooting and editing. This way

you’re always propelling forward

and maintaining your enthusiasm. 

There’s nothing more rewarding than 

looking back on a challenging 

situation that you were able to

successfully overcome and conquer.

2
Don’t get caught up in 

perfectionism – it’s okay  

to fail! Each mistake is a 

learning experience and it’s just as

useful as achieving your goal. You 

can always re-shoot and tweak your 

ideas. The beauty of personal

projects is that nothing is final until

you decide it is. 

3
It doesn’t matter if the

resources aren’t

immediately available to

you. Don’t throw away your future 

ideas based on your current (and

temporary) situation. There’s no

problem that research, asking for

help and persistence can’t solve.

When we started living by a ‘the

worst they can do is say no’ 

mindset, it opened up a whole world

of possibilities.

4 Finding a dependable team,

no matter how small or

large, makes life so much 

easier. Even if none of you have any 

experience whatsoever, just getting 

out there and making it happen will

increase your chances of success 

exponentially. 

Pro advice Nico’s 4-step guide   
to better personal projects 

GET 
INVOLVED

We want to see your best  

photo projects! If you have  

a unique body of work you’d 

like to share with the world,  

then drop us a line at  

practical.photography@

bauermedia.co.uk
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KnowKnow
YouY rStuff

All your technique and gear questions answered by  
our team of experts knowyourstuff@bauermedia.co.uk

Tim Berry 
PP’s deputy 

editor has a 

master’s degree

in photography

and has taught

undergraduates.

Louise Carey

PP’s features

writer is an

experienced

fine art and

documentary

photographer.

Dan Mold

PP’s Photoshop

editor is a former

Digital Photo
staffer who has

encyclopedic

photo knowledge.

Tim says: Anyone who’s tried
photographing children, pets,
sports or wildlife will know how 
incredibly challenging 
fast-action photography can be. 
Even seasoned pros find it tough, 
and they have the best kit on 
their side. Let’s take a look at five 
things you can do to achieve the 
very best results.

Use a wide aperture
The wider your aperture
(represented by a small f/number),
the more light reaches the sensor.
This will help give you fast shutter
speeds that will keep the subject
sharp. Ideally, you’ll want at least
1/1000sec. Beware though that a
wide aperture means a shallow
depth-of-field, so the in-focus
area is thinner. For this reason,
don’t go wider than f/4.

Increase your ISO
If you’ve set a wide aperture but
your shutter speed is still too
slow for sharp shots, try raising
the ISO to make the sensor more
sensitive to light. Note though
that this increases digital noise,
so you shouldn’t shoot beyond
ISO 3200 (more on page 111).

Set a fast burst speed
Most cameras can shoot at 5fps
or faster, allowing you to take 
several shots in quick succession.
This is useful for capturing very
fleeting moments, such as a dog
jumping to catch a ball. In RAW,
most cameras can only maintain
their top burst speed for around
8-20 shots at a time.

Use continuous focus
With your finger half-pressed
on the shutter button, this mode
allows your camera to focus
continually, keeping the subject
sharp should they be moving
towards the camera. Also, turn
on 3D tracking so the focus point
automatically shifts should the
subject move within the frame.

Insert a fast card
A memory card with a very fast
write speed is a must for
fast-action shooting, as the
camera’s buffer will clear much
quicker. This means you’ll never
be left waiting for your camera to
save the last burst of images,
which can mean missing a
crucial moment. Aim for a write
speed of at least 60MB/s.

I’ve been taking some photos of my dogs at the park but

I find it really hard to get pin-sharp shots. What can I do

to improve my results?

Sinead Hurley, Brighton

Samsung PRO+
SD card from £25

Available in 32GB, 64GB and 
128GB capacities, Samsung’s 
Class 10 U3 PRO+ range boasts 
a read speed of 95MB/s and a 
write speed of
90MB/s,
making it ideal
for wildlife, sport
and 4K video.

SanDisk Extreme
Plus SD card
from £14

With a maximum read
speed of 90MB/s and
max write speed of
60MB/s, this Class 10
U3 card is perfect for
fast bursts. It’s available in 16GB, 
32GB or 64GB options, and is 
backed by a lifetime warranty.

How do I shoot 
fast-moving 
subjects?

JZ
A

B
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Most modern digital cameras 

have extremely capable 

autofocus systems, with several 

different modes to suit any

shooting situation. For fast

action shooting, most 

photographers will activate 

continuous focusing (AI Servo or 

AF-C), and some will make use 

of the 3D tracking. 

But a very underused 

function for sports and wildlife 

work is back-button focusing, 

where you focus by pressing the 

rear AF button with your thumb, 

rather than half-pressing the 

shutter button. Splitting the 

focusing and shooting controls 

across two buttons offers

several advantages, including 

being able to lock focus on a

particular spot without worrying 

about your camera refocusing 

when you take your shot. This is 

great if you anticipate your 

subject moving into a particular

area of the frame. 

Back-button focusing will 

seem complicated and 

unintuitive at first – perhaps like 

moving to manual gears after 

being used to an automatic. But 

it will become second nature 

quickly, and give you much 

greater control. Almost all DSLRs 

have back-button focus, but it 

has to be activated in the menu 

first, as shutter button AF is the 

default. Check your manual for 

how to do this on your camera.

Above Many DSLRs have back-button focusing, which 

is ideal for fast-action photography. It allows you to 

focus with your thumb and shoot with your finger.

Try this! Back-button focus for better results

TIP 
CONSTANTLY

CHECK RESULTS
Review your images regularly

as you shoot, zooming in to

ensure the subject is sharp.

This way you can adjust

your approach if

necessary.
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I’m about to invest in
a second lens for my
DSLR. Do you have

any need-to-know advice
before I make my decision?
Stuart Granger, Leeds 

Dan says: If you only own
one lens, chances are it’s the
18-55mm standard zoom that
came with your camera. While
these basic kit lenses tend to
offer reasonable image quality,
they often lack in other key
areas, including build quality

aperture blades from your 
autofocus before you commit.

The very first thing 
you’ll need to decide is what 
focal length best suits your 
photography. This will largely 
depend on what you shoot. 
Portraits, for example, are 
usually well suited to 50mm 

lenses (85mm on full-frame),
whereas landscapes are 
normally shot at around 
14mm (20mm on full-frame).

The next thing to consider
is the maximum aperture.
If you want a very blurry 
background behind your 
subject, or if you shoot 
handheld in low light, you’ll 
want an aperture of around 
f/2.8 or wider. However, if 
you’re a landscapes shooter, 
this is less important as you’ll 
mostly be shooting at f/16.

Once
you’ve
settled on these two things,
you should have narrowed 
down your options to just a 
few compatible models. But 
before you decide, it’s worth 
considering some of the below 
features and functionality.

    

  Size & weight   

Lens coatings

  Internal design  

TIP
CONSIDER

SECOND HAND
Used lenses are generally as 
good as new ones, so long as 
there aren’t scratches on the 

front or rear elements, or 
internal dust or

mould.

  Image   
  s bilisation  

 

  Weather-sealing    Extending barrel  

.

  Smooth   
  zoom and   
  focus rings  

.

  Lens hood   
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My shots are brighter in

the middle than they are

the corners. Is this a

problem with my lens?

Rod Storey, Exeter

Tim says: The problem you’re

describing is an optical issue known

as vignetting, and all lenses suffer

from it to an extent. It’s most severe

at the widest aperture setting, and

usually all but invisible by around f/8. 

You can check how severe your

lens’ vignetting is at different

apertures by shooting a plain white

wall in RAW format, and looking at

the results on a computer screen.

You may notice that vignetting is

less severe when working in JPEG

format, as your camera may have

in-built lens profiles to compensate.

Vignettes are usually considered

an imperfection, though sometimes

photographers add one in editing for

creative effect – many feel that it

helps focus the eye on the centre of

the frame. If desired, you can easily

remove vignetting in Lightroom or

Photoshop by activating the Lens

Corrections function, which should

recognise the lens you used

automatically and make the

necessary adjustments.

What’s the highest ISO you’d recommend I use?

I’ve heard that the golden ratio
can help improve the look of
my images. What is it and how

do I use it in my photography?
Sheila Finegold, East Sheen 

Louise says: If you’ve read Camera School
(page 118), you’ll be well aware of the
rules of composition. The rule-of-thirds,
foreground interest and lead-in lines can
help to make an otherwise unremarkable
image extremely eye-catching. But one
lesser known idea predates all of these –
the golden ratio. In 1200AD, Leonardo
Fibonacci found that all sorts of objects
within nature conformed to the same basic
proportions, and that this was pleasing to
the human eye. Like the rule-of-thirds,
the golden ratio is also easiest to visualise
with a 9x9 grid overlaying your frame.
However, rather than nine equally-sized

rectangles, the centre rectangle is smaller
than the others, so the two horizontal
and vertical lines are nearer to the centre.
An ever shrinking spiral can then be
drawn onto this grid (as below). Commit
this shape to memory and look out for a
composition that follows this pattern.

What is the golden
ratio & how can I use it?

I often work in dark conditions.

What’s the maximum ISO I

should use? Lin Ellis, Hounslow

Dan says: Your camera’s ISO adjusts

how sensitive the sensor is to light. In

darker conditions, increasing sensitivity

gives faster shutter speeds, so you can

handhold your camera without risking

blur. Higher ISOs mean more noise.

When handholding, the goal is to shoot

with the lowest ISO while having a fast

enough shutter speed to avoid camera

shake. On most newer DSLRs and

CSCs, noise is minimal up to ISO 1600,

and images are still useable to 3200,

with some noise reduction in

Photoshop. Avoid anything beyond

this, using either flash or a tripod

instead. Or, turn on image stabilisation,

to steady your shot at slower shutter

speeds. It’s better to have a noisy

image than a blurred one, so use a high

ISO if camera shake’s a possibility.

Why are my 
images dark in 
the corners?

Above On a newer DSLR, you can achieve 

very useable images right up to ISO 3200.

Above The golden ratio (blue) is broadly 

similar to a rule of thirds grid (yellow).
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I’ve just bought some basic

studio lights but I’m not too

sure how to fire them from my

camera, or what settings to use. Help!

Steve Johnson, Clacton-on-Sea 

Tim says: If you’ve not used dedicated 
studio lighting kit before, it can seem 
pretty complex and high-end. But in many 
ways studio photography is far easier to get 
the hang of than working outdoors, as 
you’re always in complete control of the 
light falling onto your subject. 

To get started, the first thing you’ll need 
to do is connect the studio head to the 
camera. Check in the box that your lights 
came in and look for a PC sync cable 
(usually included). This should have a jack 
connector on one end, which plugs into the
head, and a PC sync on the other, which 
plugs into your camera (see inset). If your 

camera doesn’t have a PC port, you’ll need
to buy a PC hotshoe adapter.

With this in place, your lights should
now fire. However, if you’d prefer not to
have a cable stretching across your setup, 
consider investing in some wireless 
triggers instead. These can cost under £25
for a set, and also fire flashguns – check out
the three options below. Note that for 
studio lights you’ll only need one 
transmitter and one receiver, regardless of
how many lights you have. Just flick the 
cell switch on the back of the heads 
without a receiver, and they’ll 
automatically fire with your master light.

In terms of settings, shoot in manual, 
using ISO 100,  an aperture of f/8 and a 
shutter speed of 1/160sec. Adjust the lights
to 1/2 power and position them around 6ft 
from the subject. Then simply change light
power for a brighter or darker shot.

Three great value wireless trigger options

Calumet Pro Series 4 kit £65C 5
This twin-unit kit includes a test button, 

a status LED, and offers a 100m range if 

used with flashguns. There are four

channels in case you’re working near 

other photographers with triggers, and 

leads are included. Takes AAA batteries. 

Available in Canon and Nikon fits.

Phottix Strato II kit £140
This 5-in-1 transmitter and receiver kit 

offers a range of more than 150m and a 

sync speed of up to 1/250sec. It allows 

you to create up to four groups of lights if 

desired, has four channels to avoid firing 

nearby lights, and runs on AAA batteries. 

Available in Canon, Nikon and Sony fits. 

Yongnuo RF603 kit £23
Including two transceivers, this basic, 

but exceptionally good value, kit boasts 

a range of 100m. For use with most 

studio heads, you’ll need to buy a 

2.5mm to 6.35mm jack cable. The units 

work on AAA batteries, and are available 

in Canon and Nikon fits.

trigger studio lights?

P
E

O
P

LE
IM

A
G

E
S

 
thread size?

I need to know what

thread size my lens is,  

as I want to order some 

filters. How can I find this out? 

Kerry Brown, West Lothian

Louise says: Unless your lens 

features a built-in non-removable 

lens hood, it almost certainly has 

a tiny thread surrounding the front 

element. This is designed so you 

can attach filters (directly or via a 

filter holder) and lighting 

accessories. The thread is 

measured in millimetres, and is 

dictated by the physical size of the 

front element of your lens. Smaller 

DSLR lenses usually have a thread 

size of around 35mm, whereas 

larger telephoto models can be 

around 105mm. Most landscape 

lenses are 77mm, so this is a 

common thread for filters.

A lens’ thread size is usually 

found on the back of the lens cap, 

so check there first. If not it should 

be printed somewhere on the lens 

body, often represented by a ‘ø 

symbol’. If you still can’t find it, 

check the manufacturer’s website.
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Lens/Camera Adaptors

Close up & Macro

Circular Polarisers

“Highly Rated”
- Practical Photography, June 2016

- NPhoto Magazine, August 2016 - Digital Photo, 2015

Neutral Density Filters

- Digital Camera, ND Group Test

visit srb-photographic.co.uk
for more information.

Infrared
Skylight
Black & White
Colour Grad
6WDU (�HFW

from £19.95
from £9.95
from £7.50
from £14.95
from £12.95

More Filters...UV Filters

from £12.50 - Digital Photo, 2015

ND Fader Filters

from £29.95

ND Grad Filters

from £16.50

Available Grads:
0.3 0.6 0.9 1.2

from £16.95 from £13.95

0.3 0.6

0.9 1.2
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�OWHU� 9LVLW srb-photographic.co.uk for more!

- Photo Plus, 2014

Camera Lens £

Canon EOS
Canon EOS
Canon EOS
Canon EOS
Canon EOS
Canon EOS
Canon EOS
Canon EOS
Canon EOS
CanonEOS-M
CanonEOS-M
CanonEOS-M
CanonEOS-M
CanonEOS-M
CanonEOS-M
CanonEOS-M
Fuji X
Fuji X
Fuji X
Fuji X
Fuji X
Fuji X
Fuji X
Nikon
Nikon
Nikon
Nikon 1
Nikon 1
Nikon 1
Nikon 1
Nikon 1
Nikon 1
Nikon 1
Nikon 1
Micro 4/3

M42
Nikon
Nikon G
Pentax K
Olympus OM
Con/Yash
Leica R
Leica M
Canon FD
Canon EOS
Leica M
Nikon
Canon FD
C Mount
M39
M42
M42
Leica M
Nikon
Canon EOS
Olympus OM
Canon FD
Con/Yash
M42
Canon FD
C Mount
M42
M39
Nikon
Canon EOS
Pentax K
Leica M
Leica R
Con/Yash
Canon EOS

£16.95
£22.95
£39.95
£24.95
£24.95
£24.95
£22.95
£24.95
£44.95
£29.95
£29.95
£29.95
£29.95
£29.95
£29.95
£29.95
£24.95
£29.95
£29.95
£29.95
£29.95
£29.95
£29.95
£24.95
£44.95
£32.95
£24.95
£22.95
£29.95
£44.95
£29.95
£39.95
£37.95
£23.95
£29.95

Micro 4/3
Micro 4/3
Micro 4/3
Micro 4/3
Micro 4/3
Micro 4/3
Micro 4/3
Micro 4/3
Micro 4/3
Micro 4/3
Micro 4/3
Olympus 4/3
Olympus 4/3
Olympus 4/3
Olympus 4/3
Olympus 4/3
Olympus 4/3
Pentax
Pentax
Pentax
Pentax
Sony Alpha
Sony Alpha
Sony Alpha
Sony Alpha
Sony Alpha
Sony NEX
Sony NEX
Sony NEX
Sony NEX
Sony NEX
Sony NEX
Sony NEX
Sony NEX
Sony NEX

Nikon
Nikon G
M42
Olympus OM
Minolta MD
Leica R
Leica M
Sony Alpha
Pentax K
Canon FD
Con/Yash
M42
Con/Yash
Leica R
Nikon
Olympus OM
Pentax K
M42
Nikon
Sony Alpha
Canon FD
M42
Minolta MD
Nikon
Pentax K
Canon FD
Canon EOS
Nikon
Sony Alpha
Olympus OM
Pentax K
Leica M
Leica R
Canon FD
M42

£29.95
£34.95
£29.95
£29.95
£29.95
£29.95
£29.95
£34.95
£29.95
£29.95
£29.95
£17.95
£22.95
£22.95
£22.95
£22.95
£22.95
£18.95
£44.95
£44.95
£44.95
£15.95
£44.95
£44.95
£44.95
£44.95
£29.95
£29.95
£34.95
£29.95
£29.95
£29.95
£29.95
£42.95
£23.95

Camera Lens £
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SRB Photographic

n-it

�0D[� +� ����PP

- Min.H: 400mm

�:HLJKW� ���J

�0D[� /RDGLQJ:�

�NJ

£24.95
only

- Carbon Fibre

� $UFD�VZLVV +HDG

� 5HG� %ODFN 	 %OXH

£119.95
only

$ZDUG�ZLQQLQJ DFFHVVRULHV IRU FORVH XS SKRWRJUDSK\

$ZDUG�ZLQQLQJ 65%3KRWRJUDSKLF EUDQG

52mm
55mm
58mm
62mm
67mm
72mm
77mm

£19.95
£20.95
£21.95
£22.95
£23.95
£24.95
£25.95

Foundation Kit
Push-on Holder
Professional Kit
Upgrade Kit
Adaptor Rings from

ND Filters from

Polarisers from

£59.95
£115.00
£115.00
£75.00
£20.00
£78.00
£155.00

Big Stopper
Little Stopper
Super Stopper
Filter Sets from

Digital Starter Kit
Accessories from

£99.95
£95.99
£99.95
£100.00
£219.95
£4.95

Canon EOS
Canon EOS-M
Fuji XPro
Micro 4/3
Nikon 1

£29.95
£49.95
£49.95
£49.95
£49.95

Canon EOS
Micro 4/3
Nikon
Olympus 4/3
Sony Aplha

£17.50
£17.50
£17.50
£17.50
£17.50

Nikon
Pentax Q
Sony Alpha
Sony NEX

£54.95
£49.95
£54.95
£49.95

(DFK VHW LQFOXGHV

IRXU FORVH XS OHQVHV

ZLWK XSWR ��� GLRSWHU

DQG�D�SURWHFWLYH FDVH

Auto Extension Tubes Manual Extension Tubes

Camera Adaptors

Other Adaptors

Self Take KitsCaps & Hoods

&DQȇW VHH \RXU�DGDSWRU"�:LWK�RXU�RQ�VLWH�

HQJLQHHULQJ�IDFWRU\���DQ\WKLQJ�LV�SRVVLEOH��

)LQG PDQ\ PRUH DGDSWRUV IRU DOO NLQGV RI SKRWRJUDSK\ DW srb-photographic.co.uk

£8.00
£265.00
£77.00

T2 Mounts from

MTF Adaptors from

1RYR�H[�$GDSWRUV�from

£14.95
£16.45
£4.95

C-Mount Adaptors from

Enlarging Adaptors from 

Step Rings from

Flat Step Rings
Bayonet Step Rings from

Microscope Adaptors

£7.00
£15.50
£49.95

Tripods & Monopods

25mm On-it Tripod On-it Monopod

LEE Filters 100mm System

LEE Filters Seven5 System LEE Filters SW150 System

Travel Tripod
e����

Monopod Feet
-XVWe�����

Lens Caps

Body Caps

Rear Lens Caps

Petal Hoods

Rubber Lens Hoods

Metal Hoods

Body & Rear Sets

£3.95

£3.50

£3.50

£10.95

£4.95

£5.95

£5.95

from

from

DSLR Self Kit

Compact Self Kit

Angled Self Kit

£34.95

£24.95

£34.95

0LFUR�EUH &ORWKV
Olloclip Lenses
Lens Pouch
Deluxe Lens Pouch
Circular Filter Pouch
Square Filter Wallet
Square Filter Case
Lightning Sensors
6HO�H 6WLFN %XQGOH
Bluetooth Remotes
OpTech Straps
Camera Spirit Levels

£1.50
£59.95
£8.50
£11.95
£5.95
£9.95
£1.95
£64.95
£5.95
£2.95
£9.99
£3.50

from

from

from

from

from

from

Lens Pen
Cleaning Kits
Dust Blowers
Cleaning Solution

£4.95
£5.95
£3.50 
£4.95

from

from

Memory Card Cases
5H�HFWRU .LWV
Rainsleeves Pack of 2

White Balance Caps
Filter Stack Caps
Angled View Finder
DC Compact Mount
&LUFXODU��OWHU:UDSV

£9.95
£8.95
£5.95
£9.95
£10.95
£39.95
£17.95
£9.95

from

fromIn-It Lens Pocket £3.95 fromIn-It Camera Wrap £8.95Accessories

LEE Filters 6RPHWKLQJ�IRU�WKH�SURIHVVLRQDO

Seven5 
Holder
£59.50

SW150 Mark II
Holder
£150.00

£17.50
£52.00
£64.95
£65.00
£68.00

Adaptor Rings
ND Grads
ND Filters
Big Stopper
Little Stopper

£89.95
£64.95
£95.00
£132.00
£132.00

Adaptors
Screw Adaptors
ND Filters from

Big Stopper
Little Stopper

£129.95
£180.00
£249.00
£18.00
£47.95

Super Stopper
Polariser
ND Filter Sets
Lightshield
Filter Pouch

£64.95
£190.00
£109.00
£460.00
£69.50

Super Stopper
Polariser
Starter Kit
Deluxe Kit
Seven5 Hood

0DQ\�PRUH�JUHDW�SURGXFWV�RQOLQH��6LJQ�XS�IRU�WKH�ODWHVW�QHZV�DQG�R�HUV�DW www.srb-photographic.co.uk

- Carbon Fibre

� $UFD�VZLVV +HDG

� 5HG 	 %ODFN

£149.95
only

28mm On-it Tripod

- Practical Photo, 2016

- NPhoto, 2016

You could easily 
expect to pay that 
for the lightweight 
alloy head alone

- F2 Freelance Magazine

ND1000 Filters
from £24.95

Best Value in Photoplus Big
Stopper Group Test

P Size Lens Hood
£39.99

new

FREE 
UK delivery!
2Q�DOO�RUGHUV�

WRWDOOLQJ e�� RU RYHU

1H[W�GD\�GHOLYHU\�

available

100mm 
Starter Kit

from 

£139.95

*Exclusive*

1 9 6 7 - 2 0 1 7

SRBPHOTOGRAPHIC
Celebrating 50 years of SRB

Pro Filter System

Best Value
Digital Camera mag

P Size
P Size W/A

£19.95
£19.95

Plastic Filter System
� [ +ROGHU � [ $GDSWRU�5LQJ

P Size
£4.95

Adaptor Rings £4.95

A Size
£8.95 Filter Kit

A Size  £39.95
P Size £39.95

Starter Kit
A Size  £29.95
P Size  £24.95

Individual Square Filters

0.3 Full ND
0.6 Full ND
0.9 Full ND

£14.95
£14.95
£14.95

0.3 Soft ND
0.6 Soft ND
0.9 Soft ND

£14.95
£14.95
£14.95

0.3 Hard ND
0.6 Hard ND
0.9 Hard ND

£14.95
£14.95
£14.95

Sunset Grad
Twilight Grad
Black & White
6WDU (�HFW

£14.95
£14.95
£13.50
£13.50

$�6L]H�	�3�6L]H�UHVLQ�VTXDUH��OWHUV

P Size 6-Stop Filter

P Size ND1000
£29.95

£29.95

Pro Glass Square Filters
Full ND
Soft ND Grad
Hard ND Grad
Black & White
Landscape

£39.95
£39.95
£39.95
£29.95
£34.95

Square Filter Sets3�6L]H�JODVV�VTXDUH��OWHUV

0.3 0.6 0.9 1.2
£22.95 £22.95 £22.95 £22.95 - Digital Photo, 2014

new

Elite Filter System

Elite Adaptor Rings £5.95

Elite Polariser
£24.95

Elite ND1000
£29.95

7KH QHZ3 6L]H VTXDUH �OWHU V\VWHP

Ȋ:HOO�PDGH 	 GHVLJQHG��OWHU�V\VWHP�WKDW�OLIWV�WKH VHPL�
SUR 3 V\VWHP�WR�D�KLJKHU�OHYHOȋ f2 Camercraft

Elite Filter Holder
£34.95

new

Square Filters

“SRB are a company who are vital to the optical 
LQGXVWU\�DW�ODUJH��7KH\�DUH�WKH�JR�WR��UP�ȋ

��3URIHVVLRQDO�ΖPDJHPDNHU�0DJD]LQH



Reader Survey
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To take part in our survey and prize draw, visit:
www.practicalphotography.com/survey  

We need your help! Our mission at Practical Photography isy
simple – we want to create the biggest and best magazine 

for you, the reader, and help you to fulfil your creative 

potential. Your feedback helps us to evolve and improve, 

which is why we’d like to invite you to take part in our survey

and tell us what you think. Whether you’ve been reading

Practical Photography since the 1980s or have just pickedy
up your first copy (in which case, welcome), we want to 

know what you’d like to see more or less of, which sections

you flick to first, how often you watch the videos, and so 

on. We live and breathe photography and we know you do

too, which is why your opinions are so important to us. 

Win! A new Nikon DSLR
To make it worth your while, we’ve got a Nikon D3400 

and AF-P DX Nikkor 18-55mm f/3.5-5.6G VR lens 

worth £490 up for grabs. Everyone who completes 

the survey can enter the prize draw. The lucky 

winner will be announced on the official Practical 
Photography Facebook page on 16 May 2017.y

THE PRIZE
NIKKOR 18-55MM F/3.5-5.6G VR LENS
The Nikon D3400 is the perfect entry-level DSLR – compact, light 

and easy to use. Powered by Nikon’s Expeed 4 processor and 

24.2MP APS-C sensor, the D3400 boasts a wealth of impressive 

features, including a 5 frames-per-second burst mode, Full HD 

video and innovative SnapBridge, which connects the camera to 

your smart device via Bluetooth so you can sync photos as you 

shoot. Plus, for first-time DSLR users, the Guide Mode provides an 

alternative to the main menus to help quickly capture specific types 

of images. Nikon’s AF-P DX Nikkor 18-55mm f/3.5-5.6G VR is a 

versatile zoom lens for great everyday photography. It focuses 

quickly and smoothly, with virtually no drive noise, which also makes 

it the perfect partner for shooting movies. Nikon’s impressive 

Vibration Reduction (VR) keeps images sharp, even in low light.

Tell us what 
you think!
& win a Nikon 
D3400 DSLR  
kit worth £490

WIN!
THIS AMAZING 
NIKON CAMERA

& LENS KIT



All prices include VAT @ 20%. All products are UK stock. E&OE. * = Please mention “Practical Photography” for this special price.
For our opening times and directions to our BURGESS HILL and LONDON stores, please visit www.parkcameras.com/prp.

Prices correct at time of going to press; Prices subject to change; check website for latest prices.

Exclusive offers,
competitions & more at

Experts in photography   Unbeatable stock availability      Competitive low pricing      UK stock

14mm f/2.8L II USM £1,999.00

20mm f/2.8 USM £449.00

24mm f/1.4L Mk II USM £1,499.00

24mm f/2.8 IS USM £429.00

24mm f/2.8 STM £139.00

28mm f/1.8 USM £419.00

28mm f/2.8 IS USM £389.00

35mm f/1.4L II USM £1,899.00

35mm f/2.0 IS USM £469.00

40mm f/2.8 STM £199.00

50mm f/1.2 L USM £1,369.00

50mm f/1.4 USM £349.00

50mm f/1.8 STM £129.00

60mm f/2.8 Macro £419.00

85mm f/1.2L II USM £1,769.00

85mm f/1.8 USM £349.00

100mm f/2 USM £429.00

100mm f/2.8 USM Macro £459.00

100mm f/2.8L Macro IS £869.00

135mm f/2.0L USM £949.00

180mm f/3.5L USM £1,329.00

200mm f/2.0L IS USM £5,399.00

200mm f/2.8L USM/2 £699.00

300mm f/2.8L USM IS II £5,799.00

300mm f/4.0L USM IS £1,279.00

400mm f/2.8L USM IS II £9,899.00

400mm f/4.0 DO IS II £6,999.00

400mm f/5.6L USM £1,199.00

500mm f/4.0L IS MK II £8,399.00

600mm f/4.0L IS MK II £11,349.00

800mm f/5.6L IS USM £11,899.00

8 15mm f/4L Fisheye USM £1,199.00

10 18mm IS STM £229.00

10 22mm f/3.5 4.5 £499.00

11 24mm f/4L USM £2,699.00

15 85mm f/3.5 5.6 IS £649.00

16 35mm f/2.8L II USM £1,429.00

16 35mm f/2.8L III USM £2,099.00

16 35mm f/4.0L IS USM £939.00

17 40mm f/4.0L USM £719.00

17 55mm f/2.8 IS USM £749.00

18 135mm IS STM £379.00

18 135mm f/3.5 5.6 IS USM £409.00

18 200mm f/3.5 5.6 £469.00

24 70mm f/2.8L II USM £1,899.00

24 70mm f/4.0L IS USM £799.00

24 105mm f/4L IS II USM £1,065.00

24 105mm f/3.5 5.6 IS STM £729.00

28 300mm f/3.5 5.6L IS £2,249.00

55 250mm f/4 5.6 IS STM £285.00

70 200mm f/2.8L IS II USM £1,999.00

70 200mm f/2.8L USM £1,329.00

70 200mm f/4.0L IS USM £1,149.00

70 200mm f/4.0L USM £659.00

70 300mm f/4.0 5.6 IS £449.00

70 300mm f/4.0-5.6IS II USM £499.00

70 300mm f/4.0-5.6L IS USM £1,289.00

75 300mm f/4.0 5.6 USM III £229.00

100 400mm L IS USM II £1,875.00

200 400mm f/4.0L USM £10,999.00

Prices updated DAILY! Visit us in store, online at
parkcameras.com or call our expert team on 01444 23 70 54

The EOS 80D excels at sports, portraiture,
landscape, street, travel and low light
photography – as well as serious movie making,
thanks to innovative technologies that help you
achieve stunning results in any situation.

24.2
MEGA

PIXELS 7 fps
1080p3.0”

In stock from £919.00*

Canon EOS 7D Mark II

20.2
MEGA

PIXELS 10 FPS

Body only + 100-400 L IS II

*Price after £125 cashback
from Canon. Offer ends 16.05.17

Canon EOS 6D

20.2
MEGA

 PIXELS

+ 24-105 IS STM

*Prices after £125 cashback
from Canon. 15.03.17 16.05.17

Canon EOS 5DS

50.6
MEGA

PIXELS

See website for
low prices on

lenses

*Price after £250 cashback
from Canon. Offer ends 16.05.17

Canon EOS 5DSR

50.6
MEGA

 PIXELS

+ 11-24mm f/4L

*Prices after £250 cashback
from Canon. Offer ends 16.05.17

Canon EOS M5

24.2
MEGA

PIXELS 7 FPS

Body only + 15-45mm

*Prices after £80 cashback 
from Canon. Offer ends 16.05.17

£80
cash
back

*Price after £80 cashback claimed from Canon. Offer ends 16.05.17

£125
cash
back

£125
cash
back

£250
cash
back

£250
cash
back

Canon PowerShot
G5X

20.9
MEGA

PIXELS

*Price after £35 cashback
from Canon. Offer ends 16.05.17

£35
cash
back

Canon PIXMA
PRO 100s A3+ Printer

In stock at only

*Price after £50 cashback
from Canon. Offer ends 16.05.17

£50
cash
back

£80
cash
back

Canon EOS 5D Mk IV

30.4
MEGA

 PIXELS

See website for
12 months 0%

fi nance!

For up to £200 cashback on selected Canon lenses, visit us instore, or see www.parkcameras.com

Canon PowerShot
G9X

20.2
MEGA

PIXELS

Available in Black or Silver

Add a Canon NB-13L spare 
battery for only £59.00

3x

For a range of refurbished Nikon cameras and lenses at
low prices, visit our website and search ‘REFURBISHED’

The D500 features a 20.9 MP sensor, 10fps
continuous shooting, 4K UHD video recording,
and an impressive ISO range of 100-51,200.

20.9
MEGA

PIXELS 10 fps
4K3.2”

Add a Nikon MB-D17 battery grip for only £349.00 In stock from £1,729.00

153
POINT

 AF

Nikon D5600

24.2
MEGA

 PIXELS

+ 18-140 VR

Add a Nikon EN-EL14a spare
battery for only £47!

Nikon D7200

24.2
MEGA

PIXELS 6 FPS

Body only + 18-105 VR

Add a Nikon MB-D15 battery
grip for only £229!

Nikon D610

24.3
MEGA

PIXELS 6 FPS

Body only + 24-85 VR

Add a Nikon MB-D14 battery 
grip for only £229!

AF G 10.5mm f/2.8G ED DX £599.00

AF D 14mm f/2.8D £1,329.00

AF D 16mm f/2.8D Fisheye £699.00

AF S 20mm f/1.8G ED £669.00

AF D 20mm f/2.8 £499.00

AF D 24mm f/2.8D £379.00

AF S Nikkor 24mm f/1.4G £1,799.00

AF D 28mm f/2.8 £259.00

35mm f/2 AF Nikkor D £269.00

AF S 35mm f/1.8G ED £439.00

AF S 35mm f1.8G DX £169.00

AF S 40mm f/2.8G ED £239.00

AF 50mm f/1.4D £259.00

AF S 50mm f/1.4G £389.00

AF D 50mm f/1.8 £119.00

AF-S 50mm f/1.8G £189.00

AF D 60mm f/2.8 Micro £429.00

AF S 60mm f/2.8G Micro ED £499.00

AF S 85mm f/3.5G DX £429.00

AF S 85mm f/1.8G £429.00

AF S 105mm f/2.8G VR £749.00

AF D 135mm f/2.0D £1,149.00

AF D 180mm f/2.8 IF ED £749.00

AF D 200mm f/4D IF ED £1,249.00

AF S 200mm f/2G ED VR II £4,769.00

AF S 300mm f/2.8G ED VR II £4,849.00

AF S 300mm f/4 D IF ED £1,149.00

AF S 300mm f/4E PF VR £1,549.00

AF S 400mm f/2.8 FL ED VR £9,999.00

AF S 500mm f/4E FL VR £8,499.00

AF S 600mm f/4E FL VR £10,999.00

AF-S 800mm f/5.6E FL VR £14,799.00

AF S 10 24mm f/3.5 4.5G £729.00

AF S DX 12 24mm f4 G £979.00

AF S 16 80mm f/2.8 4E VR £869.00

AF S 16 85mm f/3.5 5.6G £579.00

AF S 17 35mm f/2.8 IF ED £1,499.00

AF S 17 55mm f/2.8G DX £1,329.00

AF S 18 35mm f/3.5 4.5G £599.00

AF S 18 105mm VR £219.00

AF S 18 140mm ED VR DX £429.00 

AF S 18 200mm ED VR II  £534.00

AF S 18 300mm f/3.5 6.3 VR  £629.00 

AF S 24 85mm VR £429.00 

AF S 28 300mm ED VR £799.00

AF S 55 200mm f/4-5.6 VR II £259.00

AF S 70 200mm f/2.8 VR II£1,999.00 
AF-S 70-300mm IF ED VR  £499.00 

Nikon D750

24.3
MEGA

PIXELS 6.5 FPS

Body only + 24-120 VR

Add a Nikon MB-D16 battery
grip for only £229!

Nikon D810

36.3
MEGA

PIXELS 7 FPS

Body only + MB-D12 grip

Save 5% on accessories with
the D810! See website.

Nikon D5

20.8
MEGA

PIXELS 12 FPS

XQD Type CF Type

Save 5% on accessories with 
the D5! See website.

Prices updated DAILY! Visit us in store, online at
parkcameras.com or call our expert team on 01444 23 70 54

Introducing the ultimate high-end mirrorles
camera: a compact and lightweight body
which overturns common perceptions of
medium format digital cameras.

51.4
MEGA

PIXELS
1080p3.2”

Call us on 01444 23 70 54 for latest availability! Available from £6,199.00

15
FILM

MODES
NEW!

Fujifilm X-T2

24.3
MEGA

PIXELS

Body only + 18-55mm R

Extra £200 bonus when you
trade in your old camera!

f

Fujifilm XF 50-140mm
f/2.8 WR OIS

In stock at

For even more Fujifilm
lenses, visit our website

Fujifi lm X-PRO2

24.3
MEGA

PIXELS

Body only Graphite

Extra £200 bonus when you
trade in your old camera!

4K

Lume Cube
LED Lighting

Available from

See the Lume Cube range of
LED lights on our website!

Slik Lite
Aluminium &
Carbon Fibre
Tripods

Available from

See the complete range of
Slik tripods on our website!

NEW!

Vanguard Alta
Shoulder Bags /Backpacks

Available from

See the Vanguard range 
in store or online!

NEW!

With unerring autofocus, unshakeable stability,
and intuitive touchscreen operation crafted to
fit in a palm, the a6500 is so ideal everywhere
that you never need to miss a moment.

24.2
MEGA

PIXELS 11 fps
IS 4K3.0”

Add a Sony FE 50mm f/1.8 lens for only £199.00
when bought with the a6500! Normally £229.00. In stock from £1,499.00

20.1
MEGA

PIXELS

4K

In stock Spread the cost with

our finance options!

Add a Sony NP-BX1 spare
battery for only £36!

Sony a6300

24.2
MEGA

PIXELS 11 FPS

Body only + 16-50mm

Add a Sony NP-FW50 spare
battery for only £54!

Sony a7S II

12.2
MEGA

PIXELS

+ 24-70 f/2.8 GM

Add a Sony NP-FW50 spare 
battery for only £54!

Enter our photo competition in the month of April for the chance to WIN an Olympus E-PL8 + 14-42mm EZ!
Learn more and submit your entry at www.parkcameras.com/calendar-competition-2017

W
IN

!



OMore intuitive interface
makes viewing even easier

O Extra images and videos
o inspire your photography

O Retina-optimised display  
or incredible detail & clarity

New iPad 
edition! 
The best digital 
photo magazine 
just got better...      

Enjoy over 60 minutes of
expert advice every issue

and get more free gifts

See the world s most amazing
photographs as they were

meant to be displayed

Navigate around the
magazine quickly and easily

with its slick new design

 Bring pictures to life  
 with pan & zoom detail

 Take a fresh look at  
 your favourite features

 Watch the best camera  
 and editing videos 

Packed 
with over 
60 minutes  
of video 
lessons! 

Subscribe or buy a single issue right now at
www.greatmagazines.co.uk/pp
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SUPPORTED BY

You’ll learn how to shoot properly exposed, well-composed and
pin-sharp landscapes, before putting your new skills to the test.

MODULE 1 CLASSIC LANDSCAPES

Sign up today at camera-school.com

FREE TIPS 
CARDS! 
SEE THIS ISSUE’S 
BACK COVER 
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\\ MODULE 1
CLASSIC LANDSCAPES
Issue: May 2017
On sale: 13 April 2017
Homework deadline: 10 May 2017
Marks announced: 24 May 2017

\\ MODULE 2
FLATTERING PORTRAITS
Issue: June 2017
On sale: 11 May 2017
Homework deadline: 7 June 2017
Marks announced: 21 June 2017

\\ MODULE 3
NATURAL WORLD
Issue: July 2017
On sale: 8 June 2017
Homework deadline: 5 July 2017
Marks announced: 19 July 2017

\\ MODULE 4
CREATIVE STILL LIFE
Issue: August 2017
On sale: 6 July 2017
Homework deadline: 2 August 2017
Marks announced: 16 August 2017

\\ MODULE 5
ARTISTIC MOVEMENT
Issue: September 2017
On sale: 3 August 2017
Homework deadline: 30 August 2017
Marks announced: 13 Sept 2017

\\ MODULE 6
AFTER DARK
Issue: October 2017
On sale: 31 August 2017
Homework deadline: 27 Sept 2017
Marks announced: 11 October 2017

IMPORTANT DATES 
CUT OUT & KEEP   

What is Camera School?
Designed for beginners who want to take their 

photography to the next level, Camera School is  

a free six-month course that teaches you the key 

camera settings and techniques needed to start 

shooting striking images. Every module focuses on  

a new genre. Sign up at camera-school.com to get 

expert feedback, exclusive how-to videos and more.

Tell me more about the homework...
Every month, we’ll set you a homework task based 

on the techniques you’ve learned – take a look at the 

cut-out-&-keep course schedule to the right. You’ll 

be working to a brief with very specific criteria, so 

read this carefully before you shoot (see page 125). 

Upload your homework by the deadline and we’ll give 

you feedback on your work, and hopefully a certificate!

How will my certificates work?
If you complete the homework task perfectly, ticking 

all the boxes specified in the brief, you’ll receive a 

Gold certificate! If you didn’t quite get it right, you’re 

still in with a good chance of a Silver or Bronze. Find 

out how to submit your homework on page 125.

GET 
FEEDBACK 

ON YOUR SHOTS!
Not only will you receive a 

special certificate if you pass 

the module, but we’ll give 

you some expert personal 

feedback on your 

image!
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CORE SKILLS TAKE CONTROL 
OF COMPOSITION

UNDERSTAND THE
RULE-OF-THIRDS

The way that the various elements of the scene  

are arranged within your frame can really make or 

break your image. A poorly considered composition

tends to produce unbalanced, aesthetically 

awkward results. But get it right, and you’ll be  

able to achieve eye-catching, sophisticated 

images every time. On this page we’re going to 

focus on three of the most effective compositional

techniques for shooting landscapes, and we’ll  

be asking you to employ all of them when taking 

your homework image.

Choose a focal point
It might sound painfully obvious, but a strong focal
point (a main point of interest) is fundamental to

producing an interesting shot. This could be a 

house, a tree, a windmill, a person, or as in the 

image to the right, a lighthouse. Once chosen, set

up your camera on your tripod and move around

the scene to find a lead-in line. This compositional

device helps to lead the viewer’s eye towards the

focal point, and will ideally start in one of the 

corners of the frame. There are no hard-and-fast

rules as to what you should or shouldn’t use as your

lead-in line, but a path, fence or even an aeroplane

trail are all ideal candidates. Once you start using

lead-in lines, you’ll see how effective they are at 

directing the viewer’s eye towards the focal point.

The third compositional rule you’ll need to employ is

called the rule-of-thirds. And the clue’s in the

name, as the idea is that dividing your

frame up into nine equal rectangles and

placing lines or objects on one of the

four intersecting lines will make your

image look more balanced. There’s

more information on just how to do

this below.

Above Lead-in lines point the viewer towards the main 
focal point of the image. In the top shot, the shoreline 
directs the viewer’s eye towards the lighthouse.

Imagine your frame is divided into nine equal 
rectangles, by two horizontal and two vertical 
lines. Now position your horizon on either of the 
two horizontal lines so that the sky takes up either 
one third or two thirds of the frame. This is often 
more pleasing to the eye than when the horizon is 
halfway down the shot. You can also make use of 
the vertical lines by aligning them with any vertical 
objects in the frame, such as a tree, lighthouse or 
rock. Here we’ve used Dorset’s Pulpit Rock. It 
looks striking when your focal point falls on one of 
four points where the horizontal and vertical lines 
cross. These points are called powerpoints. Place 
your focal point on one of these, then use lead-in 
lines to guide the eye to it for maximum impact.

TIP 
USE LIVE

VIEW TO COMPOSE
In Live View, use the info 
button to display a grid to 
help you frame-up. Some 

models have a virtual 
horizon so you can

level up too.

 NO OBVIOUS LEAD-IN LINE

GOOD USE OF LEAD-IN LINE

1.1
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WHY THIS SHOT WORKS

THE HORIZON IS 
PERFECTLY LEVEL
A wonky horizon is the 

easiest mistake to spot 

when looking at a 

landscape, so be sure 

to take a moment to 

correct it. Most tripods 

have a bubble level 

built into the head, but 

many new cameras 

have a virtual horizon 

built-in, so you can 

level up on your LCD 

screen as in the  

image below.

LEAD-IN LINES 
GUIDE THE EYE IN
A bright pathway 

makes for a fantastic 

lead-in line in this 

image, balancing out 

the foreground and 

leading the eye from 

the bottom right corner 

all the way to the focal 

point. There are loads 

of possibilities for 

lead-in lines – paths, 

fence posts, roads,  

a row of flowers. They 

all work brilliantly well.

RULE-OF-THIRDS 
USED TO COMPOSE
A strong landscape 

will have an interesting 

focal point, such as a 

tree or lighthouse, that 

the eye can lock on to. 

Use the rule-of-thirds 

(see panel below left) 

to position your focal 

point a third of the way 

in from the frame edge. 

This will strengthen 

your composition and 

balance the elements 

out for more impact.

When a fantastic scene grabs
you and you feel the urge to
record the landscape on your 
camera, don’t be tempted to 
just take a snap. Take a little 
more time to consider the 
photograph you’re about to 
shoot, and try to work out 
where the various elements will 
fall best. The rule-of-thirds is 
one of the easiest ways to frame 
up a landscape. With the 
lighthouse positioned a third of 
the way in from the top edge, 
the image above has a good 
balance, with the foreground 
taking up the remaining two 
thirds of the frame. The path 
also does a great job of guiding 
the eye to the lighthouse, 
cementing it as the focal point
in this image. Look out for lines
you can use to guide the eye 
into your homework shot, and
unless you’re going for an arty
abstract always make sure the
horizon is perfectly level too!

Above & left Some DSLRs 

have an info button which 

turns on the virtual horizon.
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CORE SKILLS MASTER
YOUR CAMERA SETTINGS
Apart from deciding what you actually want to 

photograph, the settings are the most important  

part of landscape photography. Many cameras offer 

a wide range of choices, but we will be looking at  

a tried and tested selection to help you achieve 

fantastic results every time. The key things to 

consider in landscape photography include 

keeping as much of the scene in focus as possible, 

avoiding introducing camera shake which causes 

blurred photos, and keeping your foreground and 

background exposures balanced. While our settings 

will work 90% of the time, we will also look at ways 

to fine-tune the camera for that 10% when you  

need it to perform slightly differently.

Select aperture-priority mode 
Set your camera to aperture-priority mode, by 

turning the dial usually found on the top of your 

camera to A. This will let you select the optimum 

aperture setting while letting the camera work out 

the perfect shutter speed. By setting the aperture  

to f/16, you ensure yourself a larger depth-of-field 

than a smaller f/number, such as f/5.6, would allow. 

Depth-of-field refers to the area of the image 

which is in focus. The narrower the aperture (or the 

larger the f/number) the more ‘in-focus’ area you will 

achieve. We also set our ISO to 100, which can be 

done by pressing the ISO button on top of your 

camera and using the thumb wheel to scroll through 

the options. ISO refers to the sensitivity of your 

camera’s sensor to light, with the lower numbers 

resulting in better quality but darker images. Don’t 

worry about getting darker images, however, since 

the aperture-priority mode will take this into account. 

With our main settings taken care of, we want to 

ensure we are shooting in JPEG. It’s a file format in 

which the camera applies its own processing, such 

as sharpness and colour corrections, to produce a 

great-looking shot without needing further editing.

Set white balance and scene mode
The last two settings are to do with the colour of  

our scene. The white balance, selected by the WB 

button, tells the camera what kind of light you are 

expecting. Changing this to Auto, which works well 

in natural outdoor light, lets the camera do the hard 

work in deciding how to process our scene. The last 

adjustment is making sure we’ve selected 

Landscape from our Picture Control presets 

(sometimes referred to as Picture Style), which are 

found in the camera’s shooting menu. 

1.2

Above Choosing 

aperture-priority 

will ensure 

sharpness, 

letting the 

camera match 

the shutter 

speed as 

necessary.

TIP
SET UP YOUR
CAMERA ON

A TRIPOD
Using a tripod will allow you

to get pin-sharp images,

even if your camera sets

a very slow shutter

speed.

LARGE DEPTH-OF-FIELD 
F22 / MORE IN FOCUS

SMALL DEPTH-OF-FIELD 
F5.6 / LESS IN FOCUS

f/22 

f/5.6

EXPLAINED PTH ELDDEPTH-OF-FIELD
Depth-of-field is the area of your image that’s in 

focus, which increases with higher f/numbers.
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APERTURE-PRIORITY
Shooting in aperture-

priority allows you

to select a narrow

aperture to increase

the sharpness of

your images.

SELF-TIMER
Self-timer allows you

to tell the camera to

take a photo after

2 seconds, meaning

you don’t move the

camera mid-shot.

JPEG MODE
Your camera applies

slight editing to JPEGs

before outputting,

ensuring you get a

great quality shot.

EXPOSURE
COMPENSATION
The Exposure 

Compensation function 

allows you to fine-tune 

the camera’s in-built 

computations, telling it 

to lighten or darken the 

scene as necessary.

NARROW APERTURE
Selecting a narrower aperture (higher numbers), 

meaning you have a greater depth-of-field, ensures 

you keep larger portions of your image in focus. 

LIVE VIEW
Setting your camera to its Live View 

function will afford you the freedom to 

compose your shots at any angle. Using this 

feature also makes adjusting composition. 

USE THE RIGHT SETTINGS

GET A PERFECT EXPOSURE

Settings are the key ingredient for turning a good image 

into a great image. Here are our suggestions to help you 

get the most from your camera.

Nailing the perfect exposure is the key to great shots. 

Modern cameras do a superb job on this score, 

automatically measuring a scene’s desired exposure, 

but they’re not always accurate. On the top of the 

camera you will find a button, pictured, which is called

Exposure Compensation. Holding this in and using the

thumb wheel will give you figures like +/- 3, which refer

to the amount you are telling the camera to lighten (+) or

darken (-) your scene. Exposure compensation is handy

for those instances when the in-built exposure metering

results in a perfectly exposed sky in the background,

but a very dark foreground. Adjusting the exposure

compensation tells your camera to make fine 

adjustments, allowing you to balance the darker and

lighter parts of your image to get the perfect exposure.

Above & below Using the 

Exposure Compensation

button has saved the 

scene below from being

too dark, bringing back

the details and definition.

SHOOT USING 
SELF-TIMER

One way landscape images fail  

is because of camera movement 

causing blur. To avoid this you can 

either buy a remote shutter release, 

allowing you to activate the shutter 

without touching the camera, or set 

the camera’s built-in self-timer. 

Setting the camera to fire after  

a 2-second delay will give it time  

to settle from any shake added 

when you touched it, resulting  

in pin-sharp images every time.

UNDEREXPOSEDPERFECTLY EXPOSED
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CORE SKILLS FOCUS FOR
PIN-SHARP ACCURACY
Unwanted blur can be an ugly blight on 
an otherwise stunning landscape. It can 
be incredibly disheartening to frame up 
your shot perfectly, check and double-
check all of your settings and then realise 
post-shoot that you accidentally forgot to 
make sure that your shot was actually in 
focus. Ensure your landscape images are 
always pin-sharp throughout by following 
these key tips. 

For the sharpest possible image  
you’ll want to focus one-third up from the 
bottom of the frame. This will give you the 
best chance of getting both the extreme 
foreground and distant background 
sharp. Ensure that your camera isn’t 
switched to Auto Area AF mode, as this 
will automatically select your focus for
you. Your camera is a seriously 
sophisticated piece of equipment, but  
it’s no match for the human eye. Rather
than recognising that you’re shooting 
a landscape, it will instead focus on the 
closest part of the scene, which will be 
the foreground closest to the camera. 
Switch your focus settings to Single-Point 
AF for the best results. 

1.3

Above We’ve focused one-third up from the bottom of the frame to ensure that both the

extreme foreground of the grass and the far background of the church and trees are sharp.

1 Shoot in single-point AF
By selecting Single-Point AF,

you’ll be able to choose exactly which

part of your frame you want in focus.

Changing the AF-area mode on most

Nikon models can be done by pressing

the Info button, then choosing Single-

Point AF, although on more advanced

bodies you’ll need to press the AF/MF

button while turning the finger dial.

2 Select your focus point
When composing, half-pressing

the shutter button shows a small red

box come up in the frame. This is the

focusing point and denotes where the

camera is focusing. Since we’re on

Single-Point AF, we can use the D-pad

to move this red box, allowing us to

choose our own focal point and get the

optimal sharpness from the image.

3 Switch to manual focus
Once focused, you’ll want to 

ensure the camera doesn’t try to 

refocus when pressing the shutter. 

Switching to Manual focus keeps the 

selected point secure. Most Nikon 

lenses offer a ‘M/A - M’ switch on the 

lens-side, with the ‘M’ setting denoting 

Manual focus. If your lens doesn’t have 

this, you can select MF from the menu.

TAKE IMPECCABLY CRISP LANDSCAPE SHOTS

TIP 
USE A LENS

HOOD IN THE SUN
If you’re shooting into the sun 

and struggling to focus, try 

using a lens hood to shield 

the glass of your lens 

from the glare of

the sun.

FOCUS ONE-THIRD
FROM THE BOTTOM

OF THE FRAME
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CHECK YOUR 
SHOTS TO ENSURE
PERFECTION
Is there anything worse than thinking 
you’ve absolutely nailed a shot and then 
getting home and realising that your focus
was ever so slightly out? Double-check 
your shot is perfectly in focus when you’re
on location by following these directions. 

Press the Play button on the back of 
your camera, then zoom in on your image
with the Magnifying Glass buttons and use
the D-pad to navigate around it. Don’t be 
afraid to zoom right in as far as 10x to 
make sure everything is correct. Check  
that each part of the shot is in focus,  
from the background in the far distance  
to the extreme foreground. 

If you don’t want to waste a single  
shot and you’re eager to ensure maximum
sharpness in your image before you press
the shutter button, activate Live View. 
There will be a button (usually Lv) for this 
on the back of your camera. Again, simply
zoom in on your image to check it’s sharp
throughout and take your shot. 

Above Use the Magnifying 

Glass buttons to zoom in 

and out of your images to 

check for maximum 

sharpness.

Left Checking your 

images using the Play 

button is absolutely 

vital for ensuring your 

landscapes are perfectly 

crisp and in focus.

HOMEWORK SUBMIT YOUR 
SHOTS TO GET FEEDBACK

BEFORE YOU UPLOAD...

Your homework this month is to shoot a properly exposed,

well-composed landscape that uses the rule-of-thirds and

lead-in lines, and has a clear focal point. Your shot should be

in focus, sharp across the frame and be totally unedited. As

such, your image should be in colour. Once you’ve completed

your homework, upload it to camera-school.com/mod1land.

If you need to ask a question first, head over to the official

Camera School Facebook page at facebook.com/

ppcameraschool and leave a post on our wall. We’ll get back

to you as quickly as we can! The deadline for this task is  

10 May, so make sure you submit your shots before then.

Good luck, and we look forward to seeing your results!

Q Have you used the recommended settings?

Q Have you composed your shot correctly?

Q Have you exposed your shot correctly?

Q Have you used a narrow aperture setting?

Q Have you focused one-third up the frame?

UPLOAD YOUR SHOT TO CAMERA-SCHOOL.COM/MOD-1-LAN
DEADLINE 10 MAY MARKING BRONZE, SILVER OR GOLD

USE THE RULE-
OF-THIRDS 
Ensure a pleasing 

composition by 

using the rule of 

thirds to place 

your focal point. 

EMPLOY 
LEAD-IN LINES
Search for a 

lead-in line like 

a pathway, road 

or river for a 

balanced shot.

GET THE RIGHT
EXPOSURE
Use the correct

settings in order 

to produce 

a perfectly 

exposed photo.

FREE!
HOMEWORK
TIPS CARDS

ON THIS
ISSUE’S BACK 

COVER
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NIKON AMBASSADOR Q&A
JEREMY WALKER

1.4

QWhat’s the first lesson a new landscape

photographer should learn?

Be prepared, don’t rush, never panic. It sounds

so simple, but fleeting landscape opportunities

can be lost by not having your kit ready. Prepare

your camera bag the night before and leave early

enough so that you can be in position to make the

most of the light. Running around like a headless

chicken looking for a viewpoint when the light is

already perfect will just lead to accidents and

mistakes. Keep your batteries charged and carry

a spare. Download images from your previous

outing and re-format your memory card so that

you don’t have to worry about what images are

on what card. Having to change and check

cards when the light is perfect isn’t ideal.

Q Any rookie mistakes that Camera

School students should look out for?

The biggest rookie mistake is to leave the

camera on Auto and just let the camera decide

what apertures and shutter speeds it’s going to

use. You need to know the basics – the correlation

between a given shutter speed and how changing

it will affect a given aperture and vice versa. The

second biggest rookie mistake is to have the

attitude of ‘I can fix that in Photoshop later’. Learn 

to get it right at the time of taking, as this will make 

life so much easier at the post-production stage. 

More time on location shooting and less time in 

front of a computer has surely got to be better. 

QWhat’s the secret to great composition?

Great composition is usually simple composition. 

There are several ‘rules’ and of these the rule-

of-thirds is probably the best known. If you’re an 

absolute beginner then by all means refer to one of 

these rules, but only as a guideline – they’re not 

written in stone. By keeping your image simple and 

uncluttered it’ll be a more striking shot, but you 

have to have the courage of your conviction, 

compose the image how you see and like it, and 

not conform to other peoples’ stereotypes.

QWhat’s the best piece of landscape

photography advice you’ve ever been given?

Possibly the best landscape tip I’ve ever been 

given – via a book – was from the great American 

landscape photographer Ansel Adams, who 

believed you should visualise the finished print on 

the wall before you even take the camera out of the 

bag. I think he’s right, as far too many people these 

Jeremy
Walker
An award-winning 

photographer with 

over 20 years’ 

experience, 

Jeremy’s scenic 

and architectural 

images have been 

used by advertising, 

editorial and design 

clients around the 

world. He also 

leads workshops in 

Iceland, Scotland 

and Dorset for all 

levels of ability. 

ONE OF THE UK’S BEST LANDSCAPE PROS 
SHARES HIS ZEN-LIKE WISDOM & ADVICE...



JOIN THE PROS ISLE OF SKYE
Details: “The ultimate learning experience for landscape enthusiasts

will take you to some of the most awe-inspiring landscapes the island

has to offer, where you will be helped and advised by award-winning  

pro Jeremy Walker.”

Date: 3 May 2017 Location: Isle of Skye 

THE ART OF FILTER PHOTOGRAPHY CITYSCAPES 
Details: “This workshop is a great opportunity to learn how to shoot 

creative images using a range of photographic filters such as ND grads 

and Big Stoppers.”

Date: 15 June 2017 Location: London 

THE ART OF FILTER PHOTOGRAPHY SEASCAPES 
Details: “Broaden your skillset when using filters, especially for very long 

exposures, using Big and Super Stoppers. We’ll also show you how and 

when to use hard or soft ND grads alongside other filters.”

Date: 23 June 2017 Location: Brighton 

JOIN THE PROS DORSET 
Details: “This one-day workshop with Jeremy Walker will take you to 

various locations, including the stunningly situated Corfe Castle, the 

beautifully calm Swanage Bay and the dramatic Durdle Door.”

Date: 21 October 2017 Location: Dorset 

JOIN THE PROS CORNWALL 
Details: “Join two of the UK’s leading landscape 

photographers – Ross Hoddinott and Adam Burton – 

for a 3-day Nikon School residential workshop in 

stunningly beautiful and photogenic West 

Cornwall.”

Date: 15 November 2017 Location: Cornwall 

Visit nikon.co.uk for more info. 
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days will shoot in poor light with poor composition

and then fiddle around in Photoshop until they have

something half decent. When I was an assistant after 

my art college years I worked for a technically savvy 

advertising photographer who taught me about light. 

Although this was in a studio, the principles are true 

whatever the subject and location – understanding 

light is key to a great shot, landscape or otherwise.

Q�What’s your favourite camera/
lens combo for landscapes? 
My go to combo for most things, 

not just landscape work, is the 

Nikon D810 with AF-S Nikkor 

24-70mm f/2.8E ED VR zoom.

Optically the lens is superb and

its focal length range is 

very versatile. Coupled 

with the dynamic range

and pixel count of the

D810, I think it’s the

perfect combination

for a lot of shooting

situations. If I had to

shoot landscapes with

a prime, I plump for

the Nikkor 45mm

PC-E. This lens has

tilt & shift capabilities,

but also has a handy

close focus/macro

facility. 

Above Simplicity is the key to great composition, 

so try to keep your images clean and uncluttered.

Left Understanding light and being able to make the 

most of it is hugely important, regardless of subject.

IMPROVE YOUR LANDSCAPES 
AT NIKON SCHOOL! 
Nikon School is a venue for photography training that aims to 

educate and inspire photographers. Workshops cater for every 

level of ability, whether you’re new to taking photographs, a keen 

amateur or a professional. We offer a wide range of workshops 

suited to individuals wanting to learn more about photography 

or expand their creative horizons. You’ll improve your skills, 

develop your eye and learn to take control of your camera. 

Nikon School workshops are a mix of easy-to-understand 

theory and hands-on practical assignments. We have small 

groups of up to 12 delegates to ensure everyone can benefit 

from our expert tutors’ knowledge. From understanding your 

DSLR and lenses to image editing, our workshops cover a 

variety of skills and subjects. Nikon School workshops take 

place either at the Nikon Centre of Excellence in London or on 

location – check out these landscape photography courses…



PAULS EVENTS

WALES WEEKEND
An elegant 18th century mansion house estate in Carmarthenshire is the setting for

this event. Includes diverse locations such as beautifully furnished interiors, walled

gardens, parkland, river and woodlands. Studio lighting will also be set up for use both

inside and out. Accommodation and home-cooked meals are included.

Fri 12th - Sun 14th May 2017

Fri 14th - Sun 16th July 2017

Fri 1st - Sun 3rd September 2017

MANOR HOUSE EVENT
Spend the day in a beautiful Grade II listed Jacobean manor house, complete with

VSOHQGLG IXUQLVKHG URRPV DQG ZLWK DQ DEXQGDQFH RI QDWXUDO OLJKW ÀRRGLQJ LQWR WKHVH

contemporary decorated rooms. The manor house is set in 25 ares of classical

gardens and parkland, including ornamental lake. Conveniently located in Berkshire 

close to M4 motorway and train stations.

Sat 4th March 2017 & Sat 11th November 2017

Spend an inspirational and creative weekend developing your skills in classic and

art nude photography hosted by one of the UK’s foremost teachers of this genre and

supported by only the best models.

Learn how to create beautiful nude images others will admire by effective and creative

use of studio and natural lighting, working with and directing models, planning and

using locations effectively seeing the light (and the image) and much much more

This event will be the perfect mix of expert tuition and practical assignments, meaning

QRW RQO\ ZLOO WKLV EH DQ HQMR\DEOH H[SHULHQFH LW ZLOO DOVR EH KXJHO\ EHQH¿FLDO WR DQ\RQH

starting out in artistic nude photography or those looking to develop their existing skills

or learn some new techniques

Fri 14th - Sun 16th July 2017

LIGHTING THE NUDE - WEEKEND WORKSHOP
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Fujifilm GFX 50S
We find out if Fuji’s much

anticipated 51.4MP, 14-stop

dynamic range, medium-format

monster lives up to the hype.

136
Canon 800D
With a 24.4MP sensor

but lower price, is the 800D the

value alternative to the 80D?
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the latest gear, including

Affinity’s Photo Editor and

the Spyder5 monitor
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A true one
of a kind

F
UJIFILM SEEMS
to be on quite the
mission lately,
having refreshed the

majority of its mirrorless
camera range in the past 12
months. Now it’s turning its
attention towards an even
bigger prize. The GFX 50S is
Fuji’s first medium-format
release since 2008’s GF670.
It’s also the world’s first
mirrorless medium-format.
This hotly anticipated
camera won’t stand alone
for long though, as it will
shortly go toe-to-toe with

the Hasselblad X1D. So
how does it stack up?

Main features
The GFX 50S houses a
massive 43.8x32.9mm 51.4MP
sensor and costs under £6200
body-only, which makes it
extremely attainable for
medium-format. Under the
hood, an X-Processor Pro
processor works overtime
to capture the mammoth
116MB RAW files, packed
with an astonishing 14-stop
dynamic range. The camera
sports Fuji’s trademark

retro styling, though
the angular body
is more evocative
of an ’80s sports
car and not quite as
pretty or refined as
its contemporaries.
The ISO, which has its
own dedicated dial, ranges
from 100-12,800 and images
appear very useable right up
to the highest settings. The
vast array of customisable
function buttons are
welcome, and the controls
are well laid out. It has the
same applauded thumb stick

4 Top-plate LCD
The 1.8in, top-plate 

monitor is customisable and 

allows eight functions to 

be viewed at once, such as 

shutter speed or battery life.

1

2

3
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FUJIFILM GFX 50S

2 EVF
The detachable EVF

boasts a stunning 3.69m-dot

resolution, 100% coverage and

0.85x magnification with very

little noticeable lag, and still

allows hotshoe devices to be

connected to its top-plate.

3 G series lenses
Fuji is introducing a

new range of G series lenses.

Currently comprising three

lenses, the line-up includes

the razor-sharp 63mm f/2.8 R

WR, which really impresses.

1 51.4MP sensor
The massive 51.4MP

sensor, which measures a

hefty 43.8x32.9mm, has been

fine-tuned by Fuji technicians

to produce some of the most

exceptional image detail to date.

PRICE
£6199
VIDEO

Full HD
IMAGE RESOLUTION

51.4MP

4

GetIntoGear



as the X-T2, which can be
used to select focus points for
quick and intuitive control.

While many comparisons
may be made to the similarly
priced Pentax 645Z, it’s the
finer details which really set
this Fuji apart. The GFX 50S
uses what Fujifilm calls an
‘exclusive’ 51.4MP sensor. Yes,
it’s been manufactured by a
third-party sensor specialist
– the same company that
produces all the medium-
format sensors on the market
– but Fuji has engineered
some very clever behind-
the-scenes tweaks to get the
most from it. These subtle
changes give it significantly
better image quality than 
similarly specced competitors 
around the same price point.

The high megapixel count,
as well as the 1.7x increase
in sensor size over a 35mm
camera, means the 50S is 
capable of capturing some 
extremely impressive detail.
Aided by the exclusion of 
an anti-aliasing filter, the 
images display exceptional
sharpness, even zoomed in
at 100%, capturing fine hairs
and pores with pin-sharp 

precision. The increased
sensor size also offers a much
shallower depth-of-field when
compared to full-frame and 
APS-C cameras, with the 
out-of-focus areas producing 
some breathtakingly 
beautiful bokeh. 

A Full HD movie mode is 
present, although the GFX 
50S isn’t really designed as a 
video camera and there are 
better offerings out there 
for those who take their 
videography seriously. The 
touchscreen allows the usual 
push-to-focus and swipe-
to-view functions, as well 
as allowing you to swipe up 

to check your histograms,
and it’s very responsive.

Fuji’s famous film
simulation modes have
also made the step up to
medium-format, with the
usual suspects in the 15
options available (such as
Velvia, Astia and Provia), but
now with the addition of a
black & white Acros mode.

Handling & build
Current Fuji users will find 
everything instantly familiar, 
as the camera has similar 
ergonomics to the rest of the 
Fuji range. Equally, anyone 
used to operating a DSLR 
will feel at home very quickly. 
The camera’s angular body 
hides a magnesium alloy 
re-enforced chassis, with 58 
weather-sealed points, and a 
classic textured plastic finish. 

The GFX weighs in at a 
very light 825g body-only 

(or 920g with the included
EVF attached to the
hotshoe), which is about
the same as a Canon 5D 
MkIV. The pronounced 
handgrip is perfectly
moulded and makes it feel 
extremely secure to hold. 

The rear monitor is a 
3.2in, 2360k-dot three-way 
tilting LCD touchscreen, and 
is one of the best displays 
on the market. The detail 
and colour rendition is 
super, and the inclusion 
of the touch compatibility 
makes focusing via the 
rear screen very simple. 

The 10 user-definable Fn 
buttons are laid out across 
the camera and give you 
the level of customisation 
you’d expect from a Fuji 
body. The top-plate contains 
the 1.28in, monochrome 
Sub Monitor LCD, which is 
customisable and displays 
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The colossal 51.4MP sensor offers 

almost unparalleled image resolution, 

producing sharpness and detail even at 

tight crops. This image was shot at ISO 

100, and zooming in by 6x shows you just 

how clear and useable the image 

th the large photosites 

aining a huge amount 

f information. Zooming 

n to 800% (inset) 

shows us that there is  

a limit to the resolution, 

but the clarity in 

comparison to a lot of 

ll-frame or APS-C 

meras is still incredibly 

p sive.

Impressive
image resolution

CAMER A TEST

“THE GFX 50S’S IMAGES
ARE EXCEPTIONALLY SHARP 
THROUGHOUT, EVEN WHEN 
ZOOMED IN AT 100%”

Having a medium-format sensor, which is 1.7x larger than a 

typical 35mm sensor, means that the GFX 50S can capture 

more detail than full-frame cameras. Each photosite is 5.3μm 

(micrometres), which is bigger than the Canon 5DS’s 4.13μm. 

This means that although the megapixel count is similar, 

each pixel is capable of gathering more information to give 

you a sharper and more detailed output. One of the positives 

of bigger sensors is the ability to capture much larger file 

data, so drastically cropping into your image will give you 

very useable results without sacrificing image quality. 

Tech Focus
  43.8mm sensor  

IMAGE 
QUALITY

6X ZOOM
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eight items, including shutter 
speed, battery life and ISO. 

The 63mm f/2.8 lens, one 
of the three optics currently 
in the G series, is a beautiful 
companion. It’s a 50mm 
equivalent by full-frame
standards, with pin-sharp 
optics, and is rated to easily 

capture resolution up to 
100MP, meaning it should 
support future generations 
of Fuji medium-format.

Performance
A great addition to the GFX 
50S are the C/T controls, 
which make it easier to 

change key settings. Turning 
the lens aperture or ISO dial 
to C, or the shutter speed 
dial to T, allows you full 
control from the thumb dials, 
meaning you can alter the 
settings quickly and without 
having to adjust in full stops. 

The 51.4MP resolution is 

exceptional, capturing fine 
details even when cropped 
in at the EVF’s maximum 
16.7x zoom. And the ISO is 
absolutely phenomenal, with 
ISO 12,800 being incredibly 
workable and suffering 
surprisingly little in colour 
degradation. Stepping up 
to the expanded range, 
ISO 25,600 is still useable,

ith minimal colour issues
nd very impressive detail
tained. Even the noise

attern is refined. At ISO
,200, there is some image

egradation present, with
harpness suffering and

lours beginning to lose
eir vibrancy. Reach ISO
2,400 and the clarity 
ops, rendering images
uch less useable.
Compared to a DSLR,

e possible 425 contrast AF
oints aren’t the quickest,

suffering most in bad light, 
although they do perform 
well against other medium-
format cameras. The manual 
focus assist and peaking mode 
have never looked better, 
thanks to the 100% coverage 

Hasselblad X1D £7788 

Another highly anticipated medium-format 

heavyweight, Hasselblad’s first mirrorless 

camera boasts a 50MP CMOS sensor and 

ISO 100-25,600, and claims up to an amazing  

14 stops of dynamic range. It will also sport  

a 940k-dot TFT touchscreen, 1/2000sec to  

60-minute shutter and Wi-Fi connectivity.

hasselblad.com

In a league of t

Pentax 645Z £6599 

The three-year-old Pentax also boasts a 

43.8x32.8mm, 51.4MP CMOS sensor, as well 

as a 27 cross-point AF and a tiltable, 3.2in 

1.037m-dot LCD. The 645 boasts a whopping 

ISO range of 100-204,800 and a much larger 

array of lenses. Though it may be a slightly 

more veteran offering, it is still highly praised 

for its image quality. ricoh-imaging.co.uk

ALSO  
CONSIDER

THESE

6

5 3.2in 
touchscreen

The three-angle, 

2360k-dot, 3.2in tilting 

LCD boasts touch 

functionality and 

looks beautiful when 

shooting in Live View or 

reviewing your images. 

The touch operation 

works well and the 

images are vibrant, with 

great colour rendition 

being displayed. 

6 Focus lever
The focus lever 

thumb stick is identical 

to that on the X-T2, 

and is a very welcome 

inclusion. It offers quick 

and intuitive focus 

selection for fine-tuning 

while shooting, and 

can be locked to avoid 

accidentally moving 

your focus point. 



of the detachable 0.85x
magnified, 0.69m-dot EVF.

The battery life is rated at
400 shots per charge. This
isn’t a massive improvement
over other mirrorless cameras
on paper, but in testing it
managed over 500 shots.
The mechanical shutter
retains Fuij’s 1/4000sec limit,
but the electronic shutter
is lower, with a top speed
of 1/16,000sec, compared
to Fuji’s usual 1/32,000sec
maximum. The mechanical
shutter works well, though
there’s noticeable shutter-lag,
which makes it a challenge
to shoot moving subjects.
However, the electronic
shutter is prone to severe
rolling shutter distortion,
showing up quite badly with
the slightest movement.
Hopefully, since it’s a sensor
issue, it will be an easy
firmware fix. Fortunately, the
electronic sensor issues won’t
bother most users, as very few
will be using this camera for
fast action shooting. Where
the electronic sensor can be
useful is for silent shooting,

especially given that there’s no
leaf shutter built into the lens.

The button layout is
mostly logical and ergonomic,
although the playback and
delete buttons, and the
focus selector switch, are all
awkwardly placed. Though
accessible, they are fiddly
to use at the same time as
shooting and we would
definitely like to see these
changed in a future release.

Verdict
Sporting absolutely
astounding image quality, a
phenomenally lightweight
and portable body, and
exceptional ISO range, the
GFX 50S excels and sets an
extremely high standard for
mirrorless medium-format

cameras to follow. The current
range of three G series lenses
all offer fantastic quality and
pin-sharp results, and the
3.2in touchscreen displays
images with exceptional
quality. While there is no
doubt that the GFX 50S marks
a turning point in medium-
format photography, the
electronic shutter currently
causes severe distortions,
though hopefully this is a
simple firmware fix. The
AF, though on a par with
other digital medium-format
cameras, is still a long way
from DSLR and CSC offerings.

However, despite a couple
of minor flaws, it’s hard to
argue with results, and the
images speak for themselves.
At £6199 for the GFX 50S
body, it’s still cheaper than
the older Pentax 645Z and
over £1500 less than the
upcoming Hasselblad X1D.
If you’re looking to make the
step up to medium-format,
the Fuji GFX 50S is easily our
current market favourite.

The near-unrivalled 14 stops of dynamic

range is exceptional, dealing with the

present shadows and highlights extremely

efficiently. The paired GF63mm f/2.8 R WR

lens is astonishingly sharp, helping to

capture the minutest of details and

allowing you to get the most out of the

stunning sensor. As you can see, this

image shows a very overcast scene, with

barely any detail being visible in the sky on

the day. However, the monstrous dynamic

range has given us a lot of ability to recover

the highlights in Lightroom, bringing back

texture to our shot. Likewise, when the

sun is creating tough conditions, such as

contrast in the scene, those 14 stops give

you a lot of freedom. Running the RAW files

through Lightroom or Photoshop allows

you to even out the tones like never before.

Amazing 14-stop
dynamic range

TECH SPEC
Camera: Fujifilm GFX 50S

Lens: GF63mm f/2.8 R WR

Price: £6199

Effective resolution: 51.4MP

Sensor: 43.8x32.9mm

Processor: X-Processor Pro

LCD: 3.2in 2360k-dot tilting

touchscreen

Shutter: 1/4000sec-60min

Autofocus: 425-point

contrast-detect

ISO: 100-12,800

(expands to 50-102,400)

Shooting speed: 3fps for

13 RAWs or unlimited JPEGs

(electronic), 1.8fps for

8 RAWs or unlimited JPEGs

(mechanical)

Video: Full HD at 30fps

Pop-up flash: No

Other features: 15 film

simulation modes, grain

simulation, interval timer

Battery life: 400 shots

Card type: SD, SDHC, SDXC

Size (WxHxD): 148x94x91mm

Weight: 1325g

Web: fujifilm.eu/uk

PROS Image quality ISO performance

Handling Lightweight Menu features

Fn customisation Touchscreen

CONS Electronic shutter distortion

Slow AF Shutter lag

FEATURES

HANDLING

OVERALL SCORE

IMAGE QUALITY

VALUE FOR MONEY

THE VERDICT
FUJIFILM GFX 50S

IMAGE
QUALITY

PRACTICALPHOTOGRAPHY.COM

CAMER A TEST

“AT ISO 25,600 IMAGES  
ARE INCREDIBLY CLEAN  
& THE LEVEL OF DETAIL 
RETAINED IS ASTONISHING”
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Perfect
beginnings

I
N 2015 CANON
released the 750D
and 760D, two upper 
entry-level cameras that 

were essentially identical in 
both internal spec and price. 
It was only when you looked 
at the bodies themselves 
that it became clear that 
the 750D, with simpler 
controls and fewer dials, 
was designed with a less 
experienced user in mind. 
Now Canon has replicated 
this template with the new 
800D and 77D, and it’s the 
800D that’s aimed at upper 

entry-level users who have
never touched a DSLR.

Main features
While the new 800D has 
the same 24.2MP count as 
its previous version, the 
750D, it actually boasts the 
same APS-C sensor as the 
80D, released just under 
a year ago. However, the 
sensor has now been paired 
with a DIGIC 7 engine, 
which can process data at 
an impressive 14x faster 
than the 80D’s DIGIC 6. 

Like the 77D, the 800D 

has 45-point Duel
Pixel AF, which is a
noticeable step up fro
the 750D’s 19-point
system. Not only does
this give a refreshingl
snappy autofocus – as f
as 0.03sec when using t
viewfinder – but it also
means that focusing in
light conditions is a bre
This improved AF syst
makes a real difference
when shooting fast-paced
subjects like sports, wildlife,
children and pets.

Also great for fast-action

GetIntoGear

3 Intuitive menu system
The brand new User Guide Mode that

comes as the default setting on the 800D 

makes it a true learn-as-you-go experience 

that’s perfect for beginners. 

1 18-55mm lens
This impressive kit lens was released at 

the same time as the 800D and 77D. It features 

continuous AF during video recording and  

a vastly improved manual focus ring. 

2 Vari-angle touchscreen
This is perfect for shooting  

at unusual angles, while the touchscreen 

works perfectly with the new menu system. 

4 p g
The 800D has a very

uncomplicated design, with

one mode dial at the top of

the camera and a clean, 

uncluttered back. 

4

KIT PRICE 
£869

IMAGE RESOLUTION 
24.2MP

VIDEO
FULL HD

1

3

2



photography is the 800D’s
6fps continuous shooting
speed, which is rated for
27 consecutive RAWs and 
unlimited JPEGs, although 
we found that it slowed 
after 95 JPEGs. This is a 
definite improvement from 
the 750D’s 5fps and puts 
it ahead of Nikon’s D5600 
and on a par with the 
more advanced D7200. 

The optical viewfinder in 
the 800D uses a pentamirror 
design that allows you 
to view 95% of the scene 
when composing your shot, 
which means that you will 
have to be careful not to 
get any unwanted clutter 
at the sides of your frame. 

Handling & build
One of the most unique 
aspects of the 800D is its 
User Guide Mode. With a 
cleanly-designed and intuitive
interface, this is an interesting
alternative to the traditional
Canon menu found on its 
other DSLRs. The graphics
give practical and easy-to-
understand instructions on
the basic aspects of using the
camera, such as aperture and

shutter speed. You can switch
to the normal menu as well,
but the User Guide Mode is
the default, cementing the 
800D’s status as a camera 
designed to give beginners the 
extra support they may need. 

It does lack a secondary 
LCD screen at the top, which 
may feel jarring to more 
experienced camera users, 
but the simpler design would 
benefit a beginner who 
may feel overwhelmed by 
an overly cluttered body.

Performance
The vari-angle screen 
paired with Full HD video 

means that this camera is
a strong contender for young
millennials who are interested 
in experimenting with video 
or starting a YouTube channel. 
One unfortunate drawback 
is that there’s no 4K option, 
which is a shame considering 
that this is fast becoming an 
industry standard. To add to 
this, there’s also a mic port but 
no headphone port. So while 
a solid introductory camera 
for video, the 800D won’t 
suit serious videographers. 

The 800D retains Wi-Fi 
and NFC functionality, and 
adds to the mix a low energy 
Bluetooth connection. This 
enables you to remotely 
‘wake’ the camera (so long as 
it’s not fully turned off), as 
well as operate it from your 
smart device and browse 
through your photos.

Battery life has seen a 
massive improvement from 

the 750D’s 440 shots per
charge, with the 800D
offering a pleasing 600 shots. 
However, this does drop 
down to 270 if you’re solely 
working in Live View. 

Verdict 
With so little difference in the 
internal spec of the 800D and 
77D, they’re separated only by 
handling. If you’re a slightly 
more experienced user after a 
more pro-looking DSLR with 
a similar button layout to the 
80D, then it may be worth 
investing the extra £50 for 
the 77D. If you’re a beginner 
looking to learn the ropes, 
then the 800D’s uncluttered 
design and intuitive default 
menu system will support you 
each step of the way. All in all, 
this is a great camera with a 
solid sensor, new processor 
and a freshly designed 
compact lens. Recommended. 
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Performing well in low light  
is a rigorous test of any 
camera’s mettle, but the  
800D fares pleasantly well in 
dark conditions. This image  
was shot at ISO 3200 and  
the minimal amount of noise  
is more than respectable.  
If you’re in a bit of a pinch you 
could push the ISO up to 6400, 
but this is where image quality 
does start to suffer. There’s no 
frustration over an excruciatingly 
slow autofocus with the 800D, 
as the Duel Pixel AF works  
well even in very low  
light conditions. 

Low light
quality

When Canon released the 800D and 77D,
it also announced the brand new EF-S 18-55mm 
f/3.5-5.6 IS STM lens. This nifty piece of kit is 
image stabilised and the smallest non-retractable 
DSLR lens on the market, so when paired with the 
800D it feels pleasantly light in the hand. Canon 
has re-hauled the AF system by replacing the old 
AF motor with a stepping motor which is much 
quieter. It also boasts continuous AF during video 
recording with compatible cameras. 

Tech Focus
  18-55mm kit lens  

IMAGE 
QUALITY

FIRST LOOK

“THE 800D IS A STRONG 
CONTENDER FOR 
MILLENNIALS INTERESTED IN 
SHOOTING FOR YOUTUBE...”
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under £1500

10
OF THE
BEST
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Travel photography – with its alluring
promise of exotic lands, different 
cultures and tropical vistas – used to 
be the preserve of the professionals, 
as they were the only photographers 
with the time, funds and gear 
necessary to capture the best images 
at the world’s best locations. 

But now, thanks to cheaper airfares 
and more keenly priced kit, great travel 
images are within reach of all of us. 
And it’s mirrorless cameras and lenses 
that sit right at the top of the packing 
list, as their capabilities now equal 
those of DSLRs, making them great 
compact and low-weight alternatives 
to their chunkier cousins.

Let’s check out the 10 best 
mirrorless travel lenses under £1500...

Panasonic 14-42mm f/3.5-5.6 II ASPH £279 P141
Sigma 30mm f/1.4 DC DN | C £269 P144
Tamron 14-150mm f/3.5-5.8 Di III £439 P140
Tamron 18-200mm f/3.5-6.3 Di III VC £339 P143
Samyang 8mm f/2.8 UMC Fisheye II £239 P141
Canon EF-M 18-150mm f/3.5-6.3 IS STM £399 P144
Canon EF-M 11-22mm f/4-5.6 IS STM £319 P140
Olympus M.Zuiko ED 40-150mm f/2.8 Pro £1199 P142
Fujifilm XF 18-135mm f/3.5-5.6 R LM OIS £619 P142
Fujifilm XF 27mm f/2.8 £329 P143

IN THE TEST

IMAGE SHARPNESS
Each lens was tested
in identical controlled 
conditions to ensure 
consistent results. We 
thoroughly examined  
each image to judge the 
sharpness of the corners  
at all apertures.

IMAGE DEFECTS
We also examined the test 
images to look for defects, such as 
vignetting and chromatic aberration (also 
called fringing), as well as lens distortions such as 
pincushioning or barrel distortion, which can warp detail.

HOW WE TESTED 
THE LENSES

MIRRORLESS LENSES UNDER £1500
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Micro Four Thirds users have a

large selection of lenses at their

disposal, given that they can use

both Panasonic and Olympus glass.

But the Tamron 14-150mm f/3.5-5.8

is a great alternative. With a 35mm

equivalent of 28-300mm, this 285g

lens is very portable and capable of

capturing a wide range of scenes,

from landscape to wildlife.

Despite its compact 8cm length

(13cm when fully zoomed), the

Tamron packs 17 elements in

13 groups, including Low Dispersion

(LD), and aspherical elements to

combat chromatic aberration.

As with the other Tamron

here, there’s a lock switch to

ensure no unwanted lens barrel 

creep, though Vibration Control 

is lacking. This won’t bother 

Olympus users, as they have 

built-in image stabilisation, but 

some Panasonic bodies don’t.

Images suffer very noticeably

from soft corners and chromatic

aberration at the widest aperture.

Vignetting is also quite pronounced

wide open, creating a darker area

around the edge of the image.

PROS
Zoom range
Weight
Lock switch 

CONS
No image 

stabilisation
Soft corners
Chromatic 

aberration

RATING

Above The lock switch stops
unwanted extension in transit.

SPEC
Minimum  
aperture: f/22
Elements: 17/13
Filter size: 52mm
Minimum focus 
distance: 50cm
DxL: 64x80mm
Weight: 285g

TAMRON

14-150MM F/3.5-5.8
DI III £439

#9

Above The long 
zoom range offers a 
35mm equivalent of 
28-300mm to cover 

any style of shot.

GetIntoGear

While Canon’s 18-150mm offering

gives a colossal zoom range, this

18-35mm equivalent is the perfect

choice if you’re concentrating on

landscapes. The f/4-5.6 aperture

means sharp results at the heart

of your image and the ultra-wide,

92° field-of-view ensures you

have the scope to capture some

stunning views. At just 5.8cm long

and 220g in weight, the lens is also

compact and won’t significantly

eat into your luggage allowance.

The 12 elements in 9 groups

offer up 7 rounded diaphragm

blades to capture great bokeh,

and the 15cm minimum focusing

distance means you can get very

close to your subject. The 3 stops

of image stabilisation also give you

assurance that you can use this 

lens handheld in low light conditions

without risking motion blur. 

Though wider apertures cause

slight corner blur, sharpness is

impressive across the whole

frame. At its widest focal length,

there is very noticeably barrel

distortion, which is quite severe

when shooting closer subjects.

PROS
Wide angle
Size
Image 

stabilisation 

CONS
Limited range 
Barrel distortion
Corner blur

RATING

Above The compact size makes this 
a perfect lens for those packing light.

SPEC
Minimum  
aperture: f/22-32
Elements: 12/9 
Filter size: 55mm
Minimum focus 
distance: 15cm
DxL: 61x58mm
Weight: 220g

CANON

EF-M 11-22MM F/4-5.6
IS STM £319

#10

Above The locking 
switch means that 
you won’t have to 
worry about lens 
creep in transit.

FUJI X

MICRO 4/3
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Samyang’s fisheye is the cheapest

lens here, and it’s perfect for getting

creative on your travels. The 12mm

equivalent focal length produces

a whopping 180° diagonal field-

of-view on a cropped mirrorless 

sensor, and the image fills the frame

corner to corner instead of in a 

circular shape. The 30cm minimum

focusing distance means you can

get relatively close to your subjects

to create some interesting effects,

or use it to create stunningly wide

landscapes of your destination.

The lens is light, at 290g, and

extremely compact for shooting

incognito. It comprises 11 elements

in 8 groups, with 2 aspherical and

3 Extra-low Dispersion elements to

combat lens distortion and chromatic

aberration, which it does well. 

Focusing can be tricky as the lens 

has no autofocus capability, although

the depth-of-field is very large, 

which makes this easier. Central 

sharpness is brilliant throughout, 

though corners don’t become 

perfectly sharp until f/5.6. Chromatic

aberration is also a concern, but 

any fringing is barely noticeable. 

RATING

Above The aperture and focus rings 

are very smooth to operate.

SPEC
Minimum

aperture: f/22

Elements: 11/8

Filter size: N/A

Minimum focus 

distance: 30cm

DxL: 60x65mm

Weight: 290g

SA M YA NG

8MM F/2.8 UMC 
FISHEYE II £239

#7

Above The Samyang 

features a fixed lens 

hood, to ensure 

ghosting and flare 

are kept at bay.

PROS
Lightweight

Wide

field-of-view

Wide aperture 

CONS
Hard to focus 

Manual only

Limited uses

Panasonic’s 14-42mm pancake lens

(28-84mm equivalent) offers a

perfect zoom range for travel.

At a very compact 2.7cm in length,

its diminutive size makes it a very

covert lens which takes up little

space in your kit bag. The 110g 

weight gives this a very lightweight

and balanced feel, which lessens

the effect of motion blur at longer

focal lengths. 

The f/3.5-5.6 variable aperture

offers some impressive sharpness,

and the unassuming nature means

you can blend in with the tourists to

capture some great close-up shots.

The inclusion of Panasonic’s image

stabilisation gives you up to 3 stops,

which lets you work at longer 

shutter speeds or with less light. 

There are switches on the barrel

to control zoom and focus, and 

while the electronic zoom may feel a

bit unintuitive, both switches work

well. Images are very sharp at the

centre, though there is some minor

blurring in the corners and obvious

vignetting. At 14mm there is

noticeable pin-cushion distortion,

though it can be corrected in post.

PROS
Size

Price

Stabilisation

CONS
Limited range

Pin-cushion

distortion

Unintuitive 

zoom

RATING

Above This tiny pancake lens lets you 

shoot without drawing attention. 

SPEC
Minimum  

aperture: f/22

Elements: 9/8

Filter size: 46mm

Minimum focus 

distance: 20cm

DxL: 56x49mm

Weight: 110g

PA NASONIC

G VARIO 14-42MM 
F/3.5-5.6 II ASPH £279

#8

Above Zoom and 

focus can be 

controlled directly 

from the side of the 

lens via switches. 

MIRRORLESS LENSES UNDER £1500

MICRO 4/3 FUJI XSONY E
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The Micro Four Thirds-fit Olympus

40-150mm offers an astonishing

80-300mm equivalent focal length,

making it the longest lens in test.

The 16 elements in 10 groups

include Extra-low Dispersion 

elements to combat chromatic 

aberration, as well as 2 aspherical

elements to control optical 

imperfections. The wide, fixed 

f/2.8 aperture gives you great 

low-light potential, as well as the

9 circular diaphragm blades to

allow for natural background blur.

With its large zoom range, 

this lens is suited to portraits or

wildlife, and weather-sealing allows

you to use it on rainy days on the

beach. However, at 16cm long and

880g with the tripod collar, this is 

the largest and heaviest lens in 

test and lacks the portability of 

others, although it is still compact

compared to its DSLR counterparts.

As you’d expect at this price, 

sharpness is extremely good, even

in the corners at f/2.8. Chromatic

aberration and vignetting are well

controlled at all apertures and barrel

distortion is practically non-existent.

PROS
Zoom range
Weather-sealing
Wide aperture 

CONS
Price 
Weight
Size

RATING

Above The tripod collar opens up 
more shooting possibilities.

SPEC
Minimum  
aperture: f/22
Elements: 16/10 
Filter size: 72mm
Minimum focus 
distance: 70cm
DxL: 79x160mm
Weight: 880g

OLYMPUS

M.ZUIKO ED 40-150MM 
F/2.8 PRO £1199

#5

Above The 
impressive 

40-150mm focal 
length is 80-300mm 

by 35mm standards.

With Fuji making waves with its

stream of new mirrorless releases,

its lenses are equally renowned.

The 18-135mm offers a huge

27-206mm 35mm equivalent,

with a widest aperture of f/3.5.

The 490g weight and 9.8cm length

(extending to 16cm) make this

a relatively big lens, though the

range from landscape to portrait

means it has a lot to offer.

The weather-resistant body

holds 16 elements in 12 groups,

including 4 aspherical and 2

anomalous dispersion lenses to

combat distortion, while the 7

rounded diaphragm blades offer

great bokeh in out-of-focus areas.

The internal focusing motor creates

AF speeds of 0.1sec and the 5-stop

image stabilisation ensures great 

results handheld.  

Sharpness is good either end 

of the zoom, but corner fall-off 

is noticeable. Mid-range image 

quality is great, with respectable 

sharpness corner to corner. At

wider angles there is minimal

barrel-distortion, though Fuji

attempts to correct this in-camera.

PROS
Zoom range
Image

stabilisation
Fast AF 

CONS
Size 
Weight
Price

RATING

Above Aperture can be switched from  
manual to automatic via the lens.

SPEC
Minimum  
aperture: f/22
Elements: 16/12 
Filter size: 67mm
Minimum focus 
distance: 45cm
DxL: 76x98mm
Weight: 490g

FUJIFILM

XF 18-135MM F/3.5-5.6
R LM OIS WR £619

#6

Above 5 stops of 
image stabilisation 

make this an 
exceptional lens for 
handheld shooting.

GetIntoGear
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Very similar to the lens on the well

received Fuji X100F, this 27mm

pancake lens is a great all-round

prime. The 41mm equivalent focal

length is suited to everything from

landscapes to street photography,

and Fuji has kept the weight 

down to a minute 78g, thanks 

in part to excluding a manual 

aperture ring on the body. 

The tiny 2.3cm body houses

7 elements in 5 groups, even 

including an aspherical element.

The autofocus is extremely fast and

accurate, even in low light. With

a fixed focal length, the lens isn’t

hugely versatile, and not suited to

portraits, wildlife or landscapes. 

However, it’s a good all-round focal

length for travel, giving a similar 

angle-of-view as an iPhone. It’s also

very small so you can blend into 

the crowd for stealthy shooting.

Image quality is fantastic,

as you’d expect from a prime

lens. The centre of the image

is extremely sharp and corners

suffer very little blur at the widest

aperture. There is slight vignetting

present, though nothing severe.

PROS
Incredibly sharp
Size
Wide aperture

CONS
Minimum

aperture of f/16
No aperture ring
Fixed focal 

range

RATING

Above The small size makes it a great 
lens to blend into the crowd with.

SPEC
Minimum  
aperture: f/16
Elements: 7/5
Filter size: 39mm
Minimum focus 
distance: 34cm
DxL: 61x23mm
Weight: 78g

FUJIFILM

XF 27MM F/2.8 
£329

#4

Above Excluding a
manual aperture ring
helps keep weight to

a minimum.

Tamron has packed a very wide

zoom range of 18-200mm into a

rather sleek body, although this

lens does weigh in at a fairly hefty

460g. The 10cm body almost 

doubles in length when fully 

zoomed in too, measuring 17.5cm.

This is a great all-purpose lens

though, packing a whopping 

17 elements in 13 groups, with 

7 diaphragm blades creating 

near round out-of-focus bokeh. 

The minimum aperture of 

f/22 allows you to achieve a 

very wide depth-of-field, and 

the 50cm minimum focusing 

distance is very respectable 

considering the zoom range. 

Tamron has included its Vibration

Control (VC) image stabilisation to

help you to work handheld in low 

light. The lens barrel also features

a lock switch, so the lens doesn’t 

accidentally zoom out during transit.

Image centres are impressively

sharp, even at wider apertures, and

corner softness holds up well. At

longer zoom ranges, images appear

slightly less sharp, with corner

blurring creeping in at 200mm.

PROS
Zoom range
Image

stabilisation
Price 

CONS
Weight
Size
Softer at 

200mm

RATING

Above The barrel extends to 17.5cm 
at the longest focal length of 200mm.

SPEC
Minimum  
aperture: f/22
Elements: 17/13
Filter size: 62mm
Minimum focus 
distance: 50cm
DxL: 68x97mm
Weight: 460g

TA MRON

18-200MM F/3.5-6.3
DI III VC £339

#3

Above The lock 
switch ensures no 

barrel creeping 
when shooting at 

an 18mm angle.

MIRRORLESS LENSES UNDER £1500

HIGHLY 
RATED
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A relatively new lens from Sigma’s

much-acclaimed Global Vision 

range, the 30mm f/1.4 prime offers

exceptional optical quality, and is

the cheapest autofocus lens in test.

At a very respectable 264g and 

a compact 74mm, it falls into the 

portable category well and fits into

any traveller’s kit bag with ease.

And the 50° field-of-view, fast 

AF and diminutive size makes 

this lens perfect for capturing 

local culture incognito. 

The 9 elements in 7 groups 

include one aspherical, and one

double aspherical, lens element to

ensure any distortions are kept to a

minimum. The 9 rounded diaphragm

blades, coupled with the f/1.4 

aperture, produce some stunning 

bokeh in the out-of-focus areas. Its

wide aperture makes up for its lack of

image stabilisation, giving you more

light-gathering capabilities when

shooting in low light conditions.

Sharpness in the corners is

extremely impressive, even at

the widest aperture. Vignetting

is noticeable, though chromatic

aberration is almost non-existent.

PROS
Wide aperture
Price
Sharpness

CONS
No IS
Minimum

aperture of f/16
Fixed focal 

length

RATING

Above The new design gives this 
Sigma lens a very sleek appearance.

SPEC
Minimum  
aperture: f/16
Elements: 9/7
Filter size: 52mm
Minimum focus 
distance: 30cm
DxL: 66x74mm
Weight: 264g

SIGMA

30MM F/1.4 DC DN | C
£269

#2

Above The large ring
is very responsive,
and perfect if you

want to shoot in
manual focus.

HIGHLY 
RATED

With the M6 recently joining

Canon’s expanding mirrorless

range, the 18-150mm f/3.5-6.3 is

the perfect all-round companion.

The 8.3x optical zoom offers an 

astonishing 29-240mm 35mm 

equivalent, meaning you can capture

landscapes, portraits and even 

wildlife shots with just one lens.

At 300g and 87mm long, the barrel

extends to 135mm, meaning it’s not

the most portable lens in test, but

you do get a lot of functionality. The

built-in 4-stop image stabilisation

means you can shoot handheld

in low light without the need for 

a tripod, even when fully zoomed.

The whopping 17 elements in

13 groups include a 7-bladed circular

aperture, giving you well rendered

bokeh in the out-of-focus areas. 

The image quality really 

impressed us, with great sharpness

throughout the range and only very

light vignetting, which is slightly more

noticeable at longer focal lengths.

Chromatic aberration is kept at bay

throughout the range, although

we did notice some minor barrel

distortion at wider focal lengths.

PROS
Zoom range
Image 

stabilisation
Price

CONS
Plastic build 

quality
Size
Barrel distortion

RATING

Above The barrel extends to 135mm to 
accommodate the large zoom range.

SPEC
Minimum  
aperture: f/22-32
Elements: 17/13 
Filter size: 55mm
Minimum focus 
distance: 25cm
DxL: 61x87mm
Weight: 300g

CANON

EF-M 18-150MM
F/3.5-6.3 IS STM £399

#1

Above 4 stops of 
image stabilisation 

makes handheld 
shooting in low light 

much easier.

BEST  
IN
TEST

GetIntoGear
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With a vast array of lenses covering
almost every focal length you’ll need on
your travels, this has been a very hard
test to judge. With each lens offering
something different, they all stand on 
their own merits. The third-party lenses 
also offer healthy competition, with 
Tamron, Samyang and Sigma throwing 
something different into the mix, making 
this decision even more difficult. 

Although the image quality of the Sigma 
is exceptional, especially for the price, 
we felt the fixed focal length was holding 
it back as all-purpose travel lens when
compared to others in test. The Samyang 
fisheye offers a unique perspective, 
but large field-of-view doesn’t always 
guarantee focus and nailing absolute 
sharpness in every image isn’t always easy. 

The winning lens is...
Canon’s EF-M 18-150mm f/3.5-6.3 IS STM 
takes the top spot in our test. Its image 

quality is fantastic, giving
great sharpness throughout
and keeping distortions to a
minimum. The 4-stop image
stabilisation gives it the edge
over its rivals, offering sharp
scenes in low light conditions.
The focal range offers a colossal
29-240mm equivalent, which
makes it perfect for capturing
any scene, and although it is relatively
large at full extension, for the price
you’d be hard pressed to find better. 

The Sigma 30mm gets the Highly 
Rated nod, thanks to its very impressive
sharpness, beautiful image quality and 
extremely low price. Fuji’s 27mm also 
excels at image quality, but the cross mount
availability for the Sigma wins out this 
time. The lack of zoom function makes the
uses for this lens slightly more limited than
the Canon, which counts against it and
keeps it from topping the list. The Tamron
18-200mm also gets a Highly Rated award,
offering a great zoom range. Image quality
may suffer at slightly longer focal lengths,
but the price and versatility of this lens
makes it a great choice for your travels.

While Sony has some great offerings
for its CSC range, unfortunately it 
could not supply the lenses for testing 
and, as such, could not be included.

Above The sheer versatility of Canon’s 
18-150mm gives it the top spot. Sigma 
and Tamron follow very closely behind, 
both offering great image quality.

Overall verdict

“THE CANON  
HAS A COLOSSAL 
29-240MM ZOOM 
RANGE & 4-STOP 
STABILISATION”

Best performing model under our test conditions Highly recommended productKEY:

At-a-glance results Price Depth x Length Weight Image 
stabilisation

Minimum 
focus RATING

CANON EF-M 18-150MM 
F/3.5-6.3 IS STM

£399 61x87mm 300g Yes 25cm

CANON EF-M 11-22MM  
F/4-5.6IS STM 

£319 61x58mm 220g Yes 15cm

FUJIFILM
XF 27MM F/2.8

£329 61x23mm 78g No 34cm

FUJIFILM XF 18-135MM 
F/3.5-5.6 R LM OIS WR

£619 76x98mm 490g Yes 45cm

OLYMPUS M.ZUIKO ED 
40-150MM F/2.8 PRO

£1199 79x160mm No 70cm

PANASONIC G VARIO 14-42MM 
F/3.5-5.6 II APSH

£279 56x49mm 110g Yes 20cm

SAMYANG 8MM F/2.8  
UMC FISHEYE II

£239 60x65mm 290g No 30cm

SIGMA 30MM
F/1.4 DC DN | C

£269 66x74mm 264g No 30cm

TAMRON 14-150MM  
F/3.5-5.8 DI III

£439 64x80mm 285g No 50cm

TAMRON 18-200M  
F/3.5-6.3 DI III VC

£339 68x97mm 460g Yes 50cm

MIRRORLESS LENSES UNDER £1500

BEST  
  

HIGHLY 
RATED

HIGHLY 
RATED
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The Lifeproof Fré is a surprisingly 

inexpensive phone case that is 

rated to survive immersion at 2m 

for up to an hour. While that may 

not sound like a lot, it’s perfect for 

a spot of shallow sea snorkelling or 

swimming pool fun with the family. 

The case is rated as shockproof 

from a 2m drop, as well as being 

waterproof, dust-, snow- and ice-

resistant, offering you a robust, all-

occasion case to protect your phone 

against adverse weather conditions. 

It also has an optical-grade lens 

cover, which offers very impressive 

quality. The charging and microphone 

ports can also be accessed easily. 

There are other phone cases 

available that offer greater depths 

and higher specs – and increased 

price-tags to match – but many 

of these are specific to one brand 

of phone only. lifeproof.com

SPEC Maximum depth: 2m 
Maximum drop: 2m Weight: 30g

Lifeproof Fré
£50

Smartphones are constantly being

improved, but their small sensors make

low light capture a constant struggle. Most 

phones come with a built-in flash, but it’s 

neither powerful nor flattering, and doesn’t 

add much to your photographic arsenal.  

Iblazr has created the first phone/

tablet camera-synced LED flash, 

compatible with both iOS and Android 

devices. Bluetooth functionality 

means you can use this tiny 20g light

off-camera, and the Shotlight app allows 

you to sync up to 10 lights at a time for 

blinding possibilities. The unit itself even 

offers the ability to change the colour 

temperature of the light it emits for the 

ultimate control over your scene. 

With a USB-rechargeable battery

offering up to 300 flashes or two 

hours of constant, dimmable light and 

a maximum output of 300 Lux, this 

powerful, pocketable accessory is 

a must for portrait fans. concepter.co

SPEC Max Lux: 300 at 1m Min Lux: 20 at 1m 
WxLxD: 4x3x1cm Weight: 20g

Iblazr2 Wireless LED  
Flash £40 

HIGHLY 
RATED
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favourite cinematic moments, and

although invented over 40 years ago

remains the first word in moving image

stabilisation. The Smoothee now

brings the Steadicam heritage and

quality to the smartphone world.

Keeping costs and complications

down, the Smoothee uses a non-

motorised, adjustable counterweight to

keep the phone balanced, and does a

great job of retaining smooth footage.

The universal mount holds a wide range

of smartphones, meaning you don’t need

to worry about buying new mounts every

time you change phones. The trigger

handle offers a secure grip and the

weighted front ensures constant stability.

At 39cm long, the Smoothee will slip

into any carry-on bag to accompany

you on your travels, so if you like to

shoot video or moving time-lapses,

this is perfect for you. tiffen.com

SPEC Counterweight: Yes, adjustable
WxLxD: 20.3x39.3x6.4cm Weight: 75g

Steadicam Smoothee
Universal Mount £79

Instant prints are enjoying a renaissance,

with Impossible Project (IP) resurrecting

Polaroid and Fuji offering its own Instax

format. There are many Wi-Fi-enabled 

mobile printers on the market allowing 

you to print straight from your phone, 

but none of them offer the romance of 

the Impossible Project Instant Lab. 

IP has created a portable darkroom 

that acts like a traditional enlarger. 

Simply unfold the solid bellows 

from the base and you can use the 

brightness of your phone’s screen 

to expose a single slide of instant 

film. The app provides easy-to-follow 

instructions and an intuitive interface. 

The rechargeable battery in the base 

means you can use the non-powered 

I-type film (traditionally instant cameras 

were powered by the film packs), as 

well as the powered 600 and SX-70 

film packs. NB: 8-sheet packs cost 

from £17. uk.impossible-project.com

SPEC Battery: Rechargeable Li-ion  
Film: I-type, 600, SX-70 

Impossible Project Instant
 Lab Universal £129 

Smartphone lenses do a brilliant job 

of capturing scenes around their native

35mm focal length. However, if you want

to shoot something a bit wider, you’ll

need a lens adapter to change the angle-

of-view. The Olloclip Core Lens Set 

allows you to mount either a Super-Wide, 

Fisheye or Macro 15x lens to your phone, 

all of which offer impressive optics, 

particularly at the centre of the frame. 

The Macro lens provides amazing

magnification for close-up detail, while 

the Fisheye is actually circular and not 

diagonal, meaning it’s represented 

as a circle within the image and 

doesn’t cover the whole frame. 

The whole set weighs in at a 

minute 34g and fits comfortably in 

your pocket for ultimate portability. 

The Core Lens Set is currently only 

available for iPhones, though Olloclip

offers a wide range of lenses for 

other phone makes. olloclip.com

SPEC Height: 27.9mm Width: 63.5mm 
Depth: 45.7mm Weight: 34g

Olloclip Core
 Lens Set £99 

HIGHLY 
RATED
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Sunnycam HD
sunglasses
£119
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The Sunnycam Activ Edition HD

sunglasses have been designed for

people who want to capture life as

it happens, via wearable-tech. The

centrally-mounted camera captures

1080p video at 30fps, via a 90° 

field-of-view lens. The microSD port 

on the arm supports up to 64GB 

for 11 hours of footage, and there’s 

a micro-USB port for charging and 

connecting to your computer. An 

internal, rechargeable battery provides 

up to one hour of recording time and 

the glasses themselves incorporate 

a vibration function to notify you they

are recording. We weren’t hugely

impressed with the video quality, 

as there seemed to be a lot of blur 

as the action got quicker and a lack 

of clarity on a steady stroll around 

PP HQ, but there’s no denying the 

simple fact that adrenaline junkies 

will love them. sunnycam.com

Every computer screen has variations

in its display that cause colour casts or

inaccurate brightness. Couple that with

the fact that each internet browser has

different profiles, and so displays colours

in different ways, and working with precise

colours becomes nigh-on impossible.

That’s where screen calibration comes

in. Datacolor is renowned for its industry-

standard Spyder calibration tools, and

this product is a worthy addition to the

range. Spyder5Express offers an easy and

automatic solution to screen calibration,

using a single, palm-sized device and a

download code for the drivers. The device

plugs into a USB port and hangs over

the centre of your screen, allowing the

in-built lens to read your monitor. It then

relays information back to the software

where the changes are made behind

the scenes and applied as the default

screen profile, directly to your computer.

A handy ‘Before and After’ mode highlights

changes in colour, skin tones, shadow

and highlight details, so you can see

exactly what’s been done and where.

We found the whole process took just

5 minutes per screen, and would highly

recommend it for accurate, reliable and

fast results. spyder.datacolour.com
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Above The central camera offer
a 90° field-of-view.

Da  £90

Lexar 2000x
64GB £119
With more cameras offering

higher resolution sensors and

4K video features, choosing

a memory card that can keep

up is fundamental. The Lexar

Professional 2000x 64GB Class

10 USH-II card is impressively

speedy, with read speeds of up

to 300MB/s and write speeds

up to 260MB/s. It comes with

its own USB reader, meaning

you can transfer files anywhere,

and recovery software for peace

of mind. The 2000x range also

offers 32GB and 128GB cards,

and comes with a reassuring 

lifetime guarantee. lexar.com

Kenro Film
Scanner £99
The Kenro Film Scanner allows

you to scan 35mm, 110mm,

Super 8 film and monochrome

slides straight to your computer, 

via USB, or onto an SD card

up to 32GB. The 2.4in LCD

shows a preview of the image

and controls allow you to flip

or rotate the image, as well as

choose the film type and alter

the exposure. At 275g and

10cm wide, it won’t take up

much desk space and we were

impressed by the results from 

the 14MP sensor. kenro.com

HIGHLY 
RATED

HIGHLY 
RATED
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To advertise 

call 

Sue Hunter

 on 

01733 

366361 

or e-mail 

sue.hunter@

bauermedia.

co.uk

MARKET 
PLACE

Photographic
Backgrounds
Hard wearingO low creaseOWashable

01457 764140
for a FREE colour brochure or visit...

www.colourscape.co.uk

PLAIN
8’ x 8’ ... £15 plus P&P

8’ x 12’ . £24 plus P&P

8’ x 16’ . £29 plus P&P

CLOUDED
8’ x 8’ .....  £27 plus P&P

8’ x 12’ ... £44 plus P&P

SPECIAL OFFER:
8 x 12 CLOUDEDS 

2 FOR £80 OR 3 FOR £115

10 COLOURS INC
BLACK, WHITE
& CHROMA
COLOURS

20 COLOURS

We are a family run business specialising in the design, manufacture 
and sale of very high quality Camera Bean Bags. The Bean Bags 
have a vast and varied use for the modern photographer and make 
an addition and alternative to tripods/monopods. Extremely light 
weight and easy to use.

We offer a fast friendly service and quality hand made products. 

Each Camera Bean Bag support is made up of two interconnected 
bags. They form an “H” section allowing the bags to rest over a car 
door or fence etc. They can also be used in a conventional manner.

Available in Waterproof or Non-Waterproof fabric and a variety of plain 
and camouflage colours.

Ready to use with light weight polystyrene balls and available in three sizes 
for use with cameras from compacts to telephoto lenses.
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PRICES START FROM £14.50 WHICH INCLUDES P&P WITHIN THE UK

camerabeanbags.co.uk

camerabeanbags.co.uk 
email sharon.lewis09@ntlworld.com

WILDLIFE PHOTO HIDES
WORKSHOPS AND HIRE

with Sussex Wildlife Trust
Photographer

David Plummer
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www.davidplummerimages.co.uk
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Grace. Photograph by Phoenix. 
All Rights Reserved

y Call to Artists & Photographers
y Interpret ENDANGERED
y Global, online, juried contest with cash prizes
y Fine Art category includes Sculpture, Jewelry and Wearable Art
y Digital manipulation accepted in the Fine Art Photography category
y Special category for Young Artists
y Closing date 8th October, 2017
y Exhibition during Miami Art Week, 6-9th December, 2017
y Proceeds benefit Center for Great Apes www.CenterForGreatApes.org

ENDANGERED Fine Art
& Photography Contest 2017

Submit online at:

www.Art4Apes.com
Plus full terms and conditions

Questions? lindseymatheson@gmail.com

To get your hands on this
award-winning paper please call 

01789 739200 
or visit www.permajet.com

Voted as theV Best
P r o f e s s i o n a l
Paper in 2012,
2014andnow2016
by The Society of
Photographers ,
this award winning
inkjet media is
a versatile and
rewarding choice.

With a subtle lustre surface and an 
instant-dry resin coating, Oyster 271
is the one for the photographers
and artists looking for a
consistently professional quality.

The Photography Show
for an exclusive NEW product launch

Stand F91



 
 

     

HUNDREDS OF PLACES WHERE YOU
CAN SELL YOUR PHOTOS FOR CASH!

OUT NOW! The latest edition of 
The Freelance Photographer’s
Market Handbook

Described as the photographer’s bible, this
208-page BFP Handbook has hundreds of
markets where you can sell your pictures for
£££s. It includes magazines, greetings card
and calendar publishers, picture libraries,
newspapers, book publishers etc.

The Freelance Photographer’s Market
Handbook gives full details of the type of
photos – subject matter etc – being sought,
fees paid, and exactly where to send your
pictures.

Price: £15.95 + £2.00 P&P

SPECIAL OFFER: Join the Bureau of
Freelance Photographers (BFP) and
get 14 months membership for the 
price of 12!

For almost 50 years, the BFP has been helping
photographers like you to sell their photos. 

As well as getting the 208-page Freelance
Photographer’s Market Handbook with
hundreds of markets for photos, you’ll also
receive our monthly Market Newsletter keeping
you up to date with current picture needs. 

You may also take advantage of our Advisory
Service offering personal help on any aspect of
selling photos.

All for just £54 per annum. Join now and get
14 months membership for the price of 12!

NEW! The BFP Freelance
Photography Course

While the BFP Handbook (above) will show
you WHERE to sell your photos, this lavishly
illustrated manual will show you HOW to
sell them.
It’s a practical course with 16 lessons
covering everything you need to know to
sell your pictures to magazines, greetings
cards, calendars, newspapers, books etc.
When ordered from the BFP, it comes with
a set of tutorials to guide you through 

the lessons.

Price: £25.00 + £2.00 P&P

To join the BFP � To order BFP books 
Go to www.thebfp.com 

Phone 01707 651450 
Or send a cheque to: 

Bureau of Freelance Photographers
Freepost 

Vision House PO Box 474 
Hatfield AL10 1FY



*Most brands considered. DSLR, Mirrorless and Top Compacts. 35mm and Medium Format. Auto and Manual Focus Lenses. Items must be in excellent condition and complete with relevant accessories.
Subject to inspection. E. & O. E. Goods and delivery services subject to stock and availability. Prices subject to change. Pictures are for illustration purposes only. All prices include VAT@ 20%. E. & O.E.

Thank you CameraWorld for
confirming that the great customer 

experience is alive and kicking in the high street!
Scott D | 10.11.16

Thank you so much for your excellent help 
and support with choosing a new camera... 

Absolutely brilliant shop.
Alan H | 09.03.17

#amazingService 
Sarah I | 06.09.17

100’S MORE ONLINE AT: www.cameraworld.co.uk/testimonials ”

“
WHAT OUR CUSTOMERS SAY:

We buy more We pay more We smile more
Just call or email Dale our Used Equipment Manager for expert valuation and advice. Direct Line: 0207 467 9912     

Email: dale@cameraworld.co.uk Or contact any of our used equipment experts on 020 7636 5005 or 01245 255510

Get free pick-u
Pop it in the post or we can
collect it when convenient
(dependant on value).

Get paid fast
Take advantage of one of our super
Trade-Up Offers, or just take the money & EN

Get in touch
Give us a call and have a chat
or fill out our simple form at
www.cameraworld.co.uk/use

…or, cupboards, under the stairs, behind the sofa. Why not sell them 

to us for extra spending money. We buy all sorts of photographic 

equipment – digital or film cameras, autofocus and manual lenses, 

camera bags, tripods and accessories –  it’s SO easy & fast!

Unwanted camera
gear in the attic?

Now buying 

film cameras

020 7636 5005 LONDON
14 Wells Street (off Oxford St), London W1T 3PB

sales@cameraworld.co.uk

01245 255510 CHELMSFORD
High Chelmer Shopping Ctr, Chelmsford CM1 1XB 

chelmer@cameraworld.co.uk

cameraworld.co.uk



Tel: 01803 852400
Email - info@mifsuds.com
www.mifsuds.com

Mifsuds Photographic Limited
27-29, Bolton Street, Brixham. D on. TQ5 9BZ.

PHONE LINES OPEN

MON -FRI 8am - 5pm,
SAT 9am - 3pm,

SUN CLOSED.
SHOP OPEN

MON -FRI 9am - 5pm,
SAT 9am - 3pm. SUN CLOSED.

U.K. Stock
No Grey Imports

MORE ON WEBSITE - UPDATED DAILY. FREE U.K. MAINLAND DELIVERY FOR ITEMS OVER £100 VALUE. ALL U.K. STOCK, NO GREY IMPORTS.

Family Run Pro Dealership With Friendly, Knowledgeable Staff. Prices Inc VAT - Correct 21/03/2017. P&P Extra. E&OE.

PAR
WE PART E , S
FAIR PRICES OFFERED ~ QUOTED QUICKLY ~ COLLECTION CAN BE ARRANGED

For speediest response please email your equip e t etails to... info@mifsuds.com

X-Pro2 body......................................£1348
X-T2 + 18-55mm .............................£1647
X-T2 body Graphite........................£1649
X-T2 body ..........................................£1398
X-T20 + 18-55mm...........................£1049
X-T20 body.......................................... £799
X-T10 + 18-55..................................... £749
X-A10 + 16-50mm ............................ £498
X100f compact camera ................£1249
X System Lenses, flash, accessories
10-24mm F4 XF ................................. £766
14mm F2.8 XF R ................................ £788
16mm F1.4 XF .................................... £797

16-55mm F2.8.................................... £898
18mm F2 XF........................................ £449
18-55mm F2.8/4 OIS ....................... £618
18-135mm F3.5/5.6 XF.................... £649
23mm F1.4 XF .................................... £788
23mm F2 XF R WR ............................ £418
27mm F2.8 XF .................................... £328
35mm F1.4 XF .................................... £448
35mm F2 R WR................................... £347
50mm F2 R WR................................... £449
50-140mm F2.8 R OIS....................£1328
50-230mm F4.5/6.7 XC OIS ........... £247
55-200mm F3.5/4.8 OIS XF............ £597

56mm F1.2 R APD...........................£1158
56mm F1.2 XF .................................... £797
60mm F2.4 XF .................................... £578
90mm F2 R LM WR ........................... £797
100-400 F4/5.6 OIS WR .....................£1439
1.4x XF TC WR..................................... £299
2x XF TC WR ........................................ £347
11mm or 16mm Ext tube ea............ £64
VPB-XT2 Vertical grip....................... £268
EF-20 TTL Flashgun............................. £98
EF-42 TTL Flashgun.......................... £168
EF-X20 TTL Flashgun ....................... £168
EF-500 TTL Flashgun ....................... £449

15-30 f2.8 Di VC USD ..............£928
16-300 f3.5/6.3 Di II VC PZD .£428
18-200 F3.5/6.3 Di II VC..........£198
24-70 f2.8 Di VC USD ..............£799
70-200 f2.8 Di VC USD G2 ..£1349

70-300 F4/5.6 Di VC USD.......£298
70-300 F4/5.6 Di AF.................£128
85 f1.8 SP Di VC USD...............£748
150-600 F5/6.3 VC USD G2 £1349
150-600 F5/6.3 SP VC USD ....£828
Kenko Converters

1.4x or 2x Pro 300 conv each..£159
Auto ext tube set ............. .£109.99

8-16 F4.5/5.6 DC HSM . . . . . .£599
10-20 F3.5 EX DC HSM . . . . . .£339
12-24 F4 DG HSM Art . . . . . £1399
12-24 F4.5/5.6 II DG. . . . . . . . .£649
17-50 F2.8 EX DC OS. . . . . . . .£329
18-35 F1.8 DC HSM Art . . . . .£649
18-300 F3.5/6.3 DC mac OS .£369
20 F1.4 DG HSM Art . . . . . . . .£699
24 F1.4 DG HSM Art . . . . . . . .£649
24-35 F2 DG HSM Art . . . . . . .£759
24-70 F2.8 EX DG . . . . . . . . . . .£578
35 F1.4 DG HSM Art . . . . . . . .£649
50 F1.4 EX DG HSM Art . . . . .£599
50-100 F1.8 DC HSM Art . . . .£949
50-500 F4.5/6.3 DG OS. . . . £1099
70-200 F2.8 EX DG OS . . . . . .£899
70-300 F4.5/5.6 Mac DG . . . .£129
70-300 F4.5/5.6 APO Mac DG £179
85 F1.4 DG Art. . . . . . . . . . . . . .£999

105 F2.8 EX DG OS HSM . . . .£359
150 F2.8 EX DG OS. . . . . . . . . .£799
150-600 F5/6.3 OS Contemp £799

150-600 F5/6.3 OS Sport . . £1329
500 F4 DG OS HSM Sport . £4997
500 F4.5 EX APO DG HSM. £3299
TC1401 converter. . . . . . . . . . .£249
TC2001 converter. . . . . . . . . . .£299
USB Lens dock. . . . . . . . . . . .£39.99

LOTS OF SIGMA LENSES
AVAILABLE IN SONY &

PENTAX AF FITS

WE STOCK COKIN , D Z SERIES KITS. PLEASE SEE E ITE FOR F LL DETAILS.

FZ1000

£588

FZ2000

£1089

DX NON FULL FRAME LENSES
10.5 F2.8 DX Fisheye . . . . . . . .£599
10-24 F3.5/4.5 AFS G . . . . . . . .£729
16-80 F2.8/4 AFS ED VR. . . . . .£858
16-85 F3.5/5.6 AFS VR . . . . . . .£568
18-105 F3.5/5.6 AFS G no box£239
18-140 F3.5/5.6 AFS VR . . . . . .£458
18-300 F3.5/6.3 AFS VR . . . . . .£628
35 F1.8 AFS G . . . . . . . . . . . . . . .£178
FX FULL FRAME LENSES
14-24 F2.8 AFS G ED. . . . . . . £1638
16-35 F4 AFS VR . . . . . . . . . . £1018
18-35 F3.5/4.5 AFS G . . . . . . . .£618
20 F1.8 AFS G ED. . . . . . . . . . . .£647
24 F1.8 AFS G ED. . . . . . . . . . . .£628
24-70 F2.8 AFS G ED VR. . . . £1598
24-120 F4 AFS G ED VR . . . . . .£897
35 F1.8 AFS G . . . . . . . . . . . . . . .£438
50 F1.4 AFS G . . . . . . . . . . . . . . .£377
50 F1.8 AFS G . . . . . . . . . . . . . . .£188
70-200 F2.8 AFS E FL ED VR £2648
70-200 F4 AFS G ED VR . . . . £1178
70-300 F4.5/5.6 AFS VR . . . . . .£497
70-300 F4.5/6.3 AFP VR . . . . . .£288
70-300 F4.5/6.3 AFP non VR .£259
85 F1.8 AFS G . . . . . . . . . . . . . . .£428
105 F2.8 AFS VR macro . . . . . .£748
200-500 F5.6 AFS E ED VR. . £1178
300 F2.8 AFS ED VRII . . . . . . £4897
300 F4 AFS E PF ED VR. . . . . £1497
400 F2.8 G E FL ED VR . . . . £10398
500 F4 E AFS FL ED VR . . . . . £8447
600 F4 E AFS FL ED VR . . . . . £9699

Ni on
APS-C

Body only price

£1728

Nikon D810
Full Frame

Body only £2398

Body only £1597

Plus 24-120 f4 VR £2297

Nikon D750
Full Frame

Plus 18-55 AF-P £798
Plus 18-140 VR £989

Nikon D5600
APS-C

Nikon APS-C Cameras
D7200 Body only ...............................£848
D7200 + 18-105 VR ..........................£1087
D5500 Body only ...............................£578
D5500 + 18-55 VRII ............................£648
D5500 + 18-140 VR ............................£797
D3400 + 18-55 AF-P...........................£438

Body only price

£5097

Nikon D5
Full Frame

400 F2.8 G E

FL ED VR

£10398

500 F4 G E

AFS FL

ED VR

£8447

Canon EOS 1DX MKII

Full Frame

Body only
price

£4797
Canon EOS 5D MKI

Full Frame

Body only
price

£3494
Canon EOS Full Frame Cameras
EOS 5DsR body..................................£2897
EOS 5Ds body ....................................£2797
EOS 6D body......................................£1398
EOS 6D + 24-105 f3.5/5.6 IS U STM ..£1649

CANON EF
FULL FRAME LENSES
8-15 F4 L USM Fisheye. . . . . .£1097
11-24 F4 L USM . . . . . . . . . . . .£2649
16-35 F2.8 L USM MKIII . . . . .£1997
16-35 F4 L IS USM . . . . . . . . . . . £849
20 F2.8 USM . . . . . . . . . . . . . . . . £447
24 F2.8 IS USM . . . . . . . . . . . . . . £419
24-70 F2.8 L II USM. . . . . . . . .£1847
24-70 F4 L IS USM . . . . . . . . . . . £769
24-105 F4 L IS USM MKII . . . .£1049
24-105 F3.5/5.6 IS STM . . . . . .£359
28 F2.8 IS USM . . . . . . . . . . . . . . £387
35 F2 IS USM. . . . . . . . . . . . . . . . £468
40 F2.8 STM . . . . . . . . . . . . . . . . £159
50 F1.2 L USM . . . . . . . . . . . . .£1297
50 F1.4 USM . . . . . . . . . . . . . . . . £319
50 F1.8 STM . . . . . . . . . . . . . . . . . £99
70-200 F2.8 IS LII USM. . . . . .£1947
70-200 F2.8 non IS L USM. . .£1297
70-200 F4 L IS USM. . . . . . . . .£1148
70-200 F4 L USM . . . . . . . . . . . . £658
70-300 F4/5.6 L IS USM . . . . .£1247
70-300 F4/5.6 IS USM II . . . . . . £477
85 F1.8 USM . . . . . . . . . . . . . . . . £338

100 F2.8 IS L USM macro. . . £829
100 F2.8 Macro USM . . . . . . . £458
100-400 F4.5/5.6 IS LII USM £1849
200-400 F4 IS L USM . . . . . £10399
200 F2.8 II L USM . . . . . . . . . . . £698
300 F2.8 IS L USM II . . . . . . . .£5666
300 F4 L IS USM. . . . . . . . . . . .£1278
400 F2.8 IS L USM II . . . . . . . .£9499
400 F4 DO II IS USM . . . . . . . £6666
400 F5.6 L USM . . . . . . . . . . . .£1198
500 F4 IS L USM II . . . . . . . . . £7999
600 F4 IS L USM II . . . . . . . .£11348
1.4x III converter . . . . . . . . . . . . £387
2x III converter. . . . . . . . . . . . . . £366
CANON FLASHGUNS
& DSLR GRIPS
MR-14 EX II . . . . . . . . . . . . . . . . .£498
MT-24 EXII . . . . . . . . . . . . . . . . . .£747
430EX III RT Speedlight . . . . . .£218
600EX-RT II Speedlight . . . . . . £538
BG-E20 (fit 5D MKIV) . . . . . . . . £297
BG-E16 (fit 7D MKII) . . . . . . . . . £179
BG-E18 (fit 750/760D) . . . . . . . £115
BG-E14 (fit 80D). . . . . . . . . . . . . £137
BG-E13 (fit 6D) . . . . . . . . . . . . . . £147

400
F4 DOII
IS USM
£6666 500 F4 IS L USM II £7999

Canon EOS 7D MKII
APS-C

Body only

£1239

Canon EOS APS-C Cameras
EOS 80D Body ............................£998
EOS 80D + 18-55 STM ............. £1048
EOS 80D + 18-135 STM ........... £1249
EOS 760D Body ..........................£598
EOS 750D Body ..........................£598
EOS 750D + 18-55 STM ..............£648
EOS 750D + 18-135 STM............£848
EOS 1300D + 18-55 IS ................£348

Canon E S System
EOS M3 + 15-45 ............................. £399
11-22 f4/5.6 IS STM ....................... £317
15-45 f3.5/6.3 IS STM .................... £219
18-55 f3.5/5.6 IS STM .................... £199
18-150 f3.5/6.3 IS STM.................. £398
22 f2 STM ....................................... £198
28 f3.5 Macro IS............................. £289
55-200 f4.5/6.3 IS STM.................. £268

Canon EOS 77D
APS-C

Body only

£829

Canon EOS 5
APS-C

M5 + 18-150

£1399

Body only

£1048

Canon E S 5
APS-C

Plus
15-45 £1098

Plus 18-55 STM £919
Plus 18-135 STM £1199

Canon EOS 800D
APS-C

Plus 18-55 STM £869

Body only

£779

Canon EOS M6
APS-C

M6 Body £729
Plus 15-45 STM £839
Plus 18-150 STM £1079

RX10

MKIII

£1399

RX100

MKV

£997



FUJI DIGITAL USED
X T1 body graphite box ...... £499
X T1 body black...................... £499
X T1 body black...................... £449
X T10 body box ...................... £349
16 F1.4 XF box ........................ £599
18 55 F2.8/4 XF ...................... £399
35 F1.4 R box........................... £399
60 F2.4 macro box................. £429
1.4x WR converter M box.. £259
X T2 grip.................................... £229
X10 box ..................................... £149
LEICA DIGITAL USED
M240 body box....................£2999
EVF2 viewfinder ..................... £269
MINOLTA/SONY DIGITAL USED
Sony RX100 MKIII box............ £449
Sony A7R II body box...........£2499
Sony A7 II body ........................ £999
Sony A6300 body.................... £749
Sony A58 body......................... £169
Sony VG B30AM..........................£69
Sony VG C70AM....................... £139
Sony VG CE2.............................. £179

Sony HV56AM........................... £169
Sony LA EA4 mount adap ... £189
SONY NEX USED
A6000 body................................... £329
NEX 5 body.................................... £129
FE 16 35 F4 ZA OSS E................ £999
FE 16 50 F3.5/5.6 EZ.................. £149
FE 24 70 F4 ZA OSS box.......... £699
FE 28 70 F3.5/5.6 OSS............... £299
FE 70 200 F4 G OSS box.......... £999
FE 90 F2.8 macro......................... £799
Samyang 100 F2.8 macro....... £229
MINOLTA/SONY AF USED
Dynax 9 body.......................... £299
800Si body ..................................£69
7xi body .......................................£49
7000i body..................................£39
300Si body ..................................£19
20 35 F3.5/4.5 M box.......... £249
24 F2.8 AF................................. £199
24 50 F4 .......................................£99
24 85 F3.5/4.5 ......................... £149
28 F2.8 ..........................................£99
28 80 F4/5.6................................£39

28 85 F3.5/4.5 ............................£99
35 70 F4 .......................................£39
35 70 F3.5/4.5..................................£25
35 80 f4/5.6.......................................£25
35 105 F3.5/4.5 ...............................£99
50 F1.7 AF..........................................£89
75 300 F4.5/5.6 ...............................£99
85 F1.4 G box................................ £499
100 300 F4.5/5.6 APO............... £179
100 300 F4.5/5.6.......................... £149
VC700 grip.........................................£39
RC1000S/L cord ..............................£15
SONY LENSES USED
16 80 F3.5/4.5 ZA DT................. £499
18 55 F3.5/5.6 SAM.......................£59
18 200 F3.5/6.3 DT ..................... £199
55 200 F4/5.6 DT SSM .................£69
75 300 F4/5.6................................ £129
SIGMA MIN/SONY AF USED
18 35 F1.8 Art............................ £449
28 135 F3.8/5.6............................£79
28 300 F3.5/6.3 macro........... £149
50 F1.4.......................................... £149
50 F2.8 EX DG macro ............. £149

55 200 F4/5.6 ...............................£69
70 300 F4/5.6 DG OS............ £169
70 300 F4/5.6 APO DG............£99
135 400 F4.5/5.6 .................... £299
150 500 F5./6.3 DG ............... £499
170 500 F5/6.3........................ £299
1.4x EX conv ...............................£99
TAM 10 24 F3.5/4.5 DiII ....... £239
TAM 18 200 F3.5/6.3................£99
TAM 90 F2.8 .................... £179/249
Teleplus 1.4x conv....................£69
Teleplus 2x conv .......................£79
Kenko 1.4x Pro 300DG......... £149
MINOLTA FLASH USED
Minolta 5200i.............................£29
Minolta 5400HS.........................£39
Minolta 5600HSD M ...............£99
OLYMPUS 4/3 USED
E3 body ..................................... £299
E10 MKII body......................... £349
E10 body................................... £279
E510 body ................................ £149
7 14 F4 ED................................ £499
11 22 F2.8/3.5 ......................... £349

14 42 F3.5/5.6 ............................£49
14 45 F3.5/5.6 ............................£79
14 50 F3.8/5.6 ......................... £199
14 54 F2.8/3.5 ......................... £199
35 F3.5 ..........................................£99
40 150 F4/5.6 .............................£49
50 F2 macro............................. £349
90 250 F2.9 ............................£1999
EC 14 converter ..................... £199
EC 20 converter ..................... £199
25mm ext tube..........................£99
FL 36 Flash ............................... £119
HLD 4 grip...................................£99
VA 1 angle finder......................£99
SIGMA 4/3 USED
30 F1.4 EX DC.......................... £199
50 500 F4/6.3 EX DG HSM.. £399
OLYMPUS MICRO 4/3 USED
Stylus 1F.................................... £299
OMD EM1 body M box ...... £599
OMD E M5 MKII b/o box..... £499
OMD E M5 body box............ £249
OMD EM10 body................... £249
12 40 F2.8 Pro......................... £649

12 50 F3.5/6.3 ......................... £149
17 F2.8 ....................................... £159
45 F1.8 box .............................. £199
40 150 F2.8 Pro ...................... £949
HLD 8 grip................................ £149
HLD 7 grip box....................... £119
HLD 6 grip...................................£99
PANASONIC DIGITAL USED
GH2 body ................................. £299
G6 body black......................... £299
G3 body box............................ £129
GX7 body.................................. £399
GF7 body silver box.............. £199
GF3 body black .........................£99
GF1 body ........................................£79
GM1 body silver..................... £299
12 35 F2.8................................. £549
14 F2.5 ....................................... £199
14 42 F3.5/5.6 ............................£79
14 45 F3.5/5.6 ......................... £149
20 F1.7 ....................................... £199
35 100 F4/5.6 .......................... £199
45 200 F4/4.5 box ................. £199
100 300 F4/5.6........................ £349

DIGITAL USED Why not register to receive our email newsletters? Simply send your email address to info@mifsuds.com to enrol

£2999

Used Leica
M240
body
box

£599

Used Olympus
OM-D E-M1
body M-
box

£2499

Used Sony
A7R II
body box

Although we are the best stocked dealer in the West Country,  
we cannot always have every item listed in stock at all times, so 
we are happy to reserve new & used items for customers 
planning to visit. Prices correct 21/03/2017 but subject to 
change without notice. See website for up to date prices. E&OE.

ITEM YOU REQUIRE NOT LISTED? PLEASE GIVE US DETAILS OF WHAT YOU ARE LOOKING FOR AND WE WILL CONTACT YOU WHEN THAT ITEM BECOMES AVAILABLE.
Mail order used items sold on 10 day approval. Return in ‘as received’ condition for refund if not satisfied (postage not included - mail order only). E&OE.

QUALITY USED EQUIPMENT. See website for full list. Call us to check condition. 6 Month warranty on most secondhand.

Website altered daily inc. manufacturers cashback & promotions 

www.mifsuds.com
Subscribe to our newsletter -  send your email address to info@mifsuds.com.

CANON DIGITAL AF USED
1DX body box........... £2499/2799
1D MKIV b/o serviced ........£1499
1D MKIV body......................... £999
1D MKIII body ......................... £699
1Ds body .................................. £299
7D MKII body box.................. £999
7D body box............................ £449
6D body box............................ £999
5Ds body box........................£2299
5D MKIII b/o box...... £1399/1699
5D MKII body ..............................£799
5D MKI body box ......................£399
70D body box.............................£499
60D body box.............................£399
50D body box.............................£299
40D body box.............................£149
30D body box.............................£129
20D body box................................£99
BG E2............£39 BG E2N...........£49
BG E4 box...£69 BG E5..............£49

BG E7.................................................£79
BG E8.................................................£69
BG-E11 ...........................................£169
Powershot G3X ..........................£499
SX50HS compact.......................£199
EVF-DC1 viewfinder.................£149
CANON AF FILM BODIES USED
EOS 3 body M- box ............... £299
EOS 1n HS body..................... £199
EOS 30/5 body each................£69
EOS 650 body ............................£39
EOS 600 body ............................£39
EOS 50E/500N/1000 b/o ea ..£29
PB-E2 drive M- box................ £199
PB E2 drive fits EOS1/3........ £149
CANON AF LENSES USED
10 22 F3.5/4.5 USM............... £329
14 F2.8 USM LII box ............£1499
16 35 F2.8 USM LII................. £899
16 35 F2.8 USM LI.................. £699
17 40 F4 L................................. £449

17 55 F2.8 EFS IS USM ......... £499
17 85 F4/5.6............................. £199
18-135 F3.5/5.6 IS USM............ £349
20 F2.8 USM................................... £349
24 F3.5 TSE MKI box................... £699
24-70 F2.8 L USM box............... £799
24-85 F3.5/4.5 USM.................... £149
24-105 F4 L..................................... £549
28-80 F3.5/5.6 ............................£79
28-90 F3.5/5.6 ............................£79
28-135 F3.5/5.6 IS USM ....... £169
40 F2.8 STM ............................. £139
50 F1.2 L USM box................. £999
50 F1.4 USM............................. £259
50 F1.8 MKII ................................£59
50 F2.5 macro ......................... £149
60 F2.8 USM EFS mac........... £249
65 F2.8 MP E............................ £849
70 200 F2.8 IS USM LII .......£1499
70 200 F2.8 IS USM LI........... £999
70 200 F2.8 USM L ................ £799

70 300 F4.5/5.6 DO IS U...... £399
70 300 F4/5.6 L IS U.............. £849
70-300 F4.5/5.6 IS USM ....... £249
75-300 F4/5.6 MKII ...................£99
85 F1.8 M-................................. £269
100 F2.8 IS USM L .................. £599
100 F2.8 USM box.................. £339
100-400 F4.5/5.6 L IS U..........£899
135 F2 L M- box...................... £599
180 F3.5 L mac.......................... £799
300 F2.8 LII IS U ......................£4799
300 F2.8 LI IS U............£2499/2999
300 F4 L IS USM box............... £799
400 F4 DO ISII L U..................£5799
400 F5.6 L box........................... £799
500 F4 LI IS USM.....................£4499
1.4x extender MKII box........ £249
2x extender MKIII box............ £339
2x extender MKII box............. £239
Teleplus 2x DG conv................£89
Kenko ext tube set DG................£89

SIGMA CAF USED
10 20 F3.5 EX DC................ £269
10-20 F4/5.6 HSM box ....... £219
17-70 F2.8/4 DC OS..................£249
18-50 F2.8 EX DC.......................£149
18-125 F3.8/5.6 OS DC ...........£149
18-200 F3.5/6.3 HSM OS...........£179
18-200 F3.5/6.3 DC......................£149
24-70 F2.8 HSM..........................£469
28-105 F2.8/4.................................£69
28-135 F3.8/5.6 .............................£99
28-200 F3.5/5.6 Asph ................£99
50 F2.8 EX macro ..................... £149
50-500 F4/6.3 EX DG ............ £399
70 200 F2.8 EX........................ £399
120 300 F2.8 DG OS
Sport box................................£2199
120 300 F2.8 EX DG.............. £799
120 400 F4/5.6 DG ................ £399
150 F2.8 EX DG OS mac.........£499
150 500 F5/6.3 DG OS.............. £449

150 600 F5/6.3 DG OS.............. £999
180 F3.5 EX DG HSM mac....... £399
1.4x EX DG converter................ £149
Kenko Pro 300 DG 1.4x conv....£99
Kenko Pro 300 1.4x conv............£99
Kenko ext tubes..............................£79
OTHER CAF USED
TAM 10-24 F3.5/4.5 Di II ..........£199
TAM 18-270 F3.5/6.3 VCII ...... £169
TAM 28-300 F3.5/5.6 Di VC. £449
TAM 28-75 F2.8 XR Di........... £199
TAM 70-300 F4/5.6 ......................£99
TAM 200-500 F5/6.3.................£449
Zeiss 50 F1.4 ZE box ................£599
CANON FLASH USED
ST E3 transmitter box .......... £189
ST E2 transmitter ......................£79
MR 14EX ringflash................. £319
430EXII.......£169 550EX...... £149
580EX box ................................ £179
580EX MKII ............................... £299

CANON USED Buy with confidence - all of our used equipment is thoroughly tested and cleaned before being offered for sale

Used Canon
EOS 5D
MKIII

body
 box

£1399/1699

£2499/2799

Used Canon
 EOS 1DX
 body 
 box

NIKON DIGITAL AF USED
D4s body box........................£3799
D4 body box..........................£2299
D3X body box.......................£1799
D3s body box........................£1799
D3 body box..........................£1199
D2xs body box........................ £399
D800 body box.....................£1399
D700 body box.............. £499/599
D500 body box.....................£1549
D300s body ............................. £349
D300 body box....................... £299
D200 body box....................... £149
D7100 body box .................... £499
D5000 body box .................... £199
D90 body.................................. £199
MBD 17 M box ...................... £279
MBD 15 grip ............................ £149
MBD 14 grip ............................ £149
MBD 12 grip ............................ £279
MBD 10 grip M box............. £129
MBD 10 grip ...............................£79
MBD 80 grip ...............................£49

MBD 100 grip.............................£39
MBD 200 grip.............................£49
NIKON AF FILM BODIES USED
F5 body ..................................... £399
F4E body inc MB-23.............. £399
F801 body ............................ £29/59
F601 body ...................................£29
NIKON AF LENSES USED
10-24 F3.5/4.5 AFS DX ......... £549
14-24 F2.8 AFS M- box.........£1099
14-24 F2.8 AFS ......................£999
16-35 F4 VR.............................£749
16-85 F3.5/5.6 AFS VR..........£399
17-55 F2.8 AFS .............................£499
18 35 F3.5/4.5 AFD ....................£299
18 55 F3.5/5.6 AFS VR................£99
18 135 F3.5/5.6 AFS...................£169
18 200 F3.5/5.6 AFS VRI...........£299
18 300 F3.5/5.6 VR .....................£649
28 F1.8 AFS G................................£399
24 70 F2.8 AFS box....................£999
24 85 F3.5/4.5 VR ........................ £329
24 120 f4 AFS VR......................... £699

24 120 F3.5/5.6 AFD.................. £199
28 F1.8 AFS G................................ £449
28-100 F3.5/5.6 AF G....................£69
28-300 F3.5/5.6 VR...................... £599
35 F2 AFD ....................................... £199
35-70 F3.3/4.5 AF...........................£59
40 f2.8 AFS Micro................... £169
50 F1.8 AFS box...................... £149
50 F1.8 AFD.................................£99
55-200 F4/5.6 AFS ....................£79
55-300 F4.5/5.6 VR DX ......... £219
60 F2.8 AFS .............................. £399
60 F2.8 AF................................. £199
70-200 F2.8 AFS VRII...........£1349
70 200 F2.8 AFS VRI .............. £899
70 200 F4 AFS VR................... £899
70 300 F4/5.6 VR.................... £369
80 400 F3.5/5.6 AFS VR......£1599
85 F1.4 AFS M box ............... £999
105 F2 AFD............................... £649
105 F2.8 AFS VR...................... £579
105 F2.8 AFD........................... £399
135 F2 AFD box...................... £799

180 F2.8 AFD M box............ £449
200 400 F4 AFS VRII............£3699
300 F2.8 AFS VRII .................£3999
300 F2.8 AFS VRI ..................£2999
300 F4 AFS E PF....................£1299
300 F4 AFS box....................... £549
400 F2.8 AFS VR serviced..£5799
400 F2.8 AFS non VR...........£3999
600 F4 AFS VR .......................£6299
600 F4 AFS II non VR
serviced...................................£3999
TC14EII box .............................. £299
TC17EII....................................... £249
TC20EIII M- box ...................... £329
TC20EII......£199 TC20E ........ £149
SIGMA NAF USED
15 F2.8 EX DG ............................... £399
18 200 F3.5/6.3 DC OS.............£199
24 35 F2 DG Art box .................£599
24 105 F4 DG OS HSM.............£499
28 200 F3.5/5.6 early...................£69
30 F1.4 EX DC...............................£199
35 F1.4 DG Art..............................£499

50 F1.4 EX DC M box........... £299
50 500 F4/6.3 DG.......... £399/499
70-200 F2.8 EX DG OS.......... £649
70-300 F4/5.6 APO DG............£99
80-400 F4.5/5.6 EX DG......... £399
120-400 F4/5.6 DG ................ £399
105 F2.8 EX DG OS ..................... £269
105 F2.8 EX DG............................. £199
150-500 F5/6.3 DG OS.............. £499
150-600 F5/6.3 DG OS
Sport box ......................................£1079
500 F4 DG OS HSM
sport box.......................................£4399
TC-1401 1.4x converter............ £179
2x EX DG converter.................... £149
1.4x EX converter...........................£99
2x EX converter...............................£99
TAMRON NAF USED
10 24 F3.5/4.5 DiII....................... £239
11 18 F4.5/5.6............................... £219
18 250 F3.5/6.3 ............................ £149
19 35 F3.5/4.5..................................£99
24 70 F2.8 USD VC box ............ £599

28 300 F3.5/6.3 XR Di................ £149
60 F2 SP Di...................................... £229
70-300 F4/5.6...................................£79
OTHER NAF USED
TOK 10-17 F3.5/4.5 ATX....... £249
TOK 12-24 F4 ATX Pro .......... £329
TOK 80-200 F2.8 ATX Pro .... £299
FLASH / ACCESSORIES USED
SB-24......................................................£49
SB-25......................................................£49
SB-28. ...................................................£69
SB-80DX..............................................£79
SB-400..................................................£79
SB-700............................................... £199
SB 900............................................... £249
Sigma EM140DG Ringflash.... £199
SB R1 kit M box.......................... £399
DR 3 angle finder...........................£59
MB 10 (fits F90)...............................£29
MB 23 (fits F4)..................................£69
MC 30 remote .................................£39

NIKON USED We carry out sensor cleaning on the premises, firmware updating and equipment hire - please enquire for details

£3799

Used Nikon
 D4s  body 
 box

£2299

Used Nikon
 D4  body 
 box

£1799

Used Nikon
 D3X  body 
 box

BRONICA ETRS 645 USED
40 F4 MC................................... £149
75 F2.8 PE ................................. £149
105 F3.5........................................£99
135 f4 PE................................... £249
150 F3.5 E ....................................£99
150 F3.5 PE M Box................ £149
200 F4.5 PE............................... £199
E14 Ext tube ...............................£49
E42 Ext tube ...............................£49
120 RFH........................................£69
Polaroid Back .............................£39
Plain prism ..................................£59
Rotary prism...............................£99
Winder early ...............................£79
Speed Grip E...............................£39
Tripod adapter E .......................£39
Winder early ...............................£49
Metz SCA 386.............................£49
BRONICA SQ 6x6 USED
40 F4 S ....................................... £299
50 F3.5 PS ................................. £299
50 F3.5 S.................................... £149
110 F4.5 PS macro................. £399

135 F4 PS M ............................ £229
150 F3.5 S ....................................£79
150 F4 PS ......................... £149/199
180 F4.5 PS............................... £399
200 F4.5 PS M box ............... £199
2x PS converter M ................ £179
135N back ................................ £119
SQAi 120 RFH.............................£79
SQAi prism late....................... £299
45° Prism box .......................... £129
Plain Prism S Boxed .................£69
AE Prism Early ............................£79
ME Prism Finder ........................£69
Metz SCA 386.............................£49
Pro shade S .................................£59
Lens Hood 65 80.......................£20
SQAi Motorwinder ................ £149
Speed grip S ...............................£79
CONTAX 645 USED
45 F2.8 ....................................... £499
HASSELBLAD 6x6 USED
501CM chrome
+ 80 F2.8 CB + A12................£ASK
500CM + 80 F2.8 C + A12... £799

45 degree prism early.............£99
Sports viewfinder .....................£69
Chimney.......................................£89
A12 chrome latest................. £299
A12 late blk/chr...................... £129
Polaroid back tatty...................£79
50 F4 CF FLE ............................ £849
150 F4 chrome serviced...... £199
Ext tube 21, 55 each................£39
Vivitar 2x conv ...........................£49
Lens hoods various........... £20/50
MAMIYA 645 MF USED
645 Pro TL + prism + back
+ 80 F2.8 + winder boxed .. £499
Plain prism (645 Super)..........£39
Polariod Back HP401 ...............£29
Polaroid back .............................£29
120 Insert.....................................£20
HA401 120 RFH Box.................£49
120 Back....£39 Winder...........£79
45 F2.8 N................................... £199
150 F2.8 A................................. £199
150 F3.5 N ...................................£79
150 F3.8 NL leaf...................... £299

210 F4 N M ................................£79
Ext Tube 1, 2, 3S each .............£29
Teleplus 2x converter..............£49
Vivitar 2x converter..................£39
MAMIYA TLR 6x6 USED
C330 F Body + WLF ............... £149
65 F3.5 box late ...................... £199
65 F3.5 serviced...................... £149
80 F2.8 late serviced............. £139
180 F4.5..................................... £149
250 f4.5 late serviced............ £249
250 f4.5 early serviced...... £179
Paramender ................................£49
Porrofinder..................................£59
MAMIYA 6 & 7 RF 6x7 USED
6 body + 75 F3.5 ..................£1099
50 F4 G ...................................... £599
50 F4.5 L + VF.......................... £699
80 F4.5 L M box..................... £699
150 F4.5 M .............................. £399
MAMIYA RB 6x7 USED
Pro SD + 90 KL
+ WLF + back .......................... £549
Pro S + 90 + WLF + back..... £399

Pro S body................................ £149
Pro S body scruffy ....................£99
Plain prism late....................... £199
WLF.............£79 Chimney........£99
120 645V back ...........................£99
90 F3.5 KL ................................. £299
127 F3.5 KL............................... £299
180 F4.5............................................ £149
Pro SD ext tube 2 82mm............£99
Pro SD ext tube 1 45mm............£99
Ext tube 2...........................................£49
MAMIYA RZ 6x7 USED
RZ Pro body ............................. £149
120 RFH Pro ................................£99
Polaroid back .............................£79
FE701 prism............................. £299
WLF...............£79 Winder II......£69
50 F4.5 W .................................. £249
65 F4 box M ........................... £399
90 F3.5 W M box................... £299
180 F4.5 W................................ £199
Pro shade.....................................£49
PENTAX 645AF USED
645N body ............................... £399

AF500FTZ flash..........................£79
PENTAX 645MF USED
645 + 75 F2.8........................... £249
645 body + insert .................. £199
55 F2.8 ....................................... £249
150 F3.5..................................... £199
200 F4 ........................................ £149
300 F4 ........................................ £249
1.4x converter......................... £199
PENTAX 67 USED
6x7 + prism + 105 F2.4 ........ £699
45 F4 latest M ........................ £499
135 F4 macro late .................. £249
165 F2.8 latest M .................. £499
200 F4 latest ............................ £169
200 F4 early...................................£99
300 F4 early scruffy................... £99
Pentax rear conv 1.4x.............. £249
2x rear converter.................... £179
Auto ext tubes ...........................£49
Vivitar 2x conv ...........................£49
Wooden grip ........................... £119
ROLLEI 6x6 TLR USED
3.5F White Face serviced...£1999

MEDIUM FORMAT 6x45, 6x6, 6x7 & 6x9 USED

£849

Used Hasselblad
 50mm F4 
 CF FLE

For more used equipment listings please see website www.mifsuds.com

£549

Used Mamiya
 RB67 Pro SD +
 90 KL + WLF
 + Back

£1999

Used Rollei
 3.5F 6x6
 White Face 
 serviced

CANON FD USED
28 F2.8 ..........................................£49
35 70 F3.5/4.5 ............................£59
35 70 F4 .......................................£69
50 F1.4 ..........................................£99
50 F1.8 ..........................................£49
50 F2..............................................£49
70 150 F4.5 .................................£29
75 200 F4.5 .................................£49
100 300 F5.6...............................£79
135 F3.5 (Breechlock)..............£39
2x Extender B.............................£49
25mm Ext tube..........................£29
50mm Ext tube..........................£29
177A flash....................................£20
199A flash....................................£39
244T flash ....................................£20
277T flash ....................................£25
300TL flash..................................£49

Winder A.......£20 Winder B..£30
CONTAX 35mm RF USED
90 F2.8 G................................... £299
CONTAX MF USED
28 70 F3.5/4.5 MM ................ £169
HASSELBLAD XPAN USED
Centre filter 49mm........................£129
LEICA M USED
90 F2.8 early chrome............ £499
LEICA SLR USED
R8 body black box................. £499
LEICA OPTICS USED
Televid APO 77 + eyepiece .... £799
Televid 77 + 20x60................ £649
Trinovid 10x42........................ £599
Ultravid 8x32 HD ................... £849
LIGHTMETERS USED
Polaris ...........................................£99
Sekonic L308 BII ........................£99

MINOLTA MD USED
X300 chrome body ..................£49
X300s black body .....................£49
X700 black body.......................£69
XGM chrome body...................£49
28 F3.5 MD..................................£39
50 F1.7 MD..................................£49
50 F2 MD .....................................£49
70 210 F4 MD.............................£99
2x Converter...............................£79
Ext tube for 50 F3.5..................£29
Ext tube set.................................£49
Auto bellows 1...........................£99
NIKON MF USED
F3HP body................................ £399
F3 body ..................................... £199
FM2n body chr box............... £299
FM2n body chr ....................... £249
FE body chrome........................£99

20 F3.5 AI.................................. £199
24 F2.8 AI. ................................. £199
28 F3.5 AIS...................................£99
28 F2.8 E box..............................£69
28 85 F3.5/4.5 AIS.................. £199
35 F2.8 AIS................................ £149
35 70 F3.3/4.5 AIS.................. £129
35 70 F3.5 AIS ............................£99
35 105 F3.5/4.5 AIS..................£79
50 F1.4 AI.................................. £199
50 F1.8 E.......................................£59
55 F2.8 AIS................................ £199
105 F2.8 AIS macro ............... £199
180 F2.8 AIS ED scruffy........ £179
500 F4 AIS...............................£1299
500 F8 mirror early................ £279
600 F5.6...................................£1499
TC200............................................£49
SC 17 TTL lead...........................£25

DW 3 WLF find fit F3 ...............£99
DW 21 fits F4........................... £149
OLYMPUS OM USED
OM 4T body ............................ £249
OM 1n body blk serviced... £199
OM 2SP body.......................... £149
OM 2n body blk or chr........ £149
24 F2.8 ....................................... £199
28 F3.5 ..........................................£49
35 70 F3.5/4.5 ............................£79
35 105 F3.5/4.5..........................£79
50 F3.5 macro ............................£79
200 F4 ...........................................£79
7, 14, 25 man ext tube ea......£20
14 or 25 auto ext tube ea......£29
PENTAX 35mm AF USED
16 45 F4 .................................... £199
17 70 F4 SDM M box .......... £299
18 55 F3.5/5.6 ............................£69

28 80 F3.5/5.6 ............................£49
50 135 F2.8 SDM.................... £379
55 300 F4/5.8 ED WR............ £229
55 300 F4/5.8 ED box........... £199
70 F2.8 Limited....................... £349
SIGMA PKAF USED
18 250 F3.5/6.3....................... £199
PENTAX MF USED
50 F1.4 PK....................................£99
50 F4 macro PK..........................£99
TAMRON ADII USED
28 F2.5 ..........................................£49
90 F2.5 SP ................................. £149
VANGUARD SCOPES USED
Endeavour HD65A................. £229
VOIGTLANDER USED
15 F4.5 + VF M box.............. £269

35MM & MISCELLANEOUS USED Please contact us to determine availability before making a lengthy journey

£499

Used Leica
 R8  body 
 black
 box

£1299

Used Nikon
 500mm F4 AIS

MORE ON WEBSITE
WWW.MIFSUDS.COM

MORE ON WEBSITE
WWW.MIFSUDS.COM
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AVAILABLE NOW

www.calphoto.co.uk

NATIONWIDE STORES SIGN
NEWSLETTER

Place your order online at www.calumetrenta 0

4 EASY STEPS TO RENTAL

COLLECT/
DELIVER RETURNSHOOTORDER

*Excludes damage waiver and VAT.

Visit us in store at any of our 8 stores nationwide 
expert and advice from our specialist team.

Belfast - Birmingham - Bristol - Edinburgh  

Glasgow - London  Drummond Street  

London Wardour Street - Manchester

to be the first to hear about new 
products, great offers, and exciting 
updates from Calumet Photographic.

THE GAME  
HAS CHANGED

THE NEW  
FUJIFILM GFX 50S  
IS HERE!

8 UK retail stores 0333 003 5000Click & Collect /calumetphotouk @calumetphotoukcalphoto.co.uk /calphotouk

0%
FINANCE FOR
24 MONTHS 

AVAILABLE
TRADE IN 
BONUS
AVAILABLE

£500

£30.00

PER DAY*
£65.00

PER DAY*
£95.00

PER DAY*

Help us make history and be part of the  
first National Photographic Survey!
Help us, with the support of The Photography Show, uncover the  
latest trends, factors and challenges facing the photographic  
industry today by heading online to calphoto.co.uk/NPS

Terms & conditions apply, see website for details calphoto.co.uk/national photo terms.

Plus, the chance to WIN a Fujifilm X-Pro2 worth over £1,000

Supported by

You’re invited to our

OPEN DAYS
CAPTURE MORE

Expert
advice direct
from leading

brands

In store
demonstrations

of the latest
products

Fantastic
offers exclusive

to our
Open Days

‘Capture More’ Competition Winning Image: Andy Gregory

FREE
SENSOR

CLEANING*

with donations going to
Great Ormond Street

Hospital Children’s
Charity

Registered charity no. 1160024. 

LOCATIONS & DATES: 

Bristol Thursday  20th  April 
Birmingham Thursday  27th  April
Manchester Thursday  4th  May
Glasgow Wednesday  10th  May
Edinburgh Thursday  11th  May
Belfast Thursday  18th  May 
London (Dru St.) Friday 26th & Saturday 27th May 

All open days 10am–4pm except London (Friday 26th May) which is 10am–5pm. 

Terms & conditions apply - see calphoto.co.uk/open-days for details.



DIGISCOPING

OLIVON SPOTTING SCOPES

Eyepieces (for body only scopes)

HD

£69.99
£99.99
£79.99
£79.99
£89.99
£99.99

£149.99
£249.99

Visionary  
HD 15x70 
only £ 99.99

www.far-sighted.co.uk

Clearview Binoculars: Four Square Chapel, Mapplewell. S75 6GG. Tel 01226 383736.

www.clearviewbinoculars.co.uk Callers very welcome, please check website for opening times.

Binocular Outlet: 01162 430 967, Check our website and visit us on shows and events throughout the UK:

www.binocularoutlet.co.uk

The Army Surplus Store: 01297 23867, High Street, Totnes, Devon, TQ9 5NN

www.thearmysurplusstore.co.uk����
SURPLUS STORE

J M Optics: 'HQE\ 'DOH 5RDG� 'XUNDU�:DNH¿HOG� 7HO ����� ������ (� LQIR#MPRSWLFV�FR�XN
Callers very welcome - by appontmet only, call to arrange your visit.

Eyeshields
Available for most 

binoculars and telescopes

from £14.99

Objective Optics / D & E Hughes: Tel: 01758 613 291, ���3HQODQ�6WUHHW��3ZOOKHOL��*Z\QHGG�//����'( 

www.objectiveoptics.co.uk
Objective Optics
Binoculars, Telescopes,  Astronomy

The Far-Sighted binocular company is a group of inde-

pendent specialist optical goods suppliers.  

For more information please visit www.far-sighted.co.uk. 

Offers are subject to availability and at participating 

RXWOHWV�RQO\��3ULFHV�DQG�VSHFLĆFDWLRQV�DUH�VXEMHFW�WR�

change without notice.



For SHRSOH ZKR ZDQW WR ÀQG WKHLU ¶RZQ VXEMHFW· DQG ¶D
SHUVRQDO DSSURDFK·� ([SORUH WKH ULFK UHSHUWRLUH RI SKRWRJUDSK\
IURP WKH UHDO ZRUOG� WKH XQLYHUVH RI KXPDQ LPDJLQDWLRQ� RU
VLPSO\ GLVFRYHU ZKDW WRXFKHV \RX� HDFK GD\�

Learn RQ�3URMHFW�3KRWRJUDSK\��LQ�D�YDULHW\�RI�
0HGLWHUUDQHDQ�ORFDWLRQV�LQ�DEXQGDQW�OLJKW�	�WUDQTXLOOLW\��DPRQJ�
OHJHQGV�DQG�UXLQV���IURP�$QWLTXLWp�WR�WKH�0HGLHYDO��:RUN�LQ�
ODQGVFDSHV�IURP�IUHVK�ZDWHU�PRXQWDLQ�VWUHDPV�WR�WKH�VDOW�
ODJRRQV�RI�WKH�&DPDUJXH��GDZQ��GXVN�RU�+LJK�1RRQ�7KH�
5RPDQ�FLW\�RI�$UOHV��YLOODJH�FDIpV�DQG�RQ�WKH�VWUHHWV�

Learn WR�VHL]H�¶&KDQFH·��VWUDWHJLHV�IRU�PDNLQJ�6HULHV��
3LFWXUHV�WKDW�WHOO�VWRULHV��3RUWUDLWV�WKDW�JR�EH\RQG�WKH�VXUIDFH��
,PDJH�WUHDWPHQW��DQG�HGLWLQJ�

Andrew Squires - 

Tel: 0033 681731222
www.photography-provence.com

International Summer Workshops 

en Provence

Ŗ$_bv o@;u bv |o 0;-| �o�u 1_;-r;v| omѴbm; 1-uķ �-m ou lo|ou0bh; bmv�u-m1; t�o|;� $_; ]�-u-m|;; omѴ� -rrѴb;v |o -mm�-Ѵ roѴb1b;v -m7 |o |_; 0-vb1 roѴb1� rub1; omѴ�� $_bv o@;u�;
1Ѵ�7;v�
|;Ѵ;r_om; t�o|-ঞomv -m7 omѴ� -rrѴb;v |o r;ul-m;m| u;vb7;m|v bm |_; &�ķ ;
1Ѵ�7bm] |_; �_-mm;Ѵ �vѴ-m7v� ); u;v;u�; |_; ub]_| |o u;t�;v| ruoo= o=ķ -m7 �-Ѵb7-|;ķ -Ѵ|;um-|;�t�o|;v�-v�
�;ѴѴ -v ruoo= o= |_; bm=oul-ঞom �o� ruo�b7;7 |o o0|-bm |_; t�o|;v Ő;�]� 1or� o= 7ub�bm] Ѵb1;m1; ou �ঞѴb|� 0bѴѴő 0;=ou; o�u ]�-u-m|;; bv _omo�u;7�

l�v|-u7�1o��h�bv�-�|u-7bm]�m-l;�o=��-�;u��omv�l;u��;7b-��blb|;7��_o�-u;�-m�-rrobm|;7�u;ru;v;m|-ঞ��;�o=�(-v|�(bvb0bѴb|���blb|;7��_o�-u;�-�|_oubv;7�-m7�u;]�Ѵ-|;7�0��|_;�bm-m1b-Ѵ�
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ou�1-ѴѴ�0330 022 7406

Compare car insurance and see if you can
get covered for less with mustard.co.uk

Whoever
are...

you drive
atever





Finance example: 12mths, 0% APR: Cash Price £1475, 10% Deposit £147.50, Monthly Payment £110.62, Total Amount Payable £1475. • 24mths, 9.9% APR: Cash Price £1475, 10% Deposit £147.50, Monthly Payment £60.93, Total Amount Payable £1608.82
36mths, 19.5% APR: Cash Price £1475, 10% Deposit £147.50, Monthly Payment £47.95, Total Amount Payable £1873.70 See website for details: www.uttings.co.uk/Information/Finance. Finance is subject to status, terms & conditions apply.*

*Consumer credit service provided by Pay4Later in association with Close Brothers Retail Finance. Pay4Later is licensed by the Financial Conduct Authority (Consumer Credit Licence: 0616240) Finance provided by Close Brothers Retail Finance is a trading name of Close Brothers Limited10 Crown Place, London EC2A 4FT.
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See website for Remotes, Batteries &   Chargers

See website for more lenses

See our website for full details & specifications

Full range of drone accessories available - see website 



162 PRACTICAL PHOTOGRAPHY

A gentle kind
of beauty

Sue Williamson is currently studying for a BA
in Professional Photography at Edinburgh College.
suewilliamsonphotography.wordpress.com 

O YEARS AGO I TOOK AN EVENING CLASS IN FILM 
photography and I’ve had the bug ever since. However, it 
wasn’t until I bought a digital camera some years later, and 
took a further evening class to work out how to use it properly,
that I realised I wanted to take photography seriously. I
couldn’t believe how many things had changed in such a short
period. I’m not the most technically-minded person, so the 
Photoshop and post-processing side of things was all very 
new to me. With two small children I had trouble finding the
time to learn it all. When my youngest son started school I 
applied for a National Certificate course in photography, as 
I wanted to pursue something a bit more creative. I didn’t 
know where it would take me, but I wanted to see what 
I could achieve. I was offered a place on the HND course 
in Professional Photography at Edinburgh College, which 
introduced me to technical skills, other genres and an insight
into how hard it is to work in the industry. In my second year
I mainly focused on editorial fashion images, as I liked the
collaborative process and the idea of creating narratives. 

After completing this course I began my BA in 
Professional Photography at Edinburgh College. As well 
as developing my skills, this has also encouraged me to 
approach projects from a more commercial angle as well. 
I’m using this opportunity to further identify my style, 
with a view to eventually setting up my own business. 

I recently came runner-up in Calumet’s ‘Student 
Photographer of the Year 2016’ competition with an 
image that’s a personal favourite of mine. It was shot in 
an American-style diner in Edinburgh and had a ’50s 
theme. There are always a few variables that have to 
be managed on fashion shoots, such as the input from 
other creatives, finding a good model, selecting your 
location and always paying attention to the details. 

I think that photography is a constant learning process, 
and it’s one that requires a lot of hard work, research and 
preparation. However, the freedom that it offers and the 
satisfaction of being able to achieve my own personal 
expression is an incredible reward all by itself.

Sue Williamson has 
created a stunning 
portfolio filled with soft 
tones and vintage vibes. 

STUDENT SHOWCASE






